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Changing Your SAS Workspace Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

About SAS Studio

SAS Studio is a development application for SAS that you access through your web 
browser. With SAS Studio, you can access your data files, libraries, and existing 
programs, and you can write new programs. You can also use the predefined tasks in 
SAS Studio to generate SAS code. When you run a program or task, SAS Studio 
connects to a SAS server to process the SAS code. The SAS server can be a hosted 
server in a cloud environment, a server in your local environment, or a copy of SAS on 
your local machine. After the code is processed, the results are returned to SAS Studio 
in your browser.
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SAS Studio supports multiple web browsers, such as Microsoft Internet Explorer, Apple 
Safari, Mozilla Firefox, and Google Chrome.

In addition to writing and running your own SAS programs, you can use the predefined 
tasks that are included with SAS Studio to analyze your data. The tasks are based on 
SAS System procedures and provide access to some of the most commonly used graph 
and analytical procedures. You can also use the default task template to write your own 
tasks.

Using SAS Studio

About Using SAS Studio

When you sign on to SAS Studio, the main SAS Studio window appears with a blank 
program window so that you can start programming immediately. You also have access 
to all six sections of the navigation pane.
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The main window of SAS Studio consists of a navigation pane on the left and a work 
area on the right. The navigation pane provides access to the search feature, your 
folder shortcuts and folders, your tasks and snippets, the libraries that you have access 
to, and your file shortcuts. The Folders section is displayed by default.

The work area is used to display your data, code, tasks, logs, and results. As you open 
these items, they are added to the work area as windows in a tabbed interface.
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Using the Navigation Pane

About Using the Navigation Pane

You can expand the sections of the navigation pane by clicking the section that you 
want to view.

Using the Search Section

The Search section of the navigation pane enables you to search the directory that is 
specified by the Authentication Provider for filenames, folder names, table names and 
descriptions, column names and labels, and library names. You can open items directly 
from your search results by double-clicking them or dragging them to the work area.

To use the search option:

1 In the navigation pane, click Search to open the Search section.

2 In the search box, enter the text that you want to search for.

3 Click  to open the Search Options window and specify the types of items that you 

want to search. By default, all types of items are searched.

4 Click Search.
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Working with Folders

The Folders section of the navigation pane enables you to access your folders, create 
folder shortcuts, download and upload files, and create a new SAS program. You can 
expand and collapse folders, and you can open items in the folders, such as a SAS 
program or table, by double-clicking them or dragging them to the work area.

To create a new folder shortcut, click  in the Folders section and select Folder 
Shortcut. Enter the shortcut name and full path and click Save. The new shortcut is 
added to the list of folder shortcuts.

To download a file, select the file that you want to download and click . You are 
prompted to open the file in the default application or save it to your local computer.

To upload one or more files from your local computer, click . Specify the folder to 
which you want to upload the files, and click Choose Files to browse for the files that 
you want to upload.

Working with Tasks

The Tasks section of the navigation pane enables you to access tasks in SAS Studio. 
Tasks are based on SAS procedures and generate SAS code and formatted results for 
you. SAS Studio is shipped with several predefined tasks that you can run. You can 
also edit a copy of these predefined tasks, and you can create your own new tasks.

To create a new task, click . SAS Studio creates a template in the work area that you 
can use to create custom tasks for your site. Custom tasks can be accessed from the 
My Tasks folder. For more information, see “Understanding Tasks in SAS Studio” on 
page 51.

To edit a task that you have created, select the task from the My Tasks folder and click 

. The XML code that is used to create the task is opened in the work area. If you 
want to edit a predefined task, you must first right-click the task and select Add to My 
Tasks. For more information, see “Edit a Predefined Task” on page 56.

Note: You can edit only the tasks that are in the My Tasks folder.
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Working with Snippets

The Snippets section of the navigation pane enables you to access your code snippets. 
Code snippets are samples of commonly used SAS code that you can insert into your 
SAS program. SAS Studio is shipped with several predefined code snippets that you 
can use. You can also edit a copy of these snippets and create your own custom 
snippets. Your custom snippets can be accessed from the My Snippets folder. For more 
information, see “Working with Programs” on page 13.

To edit a snippet that you have created, select the snippet from the My Snippets folder 

and click . If you want to edit a predefined snippet, you must first right-click the 
snippet and select Add to My Snippets.

Note: You can edit only the snippets that are in the My Snippets folder.

Working with Libraries

The Libraries section of the navigation pane enables you to access all of your libraries 
and the tables in the libraries. You can use the Libraries section to expand a table and 
view the columns in that table. The icon in front of the column name indicates the type.

Here are examples of common icons for the column types.

Icon Type of Column

Character

Numeric

Date

Datetime

You can drag tables and columns from the Libraries section to a program, and SAS 
Studio adds code for the dragged items to your program. For more information, see 
“Opening and Creating Programs” on page 14.

You can also create new libraries and assign existing libraries.
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To create a new library:

1 Click Libraries in the navigation pane and then click . The New Library window 

appears.

2 In the Name box, enter the libref for the library. The libref must be eight characters 
or fewer.

3 In the Path box, enter the physical path where the library resides.

4 In the Options box, specify any configuration options that you need. For the 
appropriate options, see the documentation for your operating environment.

5 If you want to access this library each time you use SAS Studio, select Re-create 
this library at start-up.

6 Click OK to create the library. The new library is added to the list of libraries in the 
navigation pane.

To assign unassigned libraries, click . If you want to access the selected libraries 
each time you use SAS Studio, select Assign selected libraries at start-up. If a library 
is unassigned, then you cannot access the tables in that library.

Using SAS Studio 7



Using File Shortcuts

File shortcuts enable you to quickly access files that you specify. You can create a file 
shortcut to a file on your SAS server or via a URL.

To create a new file shortcut, click . You can define the shortcut by specifying a 
complete path and filename or by specifying a URL. If you want this shortcut to be 
available the next time you use SAS Studio, select Re-create this file shortcut at 
start-up.

You can open a file from a file shortcut by double-clicking it or dragging it to the work 
area.

Customizing the Navigation Pane

By default, all six sections of the navigation pane are displayed when you open SAS 

Studio. To customize which sections are displayed, click  and select View. Select or 
clear any sections that you want to add or remove. The navigation pane is updated 
immediately.

Using the Work Area

About Using the Work Area

The work area is the main portion of the SAS Studio application for accessing programs 
and tasks and for viewing data. The work area is always displayed and cannot be 
minimized. When you open a program, task, or table, the windows open as new tabs in 
the work area. The code, log, and results that are associated with programs and tasks 
are grouped together under the main tab for the program or task.
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Customizing the Work Area

By default, the work area is displayed beside the navigation pane, but you can use the 
options menu to maximize the work area and hide the navigation pane. You can also 
close all of the tabs in the work area at once.

To maximize the work area, click  and select Maximize View.

Note: To reopen the navigation pane, click  and select Exit Maximized View.
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To close all tabs that are open in the work area, click  and select Close All Tabs. 
You are prompted to save any unsaved programs or tasks.

Customizing the View of the Program Tab

On the Program tab, you can rearrange the tabs by using a drag-and-drop operation to 
move them to the left or right. You can also dock a tab on the right side or bottom of the 
work area to view more than one tab at a time.

To rearrange a tab:

1 Select the tab that you want to move.

2 Move the tab icon to the location where you want to view this content. The icon 

indicates a valid location.
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Setting General Preferences

The Preferences window enables you to change several options that affect SAS Studio.

To access the general options, click  and select Preferences. Click General.

Option Description

Show generated code in the SAS log displays the ODS statements, %LET 
statements, and any other code that is 
automatically generated by SAS in the log 
file. This option applies to both SAS tasks and 
SAS program files.

Include a Show Details button in error 
messages

adds a Show Details button to any error 
messages that SAS Studio generates.

Time-out interval: (hours) specifies the amount of time that SAS Studio 
allows you to be logged on without any 
activity. The default value is one hour.
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Option Description

Start new programs in interactive mode opens new programs with the interactive 
mode on. This option is available only if you 
are running the first maintenance release for 
SAS 9.4. For more information, see “Working 
in Interactive Mode” on page 23. 

Changing Your SAS Workspace Server

If you have access to more than one SAS workspace server, you can change the server 

that SAS Studio connects to. To change the server, click  and select Change SAS 
Workspace Server. Select the server that you want to use. When you change servers, 
any libraries and file shortcuts that you created are deleted. For more information, see 
SAS Studio 3.1: Administrator's Guide.
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About the Code Editor

SAS Studio includes a color-coded, syntax-checking editor for editing new or existing 
SAS programs. The editor includes a wide variety of features such as autocomplete, 
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automatic formatting, and pop-up syntax help. With the code editor, you can write, run, 
and save SAS programs. You can also modify and save the code that is automatically 
generated when you run a task.

SAS Studio also includes several sample code snippets that you can use to make 
programming common tasks easier.

Opening and Creating Programs

Opening a Program

You can open SAS programs from the Folders section of the navigation pane. To open 
a program, expand the appropriate folder and double-click the program that you want to 
open, or drag it into the work area. The program opens in a new tab in the work area.

Creating a New Program

You can create a new SAS program from the Folders section of the navigation pane. To 

create a new program, click  and select SAS Program. A program window appears 
in a new tab in the work area.

Note: You can also click  on the toolbar in a program window.

Running a Program

After you have written your program, you can run it by clicking . If there are no errors, 
the results open automatically. If there are errors, the Log tab opens by default. You 
can expand the Errors, Warnings, and Notes sections to view the messages. When 
you click on a message, SAS Studio highlights it for you in the log so that you can see 
exactly where the message occurs in the log.
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Using the Autocomplete Feature

About the Autocomplete Feature

The autocomplete, or code completion, feature in the code editor can predict the next 
word that you want to enter before you actually enter it completely. The autocomplete 
feature can complete keywords that are associated with SAS procedures, statements, 
macros, functions, CALL routines, formats, informats, macro variables, SAS colors, 
style elements, style attributes, and statistics keywords, and various SAS statement and 
procedure options.

Note: The autocomplete feature is available only for editing SAS programs.
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This example shows the keywords and help that appear when you enter proc a in the 
code editor.

In this example, you select APPEND from the list of procedures, so that proc append 
appears in the code editor. When you enter a space, the code editor displays a list of 
options for the APPEND procedure.

How to Use the Autocomplete Feature

To use the autocomplete feature:

1 How you open the autocomplete list depends on the keyword that you want to add.
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n If you want to add a global statement, DATA step statement, CALL routine, 
procedure, macro statement, or automatic macro variable, enter the first one or 
more letters of the keyword that you want to use. 

A window opens with a list of suggested keywords that begin with those letters.

n If you want to specify colors, formats, informats, macro functions, SAS functions, 
statistics keywords, style elements, or style attributes, position your mouse 
pointer in a comment and press Ctrl+spacebar. To navigate through the list of 
options backward, press Ctrl+Shift+spacebar.

Note: These shortcuts work even if you have deselected the Enable 
autocomplete option in the Preferences window. For more information, see 
“Customizing the Code Editor” on page 30.
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2 You can navigate to the keyword that you want to use in several ways:

n Continue to type until the correct keyword is selected (because the matching 
improves as you type).

n Scroll through the list by using the up and down arrow keys, the Page Up and 
Page Down keys, or your mouse.

3 You can add the keyword to your program by double-clicking the selected keyword 
or by pressing the Enter key.

Using the Syntax Help

The code editor displays brief SAS syntax documentation as you write and edit your 
programs. You can display the Help in the following ways:

n Right-click a keyword in your program and select Syntax Help.

n Start typing a valid SAS keyword, and then click a suggested keyword in the 
autocomplete window.
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n Position the mouse pointer over a valid SAS keyword in your program. This works 
only if you have selected the Enable hint option in the Editor preferences. For more 
information, see “Customizing the Code Editor” on page 30.

The SAS Product Documentation provides more comprehensive usage information 
about the SAS language, but the syntax help in the code editor can get you started with 
a hint about the syntax or a brief description of the keyword. You can get additional help 
by clicking links in the syntax help window as follows:

n Click the keyword link at the top of the window to search the support.sas.com 
website for the keyword. 

n Click the links at the bottom of the window to search for the keyword in the SAS 
Product Documentation, Samples and SAS Notes, and SAS Technical Papers.
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Adding Table Names and Column Names

From the Libraries section of the navigation pane, you can use a drag-and-drop 
operation to move table names and column names into the SAS code. For example, 
you can move the Sashelp.Cars table into the DATA option for the PRINT procedure. 
When you release the mouse, the fully qualified name for the table appears in your 
code.
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Editing the Code from a Task

You can edit the code that is generated automatically when you run a task and then run 
it with your modifications. When you edit the code, SAS Studio opens it in a separate 
program window. The code is no longer associated with the original task.

To edit a program generated by a task:

1 On the appropriate task tab in the work area, click Code to display the code that is 
associated with the task. 

Note: In order to edit the code that is associated with a task, you must first display 
the code with the task. If the task code is not displayed, click  and select 

Preferences. Click Tasks, and then select Show Task Code.

2 On the toolbar, click Edit. The code is opened in a new program window.
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Using Your Submission History

SAS Studio maintains a log with entries for each time you run a program or task. You 
can use this log, or submission history, to access prior versions of your submitted code. 
To view your submission history, click the Code tab in your program or task window. On 

the toolbar, click  and select the version that you want to open. The prior version of 
the program opens in a new window from which you can copy and paste the code as 
needed.

Note: The submission history is cleared when you sign off from SAS Studio.
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Automatically Formatting Your SAS Code

You can use the code editor to make your programs easier to read by automatically 
formatting your code. When you automatically format your code, line breaks are added, 
and each line is correctly indented according to its nesting level. To format the code in 

the code editor, click .

For example, the following code is difficult to read because it lacks indention and logical 
line breaks:

data topn;
length rank 8; label rank="Rank";
set topn; by &category descending &measure;
if first.&category then rank=0; rank+1;
if rank le &n then output;
run;

After you use the automatic code-formatting feature, the program looks like this:

data topn;
    length rank 8;
    label rank="Rank";
    set topn;
    by &category descending &measure;

    if first.&category then
        rank=0;
    rank+1;

    if rank le &n then
        output;
run;

Working in Interactive Mode

Some SAS procedures are interactive, which means they remain active until you submit 
a QUIT statement, or until you submit a new PROC or DATA step. In SAS Studio, you 
can use the code editor to run these procedures, as well as other SAS procedures, in 
interactive mode.
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By using interactive mode, you can run selected lines of code from your SAS program 
and use the results to determine your next steps. For example, the OPTMODEL 
procedure in SAS/OR enables you to model and solve mathematical programming 
models. By running this procedure interactively, you can quickly check results for parts 
of the program and determine whether you need to make any modifications without 
running the entire program.

To run a program in interactive mode, click  on the toolbar. To turn off interactive 

mode, click  again. If you change modes while a program is open, the log and results 
for that program are cleared.

Note: Interactive mode is available only if you are running the first maintenance release 
for SAS 9.4.

When you run a program in interactive mode, SAS Studio does not add any 
automatically generated code, such as ODS and %LET statements, to your program. In 
addition, results are generated only in HTML. In interactive mode, the log and results 
are appended to the existing log and results. Previously submitted code remains active 
until you terminate it.

For example, suppose you have the following program:

proc sql;
  select * from sashelp.cars;
  
  select * from sashelp.class;
  quit;

In noninteractive mode, if you select the first two lines of code and submit them, the 
code runs successfully. If you then select the last two lines of code and submit them, 
the code fails because the PROC SQL statement is missing.

If you switch to interactive mode and follow the same steps, the last two lines of code 
run successfully because the PROC SQL statement is still active.

Note: For documentation about specific procedures, see the SAS Programmer’s 
Bookshelf on support.sas.com.
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Working with Code Snippets

Why Use Code Snippets?

Code snippets enable you to quickly insert SAS code into your program and customize 
it to meet your needs. SAS Studio is shipped with several code snippets. You can also 
create your own snippets and add snippets to your list of favorites.

Snippet Name Description

Data

Import CSV File The Import CSV File snippet enables you to import a 
comma-separated file and write the output to a SAS data 
set.

Import XLS File The Import XLS File snippet enables you to import a 
Microsoft XLS file and write the output to a SAS data set.

DS2 Package The DS2 Package snippet provides a template for a DS2 
package. A package is similar to a DS2 program. The 
package body consists of a set of global declarations and a 
list of methods. The main syntactical differences are the 
PACKAGE and ENDPACKAGE statements. These 
statements define a block with global scope. For more 
information, see SAS DS2 Language Reference.
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Snippet Name Description

DS2 Code The DS2 Code snippet provides a template for a DS2 
program. DS2 is a SAS programming language that is 
appropriate for advanced data manipulation. DS2 is 
included with Base SAS and shares core features with the 
SAS DATA step. DS2 exceeds the DATA step by adding 
variable scoping, user-defined methods, ANSI SQL data 
types, and user-defined packages. The DS2 SET 
statement accepts embedded FedSQL syntax, and the run-
time-generated queries can exchange data interactively 
between DS2 and any supported database. This allows 
SQL preprocessing of input tables, which effectively 
combines the power of the two languages. For more 
information, see SAS DS2 Language Reference.

DS2 Thread The DS2 Thread snippet provides a template for a DS2 
threaded program. Typically, DS2 code runs sequentially. 
That is, one process runs to completion before the next 
process begins. It is possible to run more than one process 
concurrently, using threaded processing. In threaded 
processing, each concurrently executing section of code is 
said to be running in a thread. For more information, see 
SAS DS2 Language Reference.

Generate CSV File The Generate CSV File snippet enables you to export SAS 
data as a comma-separated text file.

Generate PowerPoint Slide The Generate PowerPoint Slide snippet enables you to 
stream Microsoft PowerPoint output to your web browser.

Generate XML File The Generate XML File snippet enables you to export SAS 
data as an XML file that you can view in your web browser.

Simulate Linear Regression 
Data

The Simulate Linear Regression Data snippet creates an 
input data source that you can use for linear regression 
analysis. Linear regression analysis tries to assign a linear 
function to your data by using the least squares method.

Simulate One-Way ANOVA 
Data

The Simulate One-Way ANOVA Data snippet creates an 
input data source that considers one treatment factor with 
three treatment levels. When you analyze this data by 
using the One-Way ANOVA task, the goal is to test for 
differences among the means of the levels and to quantify 
these differences.
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Snippet Name Description

Descriptive

PROC SQL The PROC SQL snippet provides a template for writing 
SQL queries. For more information, see SAS SQL 
Procedure User's Guide.

Custom ODS Output The Custom ODS Output snippet provides a template for 
creating HTML, PDF, and RTF output by using the SAS 
Output Delivery System. For more information, see SAS 
Output Delivery System: User's Guide.

Graph
Note: For more information about the SGPLOT, SGPANEL, and SGSCATTER procedures, 
see SAS ODS Graphics: Procedures Guide.

Bar Panel The Bar Panel snippet uses the VBAR statement in the 
SGPANEL procedure and enables you to create multiple 
bar charts.

Box Panel The Box Panel snippet uses the VBOX statement in the 
SGPANEL procedure and enables you to create multiple 
box plots.

Comparative Scatter Plot The Comparative Scatter Plot snippet uses the COMPARE 
statement in the SGSCATTER procedure. This code 
snippet creates a comparative panel of scatter plots with 
shared axes.

Dot Plot The Dot Plot snippet uses the DOT statement in the 
SGPLOT procedure. Dot plots summarize horizontally the 
values of a category variable. By default, each dot 
represents the frequency for each value of the category 
variable.

Fit Plot The Fit Plot snippet uses the REG statement in the 
SGPLOT procedure. This code snippet produces a 
regression plot with a quadratic fit and includes confidence 
limits.
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Snippet Name Description

HBar Plot The HBar Plot snippet uses the HBAR statement in the 
SGPLOT procedure. This code snippet creates a horizontal 
bar chart that summarizes the values of a category 
variable.

HighLow Plot The HighLow Plot snippet uses the HIGHLOW statement in 
the SGPLOT procedure. High-low charts show how several 
values of one variable relate to one value of another 
variable. Typically, each variable value on the horizontal 
axis has several corresponding values on the vertical axis.

Histogram Plot The Histogram Plot snippet uses the HISTOGRAM 
statement in the SGPLOT procedure. This code snippet 
produces a histogram with two density plots. In this 
snippet, one density plot uses a normal density estimate 
and the other density plot uses a kernel density estimate.

Scatter Plot Matrix The Scatter Plot Matrix snippet uses the MATRIX 
statement in the SGSCATTER procedure. This code 
snippet creates a scatter plot matrix.

VBox Plot The VBox Plot snippet uses the VBOX statement in the 
SGPLOT procedure. A box plot summarizes the data and 
indicates the median, upper and lower quartiles, and 
minimum and maximum values. The plot provides a quick 
visual summary that easily shows center, spread, range, 
and any outliers. The SGPLOT and the SGPANEL 
procedures have separate statements for creating 
horizontal and vertical box plots.

Macro

SAS Macro The SAS Macro snippet provides a template for creating a 
SAS macro program. For more information, see SAS 
Macro Language: Reference.

IML

Find Roots of Nonlinear 
Equation

The Find Roots of Nonlinear Equation snippet enables you 
to find the roots of a function of one variable. Finding the 
root (or zero) of a function enables you to solve nonlinear 
equations.
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Snippet Name Description

Integrate a Function The Integrate a Function snippet enables you to 
numerically integrate a one-dimensional function by using 
the QUAD subroutine in SAS/IML software. Use the QUAD 
subroutine to numerically find the definite integral of a 
function on a finite, semi-infinite, or infinite domain.

Generate a Bootstrap 
Distribution

The Generate a Bootstrap Distribution snippet uses the 
IML procedure to create and analyze a bootstrap 
distribution of the sample mean.

Fit by using Maximum 
Likelihood

The Fit by using Maximum Likelihood snippet uses 
maximum likelihood estimation to estimate parameters for 
the normal density estimate.

Simulate Multivariate Normal 
Data

The Simulate Multivariate Normal Data snippet simulates 
data from a multivariate normal distribution with a specified 
mean and covariance.

To add a snippet to your list of favorites, select the snippet name and click .

Create a Code Snippet

To create your own snippet:

1 Open your .sas file in SAS Studio and select the code that you want to save as a 
snippet.

2 On the Code tab, click . The Add to My Snippets dialog box appears.

3 Enter a name for the snippet and click Save.

This snippet is now available from the My Snippets folder.
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How to Insert a Code Snippet

To include a code snippet in your program:

1 Click the location in your program where you want to insert the snippet.

2 In the navigation pane, open the Snippets section.

3 You can add the snippet to your program in these ways:

n use a drag-and-drop operation to move the snippet.

n double-click the name of the snippet.

n right-click the name of the snippet and select Insert. To select multiple snippets, 
use the Ctrl key. Then right-click and select Insert.

Customizing the Code Editor

The Preferences window enables you to change several options that affect the features 
in the code editor, including autocomplete and color coding.
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To access the editor options, click  and select Preferences. Click Editor.

Option Description

Enable autocomplete turns on the autocomplete feature of the code 
editor. This feature can predict the next 
keyword that you want to type before you 
actually type it completely. For more 
information, see “Using the Autocomplete 
Feature” on page 15.

Enable hint displays the syntax help window when you 
position the mouse pointer over a valid SAS 
keyword in your program. If this option is not 
selected, then you can view the syntax help 
by right-clicking a keyword and selecting 
Syntax Help. This option is not selected by 
default.

Tab width displays the number of spaces that are 
inserted into your text when you insert a tab 
character. The default value is four spaces for 
each tab character.

Substitute spaces for tabs inserts the number of spaces listed in the Tab 
width box instead of a single tab character. 
This option applies to both text that you type 
in the code editor and text that you paste into 
the code editor.
Note: In Microsoft Internet Explorer and 
Apple Safari, spaces are used instead of Tab 
characters. If you are using those browsers, 
you must select the Substitute spaces for 
tabs check box in order for the value of the 
tab width to be used.

Enable color coding displays the text in the code editor in different 
colors to help you identify different elements 
in the syntax.

Show line numbers displays line numbers in the leftmost column 
of the program and log windows.
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Option Description

Font size specifies the font size of the text in the code 
editor and log window.
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About the Table Viewer

When you open a table in SAS Studio, you use the table viewer.
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Note: The table viewer displays the first 100 rows of the table. If the structure or data 
values of the table change while the table is open, you must refresh the table viewer to 
see the changes. If the structure of the table changes and you do not refresh the table, 
the columns that are listed in the Libraries section of the navigation pane might be 
different from the columns that are displayed in the table viewer.

You can view the properties of the table and its columns by clicking on the toolbar.
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Opening and Viewing Data

You can open files in SAS Studio in several ways:

n You can double-click a file in the Folders and Libraries sections. 

n You can drag a file from the Folders and Libraries sections to the work area.

n You can search for a file in the Search section and open it from the search results. 
You can open the file by double-clicking it or by dragging it to the work area.
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n You can open a file by using a file shortcut in the File Shortcuts section. You can 
open the file by double-clicking it or by dragging it to the work area.

When you open a table, all of the columns in the table are displayed. You can use the 
Columns area to specify which columns you want to include in the table viewer. By 
default, the column names are displayed, but you can choose to display the column 
labels by selecting Column labels from the View drop-down list.

Viewing the Query Code That Is Used to 
Create a Table

While you select options and customize the table to look the way you want it to, SAS 

Studio is generating SAS code that you can use. To view the query code, click  on 
the toolbar. A new program window appears with the code that was used to create the 
view of the table in the table viewer. The program is a copy of the query code and is no 
longer associated with the original query. Editing the code does not affect the data that 
is displayed in the table viewer, and modifying the table viewer does not affect the 
contents of the code.
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Filtering and Sorting Data

In the table viewer, you can right-click a column heading to filter and sort the data by 
that column.

The filter options vary depending on the type of column that you have selected. The Add 
Filter window for a numeric column enables you to specify a single value for each 
criterion.
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The Add Filter window for a character column enables you to select one or more values 
in the column.

The Add Filter window for a date column enables you to select a date value from a pop-
up calendar window.
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When you create a filter on your data, the filter criteria are displayed at the top of the 

workspace. You can click  to edit the filter and  to delete the filter.

Exporting Data

You can use SAS Studio to export your data as another file type to a folder that you 
specify.

To export your data:

1 Click Libraries in the navigation pane and browse to find the file that you want to 
export.

2 Right-click the file that you want to export and select Export. The Export Table 
window appears.

3 In the Filename box, enter the name of the exported file.

4 From the File format drop-down list, select the format of the exported file. 
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5 Select the folder in which you want to save the exported file.

6 Click Export to export the file.
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Working with Results
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Viewing Results

When you run a task or a program in SAS Studio, the results are displayed in the work 
area. You can save the results as an HTML, PDF, or RTF file. You can also download 
any generated data.

41



About the SAS Output Delivery System

The SAS Output Delivery System (ODS) gives you greater flexibility in generating, 
storing, and reproducing SAS procedure and DATA step output along with a wide range 
of formatting options. ODS provides formatting functionality that is not available when 
using individual procedures or the DATA step without ODS.

SAS Studio uses very specific ODS options and the GOPTIONS statements so that the 
output is displayed properly in the web environment. To view all of the ODS options in 

your code, click  and select Preferences. In the Preferences window, click General 
and select the Show generated code in the SAS log option.
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Note: To ensure that your output is displayed properly, do not change the settings of 
the ODS options or GOPTIONS statements in the generated code.

About SAS ODS Statistical Graphics

About SAS ODS Statistical Graphics

SAS ODS Statistical Graphics, more commonly referred to as SAS ODS Graphics, is an 
extension of the SAS Output Delivery System (ODS). ODS manages all output that is 
created by procedures and enables you to display the output in a variety of forms, 
including HTML and PDF.

Many SAS analytical procedures use ODS Graphics functionality to produce graphs as 
automatically as these procedures produce tables. ODS Graphics uses the Graph 
Template Language (GTL) syntax, which provides the power and flexibility to create 
many complex graphs. The GTL is a comprehensive language for defining statistical 
graphics.

In SAS Studio, you can use the ODS Graphics Designer to define these statistical 
graphics without knowing the GTL. After a graph definition is created, you can use that 
graph definition to create an ODS statistical graph in SAS Studio.

SAS ODS Graphics Designer

What Is the SAS ODS Graphics Designer?

The SAS ODS Graphics Designer is an interactive graphical application that you can 
use to create and design custom graphs. The designer creates graphs that are based 
on the Graph Template Language (GTL), which is the same language that is used by 
SAS analytical procedures and SAS ODS Graphics procedures. The ODS Graphics 
Designer provides a graphical user interface so that you can design graphs easily 
without knowing the details of templates and the GTL.

Using point-and-click interaction, you can create simple or complex graphical views of 
data for analysis. The ODS Graphics Designer enables you to design sophisticated 

About SAS ODS Statistical Graphics 43



graphs by using a wide array of plot types. You can design multi-cell graphs, 
classification panels, and scatter plot matrices. Your graphs can have titles, footnotes, 
legends, and other graphics elements. You can save the results as an image for 
inclusion in a report or as an ODS Graphics Designer file (SGD) that you can later edit.

For more information, see SAS ODS Graphics Designer: User's Guide, which is 
available from support.sas.com.

How to Install the SAS ODS Graphics Designer

If you have SAS Foundation installed on your machine, the SAS ODS Graphics 
Designer is already available. For example, if you are using the single-user edition of 
SAS Studio, the SAS ODS Graphics Designer is already installed because you are 
running SAS Foundation and SAS Studio on the same machine.

Note: The SAS ODS Graphics Designer is available only in the SAS Studio Single-
User edition.

To install the SAS ODS Graphics Designer:

1 Click . Select Tools  Install ODS Graphics Designer. The downloads and hot 

fixes page for Base SAS Software on support.sas.com opens.

2 Under the SAS 9.4M1 heading, click SAS ODS Graphics Designer.

3 From the list of download pages, click Request download for your Windows 
operating environment and follow the subsequent installation steps.

Open the SAS ODS Graphics Designer

After the SAS ODS Graphics Designer is installed, you can open it by using a menu 

option in SAS Studio. To open SAS ODS Graphics Designer, click  and select Tools. 
Then select ODS Graphics Designer.
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SAS ODS Graphics Editor

What Is the SAS ODS Graphics Editor?

The ODS Graphics Editor enables you to edit the various elements in the output graph 
while keeping the underlying data unchanged. In addition, you can annotate a graph by 
inserting text, lines, arrows, images, and other items in a layer above the graph. You 
can save the results of your customization as an ODS Graphics Editor (SGE) file and 
make incremental changes to the file. You can also save the results as a Portable 
Network Graphics (PNG) image file for inclusion in other documents.
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For more information about the SAS ODS Graphics Editor, see SAS ODS Graphics 
Editor: User's Guide, which is available from support.sas.com.

How to Install the SAS ODS Graphics Editor

When you install the SAS ODS Graphics Editor, SAS Studio automatically creates the 
~/Projects/ODSEditorFiles directory.

Note: If you are running the single-user edition of SAS Studio, then the SAS ODS 
Graphics Editor is already installed.

To install the SAS ODS Graphics Editor:

1 Click . Select Tools  Install ODS Graphics Editor. The downloads and hot 

fixes page for Base SAS Software on support.sas.com opens.

2 For your release of SAS, click ODS Graphics Editor. (For example, if you are 
running on SAS 9.4, select ODS Graphics Editor under the SAS 9.4 heading.)

3 From the list of download pages, click Request download for your Windows 
operating environment and follow the subsequent installation steps.

How to Edit Your Graphics Output

1 Include this statement in your SAS code so that you can edit your graphics output:

ods listing sge=on gpath="{home}/Projects/ODSEditorFiles";

When you run this program, the graphical output is saved as an SGE file in your ~/
Projects/ODSEditorFiles directory.

2 In the Folders section of the navigation pane, expand the ODSEditorFiles folder.
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3 Double-click the filename to open the graph in the SAS ODS Graphics Editor.
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For example, here is the SGPanel1.sge file in the SAS ODS Graphics Editor.

Note: The default list of files in your ODSEditorFiles folder is created by the code 
snippets in the Snippets section. For more information, see “Working with Code 
Snippets” on page 25.

Specifying the Style for Your Results

The Preferenceswindow enables you to change several options that affect how your 
results are displayed.

To access the editor options, click  and select Preferences. Click Results.

Option Description

Display warning if results are larger than n 
MB

displays a warning message when you 
attempt to open a results file that is larger 
than n megabytes (MB). The default value is 
4 MB.
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Option Description

HTML output style displays the style that is applied to results in 
HTML. To change the style that is applied to 
the results, select another style from the drop-
down list.

Produce PDF output generates results in PDF format. This option 
is selected by default.

PDF output style displays the style that is applied to results in 
PDF. To change the style that is applied to 
the results, select another style from the drop-
down list.

Generate the default table of contents automatically creates a table of contents in 
the PDF file.

Produce RTF output generates results in RTF format. This option 
is selected by default.

RTF output style displays the style that is applied to results in 
RTF. To change the style that is applied to 
the results, select another style from the drop-
down list.
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What Is a Task?

A task is an XML and Apache Velocity code file that generates SAS code and formats 
results for you. Tasks include SAS procedures from simple data listings to complex 
analytical procedures. SAS Studio is shipped with several predefined tasks. You can 
edit a copy of these predefined tasks in order to customize the tasks for your site. You 
can also build your own tasks.

How to Run a Task

To run a predefined task:

1 In the navigation pane, click the Tasks section.
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2 Expand the folder that contains the task.

3 Right-click the task name and select Open. Alternatively, you can double-click the 
task to open it.

The task opens to the right of the work area.

4 If the Data tab is available, specify an input data source and select columns for the 
roles in the data source. A role is a description of a variable’s purpose in the task. To 
add a column to a role, click . A list of available columns for that role appears. If 

only one column can be assigned to the role, you select a column and the list 
disappears. If multiple columns can be assigned, you can press Ctrl or Shift to select 
multiple columns from the list and click OK.

5 On the remaining tabs, specify any other required options, which are denoted with a 
red asterisk. As you assign values to the task, the relevant SAS code is generated.

6 Click  to run the task.
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If the task generates output data, the table opens in your work area.

If the task generates results, the output appears on the Results tab under the tab for 
the current task.
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By default, the task settings appear on the left and the results on the right. To change 

this configuration, click  and select View  Task Settings on Right.

Save a Task and Its Option Settings

If you use a task frequently, you might want to save the task after you specify the input 
data source and the option settings. In SAS Studio, you can save a task as a CTK file in 
your Folders directory. The next time that you need to run the task, double-click the 
task in your Folders directory and the task appears with all of your previous settings.

Note: Before you can save a task, you must specify an input data set and all the 
options that are required to run the task.
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To save a task:

1 Click . The Save As window appears.

2 In the My Folders directory, select the location where you want to save the task 
file and specify a name for this file. For the file type, select CTK Files (*.CTK). Click 
Save.

The task is now available from the Folders section.

Note: In the Tasks section, you are still working with this task. If you save the task 
again, the CTK file in the Folders section is updated.
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Edit a Predefined Task

To customize the predefined tasks for your site, you can edit the XML code that is used 
to create the task.

To edit a predefined task:

1 In the navigation pane, open the Tasks section.

2 Expand the folder that contains the task.

3 Right-click the name of the task that you want to edit and select Add to My Tasks. A 
copy of the task is added to your My Tasks folder.

4 Open the My Tasks folder and select the copied task.

5 Click . The XML file for the task appears.

6 Edit the XML file and save your changes. To preview your changes, click .

Create a New Task

SAS Studio provides a template that you can use to create custom tasks for your site.

To create a custom task:

1 In the navigation pane, open the Tasks section.

2 Click  and select New Task. A task template opens.
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3 Edit the code in the task template to create your task. To view the user interface for 
the task template, click . In the user interface for the task template, you can see 

examples of radio buttons, check boxes, combination boxes, and other types of 
options. For more information about this file, see SAS Studio: Developer's Guide to 
Writing Custom Tasks.

Customizing the Task Code

The Preferences window enables you to change several options that affect what and 
how the task code is displayed.

To access these options, click  and select Preferences. Click Tasks.
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Trim all leading and trailing blank spaces 
in generated code

removes any blank spaces that appear before 
or after the generated code.

Generate header comments for task code adds comments before the generated code 
for a SAS task.

Automatically format generated code automatically formats any code that is 
generated by a task and displayed in the 
code editor.
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Characterize Data Task

About the Characterize Data Task

The Characterize Data task creates a summary report, graphs, and frequency and 
univariate SAS data sets that describe the main characteristics of the data.

Example: Characterize Data Task

In this example, you want a better understanding of the contents in the 
Sashelp.Pricedata data set.

To create this example:

1 In the Tasks section, expand the Data folder and double-click Characterize Data. 
The user interface for the Characterize Data task opens.

2 On the Data tab, select the SASHELP.PRICEDATA data set.

3 To run the task, click .
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Here is a sample of the results:
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By default, the task also creates output data—a table with the frequency data and a 
table with the univariate data. Both of these tables are saved in the Work library.

Assigning Data to Roles

You must select a data source to run the Characterize Data task. However, no roles are 
available.
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Setting Options

Option Name Description

Output Options You must select at least one output option. By 
default, a summary report, graphs, and output 
tables for the frequency data and univariate 
data are created.

Limit categorical values Specifies the maximum number of categorical 
values to report per variable. By default, 30 
values are reported. You can change this 
maximum value in the Maximum number of 
unique values per variable box.

List Data Task

About the List Data Task

The List Data task displays the contents of a table as a report. For example, you can 
use the List Data task to create a report that sums the expenses and revenues for each 
sales region.

Example: Reports of Drive Train, MSRP, and 
Engine Size by Car Type

In this example, you want to create reports for each car type. Each report lists the drive 
train, MSRP, and engine size.

To create this example:

1 In the Tasks section, expand the Statistics folder and double-click List Data. The 
user interface for the List Data task opens.
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2 On the Data tab, select the SASHELP.CARS data set.

3 Assign columns to these roles:

Role Column Name

List variables DriveTrain
MSRP
EngineSize

Group analysis by Type

4 To run the task, click .
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Here is a subset of the results:

Assigning Data to Roles

Role Description

List variables Prints the variables in the order in which they 
are listed.
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Role Description

Group analysis by When you assign one or more variables to 
this role, the table is sorted by the selected 
variable or variables, and a listing is 
generated for each distinct value, or BY 
group, in the variable or combination of 
variables.

Total of Prints the sum of the selected variable at the 
bottom of the listing report.

Identifying label When you specify one or more variables in 
this role, the List Data task uses the formatted 
values of these variables to identify the rows, 
rather than observation numbers (designated 
in the results by the column heading "Obs").

Setting Options

Option Name Description

Basic Options

Display row numbers Includes in the output a column that lists the 
row number for each observation.
You can specify a label for this column in the 
Column label text box. By default, the name 
of this column is Row number.

Use column labels as column headings Uses the column label instead of the column 
name as the column heading.

Display number of rows Reports the number of rows in the table at the 
end of the output, or the number of rows in 
each BY group at the end of each BY group’s 
output.
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Option Name Description

Round values before summing the 
variable

Rounds each numeric value to the number of 
decimal places in its format, or to two decimal 
places if no format is specified. If this option is 
specified, the List Data task performs the 
rounding before summing the variable.

Heading direction Column headings can be printed horizontally 
or vertically, or you can select Default and let 
SAS determine the optimal arrangement for 
each column.

Column width Specifies how the List Data task determines 
column widths:
Default

determines the column widths on a per-
page basis.

Full
uses a format width (or default width if no 
format is specified) for all pages.

Minimum
uses the smallest possible column width 
on a per-page basis.

Uniform
reads the entire table to determine the 
appropriate column widths before 
generating output. When this option is not 
selected, different pages could have 
different widths for the same column.

Uniform by
formats all columns uniformly within a BY 
group, using each variable's formatted 
width as its column width. If the variable 
does not have a format that explicitly 
specifies a field width, the task uses the 
widest data value as the column width.
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Option Name Description

Split labels If the variable labels contain one of the split 
characters (*, !, @, #, $, %, ^, &, or +), the 
labels will be split at the split character or 
characters. For example, for a variable label 
that reads "This is*a label" and the * 
character is selected as the split character, 
the column heading will read
This is
a label

You do not need to select both the Use 
variable label as column headings and 
Split labels options. The Split labels option 
implies that you want to use variable labels.

Rows to list specifies the number of rows to list in the 
output. By default, all rows are listed.

Rank Data Task

About the Rank Data Task

The Rank Data task computes ranks for one or more numeric variables across the rows 
in a table and includes the ranks in an output table.

For example, you might want to rank the sales for each product that your company 
sells. In this case, the ranking variable would show the order of product sales. The 
product with the highest number of sales would be ranked first.

Example: Ranking Students by Age and 
Height

In this example, you want to rank the students in your class by age and height.
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To create this example:

1 In the Tasks section, expand the Data folder and double-click Rank. The user 
interface for the Rank Data task opens.

2 On the Data tab, select the SASHELP.CLASS data set.

3 Assign columns to these roles:

Role Column Name

Columns to rank Height

Rank by Age

4 To run the task, click .

The Rank Data task creates an output data set. In SAS Studio, this data set opens on 
the WORK.Rank tab. This data set contains the additional rank_Height column, which 
shows where that student ranks within her age group. For example, in the 11-year-old 
age group, Joyce is ranked number one. In the 12-year-old age group, Louise is ranked 
number 1.
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Assigning Data to Roles

To run the Rank Data task, you must assign a column to the Columns to rank role.

Role Description

Columns to rank Each column that is assigned to this role is 
ranked. You must assign at least one variable 
to this role. By default, the rankings column is 
given the name rank_column-name, where 
column-name is the name of the original 
column.
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Role Description

Rank by When you assign one or more columns to this 
role, the input table is sorted by the selected 
column or columns and rankings are 
calculated within each group.

Setting Options

You must select at least one output option.

Option Name Description

Options
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Option Name Description

Ranking method specifies the method to use when ranking the 
data. Here are the valid values:
None

does not use a method to rank the data.
Percentile ranks

partitions the original values into 100 
groups, in which the smallest values 
receive a percentile value of 0 and the 
largest values receive a percentile value of 
99.

Deciles
partitions the original values into 10 
groups, in which the smallest values 
receive a decile value of 0 and the largest 
values receive a decile value of 9.

Quartiles
partitions the original values into four 
groups, in which the smallest values 
receive a quartile value of 0 and the 
largest values receive a quartile value of 3.

Group = n (NTILES)
partitions the original values into n groups, 
in which the smallest values receive a 
value of 0 and the largest values receive a 
value of n–1. Specify the value of n in the 
Number of groups box.

Fractional ranks with denominator = n
computes fractional ranks by dividing each 
rank by the number of observations that 
have nonmissing values of the ranking 
variable.
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Option Name Description

Ranking method (continued) Fractional ranks with denominator = n+1
computes fractional ranks by dividing each 
rank by the denominator n+1, where n is 
the number of observations that have 
nonmissing values of the ranking variable.

Percents
divides each rank by the number of 
observations that have nonmissing values 
of the variable and multiplies the result by 
100 to get a percentage.

Normal scores (Blom formula), Normal 
scores (Tukey formula), Normal scores 
(van der Waerden formula)

computes normal scores from the ranks. 
The resulting variables appear normally 
distributed. Here are the formulas:
Blom formula

yi = Φ−1( (ri − 3
8 )

(n +
1
4 ) )

Tukey formula

yi = Φ−1( (ri − 1
3 )

(n +
1
3 ) )

van der Waerden

yi = Φ−1( ri
(n + 1)

)
In these formulas, Φ−1 is the inverse 
cumulative normal (PROBIT) function, ri is 
the rank of the ith observation, and n is the 
number of nonmissing observations for the 
ranking variable.

Note: If you set the If values tie, use 
option, the Rank Data task computes the 
normal score from the ranks based on 
non-tied values and applies the ties 
specification to the resulting score.
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Option Name Description

Ranking method (continued) Savage scores (exponential)
computes Savage (or exponential) scores 
from the ranks.

Note: If you set the If values tie, use 
option, the Rank Data task computes the 
Savage score from the ranks based on 
non-tied values and applies the ties 
specification to the resulting score.

If values tie, use: specifies how to compute normal scores or ranks for 
tied data values.

Mean (Midrank)
assigns the mean of the corresponding 
rank or normal scores

High rank
assigns the largest of the corresponding 
ranks or normal scores

Low rank
assigns the smallest of the corresponding 
ranks or normal scores

Dense rank
computes scores and ranks by treating tied 
values as a single-order statistic. For the 
default method, ranks are consecutive 
integers that begin with the number one 
and end with the number of unique, 
nonmissing values of the variable that is 
being ranked. Tied values are assigned 
the same rank.

Rank order specifies whether to list the values from 
smallest to largest or from largest to smallest.

Results

Location to save output data specifies the location of the output table. By 
default, the table is saved in the temporary 
Work library.
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Option Name Description

Include ranked columns specifies that the output table contains the 
original columns as well as the ranked 
columns. If you want to replace the original 
column with the ranked columns, deselect the 
Include ranking columns check box.
By default, the ranked column is given the 
name rank_column-name, where column-
name is the name of the original column.

Random Sample Task

About the Random Sample Task

The Random Sample task creates an output table that contains a random sample of the 
rows in the input table.

You might use this task when you need a subset of the data. For example, suppose you 
want to audit employee travel expenses in an effort to improve the expense reporting 
procedure and possibly reduce expenses. Because you do not have the resources to 
examine all expense reports, you can use statistical sampling to objectively select 
expense reports for audit.

Example: Creating a Random Sample of the 
Sashelp.Pricedata Data Set

In this example, you want to create a subset of the data in the Sashelp.Pricedata data 
set.

To create this example:

1 In the Tasks section, expand the Data folder and double-click Random Sample. 
The user interface for the Random Sample task opens.

Random Sample Task 77



2 On the Data tab, select the SASHELP.PRICEDATA data set.

3 To run the task, click .

Here are the tabular results:
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The task also creates a sample data set in the Work library. In SAS Studio, this data set 
opens on the WORK.RandomSample tab.

Assigning Data to Roles

For the Random Sample task, you must specify an input data source. No roles are 
required to run the task.

Role Description

Output columns specifies the variables to include in the output 
table. By default, all variables are included in 
the output table. However, you can select the 
variables to include in the output.
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Role Description

Strata columns specifies the variables to use to partition the 
input table into mutually exclusive, 
nonoverlapping subsets that are known as 
strata. Each stratum is defined by a set of 
values of the strata variables, and each 
stratum is sampled separately. The complete 
sample is the union of the samples that are 
taken from all the strata.
Note: If you do not assign any variables to 
this role, then the entire input table is treated 
as a single stratum.
You can allocate the total sample size among 
the strata in proportion to the size of the 
stratum. For example, the variable GENDER 
has possible values of M and F, and the 
variable VOTED has possible values of Y and 
N. If you assign both GENDER and VOTED 
to the Strata columns role, then the input 
table is partitioned into four strata: males who 
voted, males who did not vote, females who 
voted, and females who did not vote.
The input table contains 20,000 rows, and the values 
are distributed as follows:

n 7,000 males who voted
n 4,000 males who did not vote 
n 5,000 females who voted 
n 4,000 females who did not vote 
Therefore, the proportion of males who voted 
is 7,000/20,000=0.35 or 35%. The 
proportions in the sample should reflect the 
proportions of the strata in the input table. For 
example, if your sample table contains 100 
observations, then 35% of the values in the 
sample must be selected from the males who 
voted stratum to reflect the proportions in the 
input table.
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Setting Options

Option Name Description

Sample size specifies the sample size in the desired 
number of rows or in the desired percentage 
of input rows. For example, if you specify 3% 
of rows and there are 400 input rows, then 
the resulting samplehas 12 rows.
Note: If you assign variables to the Strata 
columns role, then the sample size 
specification that you make here applies to 
each stratum rather than to the entire input 
table.
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Option Name Description

Sample method specifies the method to use when sampling 
the data. Here are the valid values:
Simple (no duplicates)

specifies the simple method when 
sampling the input data. When a row is 
selected, it is removed from eligibility for 
subsequent selections. This makes it 
impossible to select the same row more 
than once.

Unrestricted (duplicates allowed)
specifies the unrestricted method when 
sampling the input data. When a row is 
selected, it remains eligible for subsequent 
selections. This makes it possible to select 
the same row more than once. You can 
specify how multiple selections of the 
same row are recorded in the output table.
You can choose from the following options:

Show each observations once in output (exclude 
duplicates)

a row that is selected n times occurs in 
the sample once. In the output, the 
NumberHits variable (which is 
calculated automatically by the Random 
Sample task) lists the number of times 
that the observation occurred in the 
input table.

Show all observations in output (include 
duplicates)

a row that is selected n times occurs in 
the sample n times.

Location of output data set specifies the name and location for the output 
data. By default, the data is saved to the 
Work library.

Random seed number specifies the initial seed for the generation of 
random numbers. If you do not specify a 
random seed number, then a seed that is 
based on the system clock will be used to 
produce the sample.
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Option Name Description

Generate a sample selection summary generates a summary table that includes the 
seed that was used to produce the sample. 
By specifying this same seed later with the 
same input table, you can reproduce the 
same sample.

Sort Data Task

About the Sort Data Task

The Sort Data task enables you to sort the table by any of its columns. The result from 
this task is a sorted table in the Work library. No results or output data is displayed 
when you run this task.

Assigning Data to Roles

To run the Sort Data task, you must assign a column to the Sort by role.

Role Description

Sort by When you assign one or more variables to 
this role, the table is grouped by the selected 
variable or variables. The order in which the 
variables appear within this role determines 
which variable is the primary sort key, which 
variable is the secondary sort key, and so on. 
The primary sort key is always the first 
variable that is listed within the Sort by role.

Columns to drop When you assign one or more variables to 
this role, the output that is generated does not 
contain the specified variables. You can 
assign a maximum of (n – 1) variables to this 
role, where n is the total number of variables 
in the table.
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Setting Options

Option Name Description

Output Order

Collating sequence indicates what collating sequence to use 
when sorting character variables. You can 
use these collation standards:
n sequence that is defined on the server 

(Server default)
n the ASCII or EBCDIC collating sequences
n the reverse collation order for character 

variables
n a national standard, such as Danish, 

Finnish, Italian, Norwegian, Spanish, or 
Swedish 

n a custom-defined collating sequence that is 
defined by your installation site

Maintain original data order within ‘Sort 
by’ groupings

groups the data according to the order that 
you set for the Sort by role. If this option is 
not selected, then the output table is grouped 
in an undefined order within the sorted key 
groups.

Duplicate Records

Keep all records keeps all of the records that are in the output 
table, including all duplicates of records.
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Option Name Description

Keep only the first record for each ‘Sort 
by’ group

eliminates any duplicate observations that 
have the same values for the Sort by group. 
If the Group data in the order of the Sort by 
variable option is selected, then the 
observation that is retained for each Sort by 
group is the first one that is read from the 
original table. However, if the Group data in 
the order of the Sort by variable option is 
not selected, then the observation that is kept 
for each Sort by group cannot be 
predetermined.

Do not keep adjacent duplicate records compares each record to the previous record 
in the output table. If an exact match is found, 
the duplicate record is not written to the 
output table.
Note: If you do not assign all variables to the 
Sort by role, some duplicate records might 
not be removed because the records are not 
adjacent.

Advanced Sorting

Memory for sorting specifies the maximum amount of memory 
that can be used for the Sort Data task. You 
can specify the amount of memory in bytes 
(B), kilobytes (KB), megabytes (MB), or 
gigabytes (GB). You can also specify to use 
all of the available memory or to use the 
default amount of memory that has been 
allocated on the server.

Reduce temporary disk space 
requirements

indicates that during the Sort Data process, 
only the Sort by variables and the 
observation numbers are stored within 
temporary files, reducing the amount of 
storage necessary to perform the sort. In the 
final phase of the sort, the temporary file is 
used as an index to access the original table 
and then to send the data to the results table 
in the correctly sorted sequence.
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Option Name Description

Force a sort of indexed data indicates that you want to sort all tables even 
if the table is already sorted in the desired 
sequence or the table contains a user-created 
index with keys that reflect those specified in 
the Sort by role. If you specify this option, the 
table is sorted regardless of the current order 
of the table or whether it contains an index.

Results

Location to save output data specifies the location for the output table. By 
default, this table is saved to the temporary 
Work library.

Table Attributes Task

About the Table Attributes Task

The Table Attributes task enables you to create these types of reports:

n a default report that includes the following data attributes: the date on which the 
table was created and last modified, the number of rows, the encoding, any engine-
dependent or host-dependent information, and an alphabetic list of the variables and 
their attributes.

n an enhanced report displays the table and variable attributes. Unlike the default 
report, you can specify the order of the contents in the report. From this report, you 
can determine the table type, the date on which the table was created and modified, 
the number of observations, the variable labels, and the variable types.

Example: Table Attributes for the 
Sashelp.Pricedata Data Set

In this example, you want to view the table attributes for the Sashelp.Pricedata data set.

86 Chapter 6 / Data Tasks



To create this example:

1 In the Tasks section, expand the Data folder and double-click Table Attributes. The 
user interface for the Table Attributes task opens.

2 On the Data tab, select the SASHELP.PRICEDATA data set.

3 On the Options tab, deselect the Default report check box.

4 To run the task, click .

Here is a subset of the results for the Table Attributes task. These results are the 
enhanced report for the Sashelp.Pricedata data set.

An output data set also opens on the WORK.TableAttributes tab.
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Setting Options

Option Name Description

Default report contains the output from the DATASETS 
procedure. This report includes the following 
data attributes: the date on which the table 
was created and last modified, the number of 
observations, the encoding, any engine-
dependent or host-dependent information, 
and an alphabetic list of the variables and 
their attributes.
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Option Name Description

Enhanced report contains the output from the DATASETS 
procedure. The REPORT procedure is used 
to create the enhanced report.
This report displays the table and variable 
attributes. From this report, you can 
determine the table type, the date on which 
the table was created and modified, the 
number of observations, the variable labels, 
and the variable types.

Sort variables by sorts the rows in the variable table by variable 
name, variable order in the table, variable 
type, variable format, or variable label.
Note: This option affects only the enhanced 
report.

Order sequence specifies whether to sort the rows in the table 
by ascending or descending order.
Note: This option affects only the enhanced 
report.

Location to save output data specifies the location of the output table. By 
default, this table is saved to the temporary 
Work library.

Transpose Data Task

About the Transpose Data Task

The Transpose Data task turns selected columns of an input table into the rows of an 
output table. If you do not use grouping variables, then each selected column is turned 
into a single row. If you use grouping variables, then the selected columns are divided 
into subcolumns based on the values of the grouping variables. Each subcolumn is 
turned into a row of the output table.
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Assigning Data to Roles

To run the Transpose Data task, you must assign a column to the Transpose variables 
role.

Role Description

Transpose variables Each column that you assign to this role 
becomes one or more rows of the output 
table. If you do not select any grouping 
variables, then an entire column is turned into 
a single row. If you select one or more 
grouping variables, then the grouping 
variables are used to segment each column 
into subcolumns, each of which is turned into 
a row. In this case, a column is transposed to 
the number of rows that is equal to the 
number of groups that are defined by the 
grouping variables.
You must assign at least one column to the 
Transpose variables role. To select a 
grouping variable, assign a column to the 
Group analysis by role.

Copy variables Each column that you assign to this role is 
copied directly from the input table to the 
output table without being transposed. 
Because these columns are copied directly to 
the output table, the number of rows in the 
output table equals the number of rows in the 
input table. The output table is padded with 
missing values if the number of rows in the 
input table does not equal the number of 
variables that it transposes.

Group analysis by Each variable that you assign to this role is 
used to segment the about-to-be-transposed 
columns into subcolumns that will be 
transposed separately. Each subcolumn, 
defined by a set of values of the grouping 
variables, becomes a row of the output table.
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Setting Options

Option Name Description

Source Column

Name Each row of the output table includes the 
name of the variable in the input table to 
which the values in that output row belong. To 
specify a heading for the output column that 
contains these variable names, enter the 
heading in the Name box. The name can 
include special characters, leading numbers, 
and white space, but it cannot exceed 32 
characters. The default name is Source.

Label Each row of the output table includes the 
label of the variable in the input table to which 
the values in that output row belong. To 
specify a heading for the output column that 
contains these variable labels, enter the 
heading in the Label box. The label can 
include special characters, leading numbers, 
and white space, but it cannot exceed 32 
characters. The default label is Label.

Results

Name of output table You can designate a different name for the 
output table. By default, the table is saved in 
the temporary Work library.

Transpose Data Task 91



92 Chapter 6 / Data Tasks



7
Econometrics Tasks

Count Data Regression Task . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
About the Count Data Regression Task . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
Example: Count Data Regression . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
Assigning Data to Roles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
Setting Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

Heckman Selection Model Task . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
About the Heckman Selection Model Task . . . . . . . . . . . . . . . . . . . . . . . . 100
Example: Heckman Selection Model Task . . . . . . . . . . . . . . . . . . . . . . . . 100
Assigning Data to Roles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Setting Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

Panel Data: Count Data Regression Task . . . . . . . . . . . . . . . . . . . . . . . . . . 104
About the Panel Data: Count Data Regression Task . . . . . . . . . . . . 104
Example: Count Data Regression with Panel Data . . . . . . . . . . . . . . 105
Assigning Data to Roles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
Setting Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107

Panel Data: Linear Regression . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110
About the Panel Data: Linear Regression Task . . . . . . . . . . . . . . . . . . 110
Example: Linear Regression with Panel Data . . . . . . . . . . . . . . . . . . . . . 110
Assigning Data to Roles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
Setting Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
Setting the Output Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115

Probit/Logit Regression Task . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
About the Probit/Logit Regression Task . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

93



Example: Probit/Logit Regression Task . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
Assigning Data to Roles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119
Setting Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119
Setting Output Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

Count Data Regression Task

About the Count Data Regression Task

Count regression fits regression models where the dependent variable has nonnegative 
integer or count values.

Note: The version of the task depends on what version of SAS/ETS is available at your 
site. For example, if your site is running SAS 9.4 (or earlier), SAS Studio is running 
version 1 of the Count Data Regression task. If you are running the first maintenance 
release for SAS 9.4, SAS/ETS 13.1 is available, and SAS Studio is running version 2 of 
the Count Data Regression task. The difference between the two versions is the 
addition of new options in SAS/ETS 13.1.

Example: Count Data Regression

To create this example:

1 Create the WORK.LONG97DATA data set. For more information, see 
“LONG97DATA Data Set” on page 262.

2 In the Tasks section, expand the Econometrics folder and double-click Count Data 
Regression. The user interface for the Count Data Regression task opens.

3 On the Data tab, select the WORK.LONG97DATA data set.

4 Assign columns to these roles:
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Role Column Name

Dependent variable art

Continuous variables ment
phd
mar

Categorical variables kid5

5 To run the task, click .
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Here is a subset of the results:
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Assigning Data to Roles

To run the Count Data Regression task, you must assign a column to the Dependent 
variable role.

Role Description

Dependent variable specifies the numeric column that has 
nonnegative integer or count values.
The Distribution option specifies the type of 
model to be analyzed. You can specify these 
types of models:
n Poisson regression model
n negative binomial regression model with a 

linear variance function
n negative binomial regression model with a 

quadratic variance function
n a zero-inflated Poisson model
n a zero-inflated negative binomial model

Continuous variables specifies the independent covariates 
(regressors) for the regression model. If you 
do not specify a continuous variable, the task 
fits a model that contains only an intercept.

Categorical variables specifies the variables to use to group data in 
the analysis.

Setting Options

Option Description

Methods
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Option Description

Type of covariances of the parameter 
estimates

specifies the type of covariance matrix of the 
parameter estimates.
You can specify these types of matrices:

n the covariance from the inverse Hessian 
matrix

n the covariance from the outer product mix
n the covariance from the outer product and 

Hessian matrices (also called the quasi-
maximum-likelihood-estimates)

Include the intercept in the model specifies whether to include the intercept in 
the model.

Optimization

Method specifies the iterative minimization method to 
use.

Maximum number of iterations specifies the maximum number of iterations 
for the selected method.

Plots
Note: The plot options are available only if you are running the first maintenance release for 
SAS 9.4.

Diagnostic Plots

Profile likelihood plot produces the profile likelihood functions of the 
model parameters. The model parameter on 
the X axis is varied, whereas all other 
parameters are fixed at their estimated 
maximum likelihood estimates.

Overdispersion diagnostic plot produces the overdispersion diagnostic plot.

Probability Plots
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Option Description

Specified count levels supplies the values of the response variable 
for the overall predictive probabilities plot and 
the predictive probability profiles plot. Each 
value should be a nonnegative integer. 
Nonintegers are rounded to the nearest 
integer.
This value can also be a list in the form X TO 
Y BY Z. For example, COUNTS(0 1 2 TO 10 
BY 2 15) creates a plot for counts 0, 1, 2, 4, 
6, 8, 10, and 15.

Overall predictive probabilities plot produces the overall predictive probabilities of 
the specified count levels.

Predictive probability profiles plot produces the predictive probability profiles of 
specified count levels against model 
regressors. The regressor on the X axis is 
varied, whereas all other regressors are fixed 
at the mean of the observed data set.

Zero-inflation Plots

Probability profiles plot of zero-inflation 
process selection

produces the probability profiles of zero-
inflation process selection and zero count 
prediction against model regressors. The 
regressor on the X axis is varied, whereas all 
other regressors are fixed at the mean of the 
observed data set.

Display plots specifies whether to display the plots in a 
panel or individually.

Output Tables

You can specify whether to include any output tables in the results.
Here is the information that you can include in the results:

n correlation matrix of the parameter estimates
n covariance matrix of the parameter estimates
n iteration history of the objective function and parameter estimates
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Heckman Selection Model Task

About the Heckman Selection Model Task

The Heckman's two-step selection method provides a means of correcting for non-
randomly selected samples. It is a two-stage estimation method. The first stage 
performs a probit analysis on a selection equation. The second stage analyzes an 
outcome equation based on the first-stage binary probit model.

Note: This task is available only if you are running SAS 9.4, which includes SAS/ETS 
12.3.

Example: Heckman Selection Model Task

To create this example:

1 Create the Work.Mroz data set. For more information, see “MROZ Data Set” on 
page 282.

2 In the Tasks section, expand the Econometrics folder and double-click Heckman 
Selection Model. The user interface for the Heckman Selection Model task opens.

3 On the Data tab, select the WORK.MROZ data set.

4 Assign columns to these roles:

Role Column Name

Selection Equation

Dependent variable inlf
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Role Column Name

Continuous variables nwifeinc
exper
expersq
age
kidslt6
kidsge6

Outcome Equation

Dependent variable lwage

Continuous variables exper
expersq

Categorical variables educ

5 To run the task, click .
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Here is a subset of the results:

Assigning Data to Roles

To run the Heckman Selection Model task, you must assign columns to the Dependent 
variable roles for the selection and outcome equations.

Role Column Name

Selection Equation
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Role Column Name

Dependent variable specifies a single numeric column that takes 
binary values. By default, the task uses 
samples where the dependent variable is 
equal to 1.

Continuous variables specifies the independent columns (or 
regressors) to use in the model for the 
selection equation dependent variable.

Categorical variables specifies how to group the values into levels.

Include the intercept specifies whether to include the intercept in 
the selection equation.

Outcome Equation

Dependent variable specifies a single numeric column to use.

Continuous variables specifies the independent columns (or 
regressors) to use in the model for the 
outcome equation dependent variable.

Categorical values specifies how to group the values into levels.

Include the intercept specifies whether to include the intercept in 
the selection equation.

Setting Options

Option Description

Methods

Variance estimation method specifies whether to calculate the standard 
errors by using the corrected standard errors 
or the OLS standard errors.
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Option Description

Type of covariances of the parameter 
estimates

specifies the method to calculate the 
covariance matrix of parameter estimates. 
You can select the covariance from the outer 
product matrix, from the inverse Hessian 
matrix, or from the output product and 
Hessian matrices (the quasi-maximum 
likelihood estimates).

Optimization method specifies the optimization method. You can 
also specify the maximum number of 
iterations for this method.

Output Tables

You can specify whether the results include the tables created by the task by default, the 
default tables and any additional tables that you select, or no tables.
Here is the information that you can include in the results:

n correlation matrix of the parameter estimates
n covariance matrix of the parameter estimates
n iteration history of the objective function and parameter estimates

Panel Data: Count Data Regression 
Task

About the Panel Data: Count Data Regression 
Task

The Panel Data: Count Data Regression task analyzes regression models for panel 
data in which the dependent variable is a nonnegative integer or count values. This task 
fits a one-way model where the cross-sectional effect is modeled in the error term.

Note: This task is available only if you are running the first maintenance release for 
SAS 9.4, which includes SAS/ETS 13.1.
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Example: Count Data Regression with Panel 
Data

To create this example:

1 Create the WORK.LONG97DATA data set. For more information, see 
“LONG97DATA Data Set” on page 262.

2 In the Tasks section, expand the Econometrics folder and double-click Panel Data: 
Count Data Regression. The user interface for the Panel Data: Count Data 
Regression task opens.

3 On the Data tab, select the WORK.LONG97DATA data set.

4 Assign columns to these roles:

Role Column Name

Dependent variable art

Continuous variables ment
phd
mar

Categorical variables kid5

Cross-sectional ID fem

5 To run the task, click .
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Here is a subset of the results:
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Assigning Data to Roles

To run the Count Panel Data Regression task, you must assign columns to the 
Dependent variable and Cross-sectional ID roles.

Role Description

Dependent variable specifies the numeric column that has 
nonnegative integer or count values.
The Distribution option specifies the type of 
model to be analyzed. You can specify these 
types of models:
n Poisson regression model
n negative binomial regression model with a 

linear variance function
n negative binomial regression model with a 

quadratic variance function

Continuous variables specifies the independent covariates 
(regressors) for the regression model. If you 
do not specify a continuous variable, the task 
fits a model that contains only an intercept.

Categorical variables specifies the variables to use to group data in 
the analysis.

Cross-sectional ID specifies the cross-section for each 
observation. You can specify whether the 
error component model is fixed or random.

Setting Options

Option Description

Methods
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Option Description

Type of covariances of the parameter 
estimates

specifies the type of covariance matrix of the 
parameter estimates.
You can specify these types of matrices:

n the covariance from the inverse Hessian 
matrix

n the covariance from the outer product mix
n the covariance from the outer product and 

Hessian matrices (also called the quasi-
maximum-likelihood-estimates)

Include the intercept in the model specifies whether to include the intercept in 
the model.

Optimization

Method specifies the iterative minimization method to 
use. You can specify the maximum number of 
iterations to perform for the selected method.

Plots

Diagnostic Plots

Profile likelihood plot produces the profile likelihood functions of the 
model parameters. The model parameter on 
the X axis is varied, whereas all other 
parameters are fixed at their estimated 
maximum likelihood estimates.

Overdispersion diagnostic plot produces the overdispersion diagnostic plot.

Probability Plots
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Option Description

Specified count levels supplies the values of the response variable 
for the overall predictive probabilities plot and 
the predictive probability profiles plot. Each 
value should be a nonnegative integer. 
Nonintegers are rounded to the nearest 
integer.
You can also specify a list in the form of X TO 
Y BY Z. For example, COUNTS(0 1 2 TO 10 
BY 2 15) specifies to plot counts for 0, 1, 2, 4, 
6, 8, 10, and 15.

Overall predictive probabilities plot produces the overall predictive probabilities of 
the specified count levels.

Predictive probability profiles plot produces the predictive probability profiles of 
specified count levels against model 
regressors. The regressor on the X axis is 
varied, whereas all other regressors are fixed 
at the mean of the observed data set.

Display plots specifies whether to display the plots in a 
panel or individually.

Output Tables

You can specify whether to include any output tables in the results.
Here is the information that you can include in the results:

n correlation matrix of the parameter estimates
n covariance matrix of the parameter estimates
n iteration history of the objective function and parameter estimates
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Panel Data: Linear Regression

About the Panel Data: Linear Regression 
Task

The Panel Data: Linear Regression task analyzes a class of linear econometric models 
that commonly arise when time series and cross-sectional data are combined. This type 
of pooled data on time series cross-sectional bases is often referred to as panel data. 
Typical examples of panel data include observations over time on households, 
countries, firms, trade, and so on. For example, in the case of survey data on household 
income, the panel is created by repeatedly surveying the same households in different 
time periods (years).

Note: The version of the task depends on what version of SAS/ETS is available at your 
site. For example, if your site is running the second maintenance release for SAS 9.3, 
SAS/ETS 12.1 is available, and SAS Studio is running version 1 of the Panel Data: 
Linear Regression task. If you are running SAS 9.4, SAS/ETS 12.3 is available, and 
SAS Studio is running version 2 of the Panel Data: Linear Regression task. The 
difference between the two versions is the addition of new options in SAS/ETS 12.3.

Example: Linear Regression with Panel Data

To create this example:

1 Create the WORK.GREENE data set. For more information, see “GREENE Data 
Set” on page 261.

2 In the Tasks section, expand the Econometrics folder and double-click Panel Data: 
Linear Regression. The user interface for the Panel Data: Linear Regression task 
opens.

3 On the Data tab, select the WORK.GREENE data set.

4 Assign columns to these roles:
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Role Column Name

Dependent variable cost

Continuous variables production

Cross-sectional ID firm

Time series ID year

5 To run the task, click .
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Assigning Data to Roles

To run the Panel Data: Linear Regression task, you must assign columns to the 
Dependent variable, Cross-sectional ID, and Time series ID roles.

Role Description

Dependent variable specifies the numeric column that contains 
the count values. The dependent count 
variable should take on only nonnegative 
integer values in the input data set.

Continuous variables specifies the independent covariates 
(regressors) for the regression model. If you 
do not specify a continuous variable, the task 
fits a model that contains only an intercept.

Categorical variables specifies the variables to use to group data in 
the analysis.

Cross-sectional ID specifies the cross section for each 
observation. The task verifies that the input 
data is sorted by the cross-sectional ID and 
by the time series ID within each cross 
section.

Time series ID specifies the time period for each 
observation. The task verifies that the time 
series ID values are the same for all cross 
sections.

Setting Options

Option Description

Model
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Option Description

Model type specifies that a one-way random-effects 
model be estimated or a one-way fixed-
effects model be estimated with the one-way 
model corresponding to cross-sectional 
effects only.
Note: The remaining options that are 
available in the Model Options section 
depend on whether you are creating a 
random or fixed effect.

Include the intercept in the model specifies whether to include the model. This 
option applies whether you are creating a 
random effects model or a fixed effects 
model.
Note: This option is available only if you are 
running on SAS 9.4.

Random Effects

Random effects specifies whether a one-way or two-way 
random-effects model is estimated. By 
default, a one-way random-effects model is 
estimated.

Variance component estimation method specifies the type of variance component 
estimate to use. For more information about 
the type of estimations, see the PANEL 
procedure in SAS/ETS User’s Guide.

Test for Random Effects

One-way Breusch-Pagan test
Two-way Breusch-Pagan test

requests the Breusch-Pagan one-way or two-
way test for random effects.

Fixed Effects

Fixed effects specifies whether a one-way or two-way 
fixed-effects model is estimated.
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Option Description

Display the fixed effects specifies whether to include the fixed effects 
in the results.
Note: This option is available only if you are 
running on SAS 9.4.

Methods

Covariance matrix estimator specifies the estimator of the covariance 
matrix. You can select from these options:
n Newey and West

Note: This option is available only if 
you are running on SAS 9.4.

n OLS estimator specifies that the variance-
covariance matrix is not corrected. 

n HCCME 0–4 specifies a heteroscedasticity-
corrected covariance matrix

Cluster correction for heteroscedasticity-
consistent covariance matrix

specifies the cluster correction for the 
variance-covariance matrix.

Setting the Output Options

Option Description

Plots

Diagnostic Plots

You can display these types of diagnostic plots:
n Plot of the predicted and actual values
n QQ plot of residuals
n Plot of residuals
n Histogram of residuals

Cross Sections Plots
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Option Description

The number of cross sections to be 
combined into one time series plot

specifies the number of cross sections to be 
combined into one time series plot.
Note: This option is available only if you 
display the plots individually.

You can display these types of cross-sectional plots:
n Plot of actual values by time series
n Predicted values by time series
n Stacked residuals by time series
n Residuals by time series

Display plots specifies whether to display the plots in a 
panel or individually.

Output Tables

You can specify whether the results include the tables created by the task by default, the 
default tables and any additional tables that you select, or no tables.
Here is the information that you can include in the results:

n correlation matrix of the parameter estimates
n covariance matrix of the parameter estimates
n iteration history of the objective function and parameter estimates

Probit/Logit Regression Task

About the Probit/Logit Regression Task

The Probit/Logit Regression task analyzes univariate dependent variable models. In 
these models, the dependent variable takes binary values and assumes either a 
standard normal distribution or a logistic distribution.

Note: The version of the task depends on what version of SAS/ETS is available at your 
site. For example, if your site is running the second maintenance release for SAS 9.3, 
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SAS/ETS 12.1 is available, and SAS Studio is running version 1 of the Probit/Logit 
Regression task. If you are running SAS 9.4, SAS/ETS 12.3 is available, and SAS 
Studio is running version 2 of the Probit/Logit Regression task. The difference between 
the two versions is the addition of new options in SAS/ETS 12.3.

Example: Probit/Logit Regression Task

To create this example:

1 Create the Work.Mroz data set. For more information, see “MROZ Data Set” on 
page 282.

2 In the Tasks section, expand the Econometrics folder and double-click Probit/
Logit Regression. The user interface for the Probit/Logit Regression task opens.

3 On the Data tab, select the WORK.MROZ data set.

4 Assign columns to these roles:

Role Column Name

Dependent variable inlf

Continuous variables nwifeinc
exper
expersq
age
kidslt6
kidsge6

Categorical variables educ

5 To run the task, click .
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Here is a subset of the results:
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Assigning Data to Roles

To run the Probit/Logit Regression task, you must assign a column to the Dependent 
variable role.

Role Description

Dependent variable specifies the numeric column to use as the 
dependent variable for the regression 
analysis.
Use the Distribution drop-down list to specify 
whether to create a probit or logit model.

Continuous variables specifies the numeric columns to use as the 
independent regressor (explanatory) 
variables for the regression model.

Categorical variables specifies how to group values into levels.

Setting Options

Option Description

Methods

Type of covariances of the parameter 
estimates

specifies the type of covariance matrix of the 
parameter estimates.
You can specify these types of matrices:

n the covariance from the inverse Hessian 
matrix

n the covariance from the outer product mix
n the covariance from the outer product and 

Hessian matrices (also called the quasi-
maximum-likelihood-estimates)

Include the intercept in the model specifies whether to include the intercept in 
the model.
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Option Description

Optimization

Method specifies the iterative minimization method to 
use. By default, the Quasi-Newton method is 
used.

Maximum number of iterations specifies the maximum number of iterations 
for the selected method.

Heteroscedasticity

Variables on the variance function specifies the columns that are related to 
heteroscedasticity of the residuals and how 
these variables are used to model error 
variances. Here is the heteroscedastic 
regression model that is supported by this 
task: yi = xi′β + εi

εi~N (0, σi2)

Form of variance function specifies the link function to use. You can 
choose from these options:
n Exponential σi2 = σ 2(1 + exp (zi′γ))
n Exponential with no constant 
σi2 = σ 2exp (zi′γ)

n Linear σi2 = σ 2(1 + zi′γ)
n Linear with no constant σi2 = σ 2(zi′γ)
n Square of linear function 
σi2 = σ 2(1 + (zi′γ)2)

n Square of linear function with no 
constant σi2 = σ 2(zi′γ)2
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Setting Output Options

Option Description

Plots

Diagnostic Plots

Error standard deviations by observed 
regressor

displays the error standard deviation versus 
observed regressors when you assign a 
column to the Variables on the variance 
function option.

Profiled log likelihood displays the profiled log likelihood. Each 
profiled graph is obtained by setting all the 
parameters to their maximum likelihood 
estimate except for the profiling parameter. 
The profiling parameter takes values on a 
predefined grid that is determined by the 
maximum likelihood estimate of the 
corresponding standard deviation.

Output Plots

Predicted values by regressor displays the model predicted values. Each 
contributing regressor is set equal to its 
mean, except for the parameter that is 
reported on the X axis.

Marginal effects by regressor displays the marginal effects. Each 
contributing regressor is set equal to its 
mean, except for the parameter that is 
reported on the X axis.

Inverse Mills ratio by regressor displays the inverse Mills ratio. Each 
contributing regressor is set equal to its 
mean, except for the parameter that is 
reported on the X axis.
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Option Description

Predicted response probability by 
regressor

displays the predicted response probability. 
Each contributing regressor is set equal to its 
mean, except for the parameter that is 
reported on the X axis.

Predicted probabilities for each level of 
the response by regressor

displays the predicted probabilities for each 
level of the response. Each contributing 
regressor is set equal to its mean, except for 
the parameter that is reported on the X axis.

Linear predictor values by regressor displays the structural part on the right side of 
the model. Each contributing regressor is set 
equal to its mean, except for the parameter 
that is reported on the X axis.

Display plots specifies whether to display the plots in a 
panel or individually.

Output Tables

You can specify whether to include any output tables in the results.
Here is the information that you can include in the results:

n correlation matrix of the parameter estimates
n covariance matrix of the parameter estimates
n iteration history of the objective function and parameter estimates
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8
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Bar Chart Task

About the Bar Chart Task

The Bar Chart task creates horizontal or vertical bar charts that compare numeric 
values or statistics between different values of a chart variable. Bar charts show the 
relative magnitude of data by displaying bars of varying height. Each bar represents a 
category of data.
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Example: Bar Chart of Mean Sales for Each 
Product Line

For example, you can create a bar chart that compares the total amount of sales for 
each product line in the Sashelp.Pricedata data set. By default, the task calculates the 
mean of the response variable for each product line. This bar chart shows that Line 2 
has the highest mean product sales.

To create this example:

1 In the Tasks section, expand the Graph folder and double-click Bar Chart. The user 
interface for the Bar Chart task opens.

2 On the Data tab, select the SASHELP.PRICEDATA data set.

3 Assign columns to these roles:

Role Column Name

Category variable productLine

Response variable sale

4 To run the task, click .
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Here are the results:

Assigning Data to Roles

To run the Bar Chart task, you must assign a column to the Category variable role.

Role Description

Category variable specifies the variable that classifies the 
observations into distinct subsets.

Response variable specifies a numeric response variable for the 
plot.
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Role Description

Group variable specifies a variable that is used to group the 
data.

URL variable specifies a character variable that contains 
URLs for web pages to be displayed when 
parts of the plot are selected within an HTML 
page.

BY variable creates a separate graph for each BY group.

Setting Options

Option Name Description

Direction

You can create either a vertical or horizontal bar chart.

Title and Footnote

You can specify a custom title and footnote for the output.

Group Layout

Cluster displays group values as separate adjacent 
bars that replace the single category bar. 
Each set of group values is centered at the 
midpoint tick mark for the category.

Stack overlays group values without any clustering. 
Each group is represented by unique visual 
attributes derived from the GraphData1... 
GraphDatan style elements in the current 
style.

Statistics

Mean calculates the mean of the response variable.
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Option Name Description

Sum calculates the sum of the response variable.

Limits

Limits specifies which limit lines to display. Limits 
are displayed as heavier line segments with a 
serif at the end that extends from each bar. 
Limit lines are displayed only if you select the 
Mean statistic.

Limit statistic specifies the statistic for the limit lines.

Limit multiplier specifies the number of standard units for the 
limit lines. By default, this value is 1.

Bar Details

Apply bar color specifies the color for the bars when a column 
is not assigned to the Group variable role.

Transparency specifies the degree of transparency for the 
plot. The range is 0 (completely opaque) to 1 
(completely transparent).

Data skin specifies a special effect to be used on all 
filled bars.

Bar Labels

Show bar labels or statistics displays the values of the calculated 
response as data labels.

Category Axis

Reverse specifies that the values for the tick marks are 
displayed in reverse (descending) order.

Show values in data order places the discrete values for the tick marks 
in the order in which they appear in the data.
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Option Name Description

Show label enables you to display a label for the axis. 
Enter this label in the Custom label box.

Response Axis

Show grid creates grid lines at each tick on the axis.

Append statistics to axis label includes the name of the calculated statistic in 
the axis label. For example, if you are 
calculating the mean, the axis label could be 
Weight (Mean).

Custom Label enables you to customize the label for the 
response axis. By default, the axis label is the 
name of the variable.

Legend Details

Show legend specifies whether to display a legend in the 
output.

Legend location specifies whether the legend is placed 
outside or inside of the axis area.

Graph Size

You can specify the width and height of the graph in inches.

Bar-Line Chart Task

About the Bar-Line Chart Task

The Bar-Line Chart task creates a vertical bar chart with a line chart overlay.

You can use this task to perform the following tasks:

n display and compare exact and relative magnitudes
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n examine the contribution of each part to the whole

n determine trends and patterns in the data

Example: City and Highway Mileage by Origin

For example, you can create a bar-line chart that compares the number of miles per 
gallon (in the city and on the highway) that cars use depending on their country of 
origin. The task calculates the mean of the number of miles per gallon in the city and in 
the highway for each country. This bar-line chart shows that cars from Asia tend to get 
the highest number of miles per gallon in city and highway driving.

To create this example:

1 In the Tasks section, expand the Graph folder and double-click Bar-Line Chart. 
The user interface for the Bar-LineChart task opens.

2 On the Data tab, select the SASHELP.CARS data set.

3 Assign columns to these roles:

Role Column Name

Category variable Origin

Bar response variable MPG_City

Line response variable MPG_Highway

4 To run the task, click .
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Assigning Data to Roles

To run the Bar-Line Chart task, you must assign a column to the Category variable, 
Bar response variable, and Line response variable roles.

Role Description

Category variable specifies the variable that classifies the 
observations into distinct subsets.

Bar response variable specifies a numeric response variable for the 
bar chart.
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Role Description

Line response variable specifies a numeric response variable for the 
line plot.

Group variable specifies a variable that is used to group the 
data.

URL variable specifies a character variable that contains 
URLs for web pages to be displayed when 
parts of the plot are selected within an HTML 
page.

Setting Options

Option Name Description

Title and Footnote

You can specify a custom title and footnote for the output.

Statistics

Mean calculates the mean of the response 
variables.

Sum calculates the sum of the response variables.

Bar Details

Apply bar color specifies the color for the bars.

Transparency specifies the degree of transparency for the 
plot. The range is 0 (completely opaque) to 1 
(completely transparent).

Data skin specifies a special effect to be used on all 
filled bars.

Line Details
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Option Name Description

Apply line color specifies the color for the line.

Line thickness specifies the thickness (in pixels) of the line.

Transparency specifies the degree of transparency for the 
plot. The range is 0 (completely opaque) to 1 
(completely transparent).

Use solid line pattern specifies a solid pattern for the line.

Category Axis

Reverse specifies that the values of the tick marks are 
displayed in reverse (descending) order.

Show values in data order places the discrete values for the tick marks 
in the order in which they appear in the data.

Show label enables you to display a label for the axis. 
Enter this label in the Custom label box.

Response Axes

Use zero baseline specifies whether to offset all lines from the 
discrete category values and all bars from 
category midpoints. By default, there is no 
offset.

Use uniform scale uses the same scale for both response axes.

Show grid on left (bar) axis creates grid lines at each tick on the axis for 
the bar chart.

Append statistics to axis labels includes the name of the calculated statistic in 
the axis label. For example, if you are 
calculating the mean, the axis label could be 
Weight (Mean).

Add plot prefix to axis labels adds (Bar) and (Line) to the labels for the 
response axes.
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Option Name Description

Custom label for left (bar) axis enables you to specify a custom label for the 
response axis in the bar chart. The default 
label is the name of the bar response 
variable.

Custom label for right (line) axis enables you to specify a custom label for the 
response axis in the line chart. The default 
label is the name of the line response 
variable.

Legend Details

Show legend specifies whether to display a legend in the 
output.

Legend location specifies whether the legend is placed 
outside or inside of the axis area.

Graph Size

You can specify the width and height of the graph in inches.

Histogram Task

About the Histogram Task

The Histograms task creates a chart that displays the frequency distribution of a 
numeric variable.

Example: Histogram of Stock Volume

To create this example:

1 In the Tasks section, expand the Graph folder and double-click Histogram. The 
user interface for the Histogram task opens.
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2 In the Data tab, select the SASHELP.STOCKS data set.

3 To the Analysis variable role, assign the Volume column.

4 To run the task, click .

Here are the results:

Assigning Data to Roles

To run the Histogram task, you must assign a column to the Analysis variable role.

Setting Options

Option Name Description

Title and Footnote
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Option Name Description

You can specify a custom title and footnote for the output.

Density Curves

You can specify whether to create a density curve that shows the distribution of values for a 
numeric variable. You can create density curves for normal and kernel distributions.

Bin Details

For the bins in the histogram, you can specify the color and the transparency.

Horizontal Axis

Interval axis creates tick marks at regular intervals on the 
horizontal axis based on the minimum and 
maximum values of the analysis variable.

Bin axis creates tick marks at the midpoints of the 
value bins on the horizontal axis.

Specify number of bins enables you to specify the number of bins in 
the histogram. Valid values range from 2 to 
20.
The bins always span the range of data. The 
task tries to produce tick values that are 
easily interpreted (for example, 5, 10, 15, 20). 
Sometimes the location of the first bin and the 
bin width might be adjusted. By default, the 
task automatically determines the number of 
bins.

Show label displays the label for the analysis variable 
along the horizontal axis. You can also enter 
a custom label.

Vertical Axis
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Option Name Description

Specify axis scaling specifies the scaling that is applied to the 
vertical axis. You can choose from these 
options:
COUNT

the axis displays the frequency count
PERCENT

the axis displays values as a percentage of 
the total.

PROPORTION
the axis displays values as proportions 
(0.0 to 1.0) of the total.

Show grid specifies whether to show the grid lines for 
the vertical axis.

Show label specifies whether to show the label for the 
type of axis scaling.

Legend Details

Show legend specifies whether to display a legend in the 
output.

Legend location specifies whether the legend is placed 
outside or inside of the axis area.

Graph Size

You can specify the width and height of the graph in inches.
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Line Chart Task

About the Line Chart Task

The Line Chart task assumes that the values in the category variable are discrete. The 
task groups these values into distinct categories. If you assign a column from the input 
data source to the Response variable role, you can select the statistic (either mean or 
sum) for the response values. By default, the task calculates the mean of the values for 
the response variable. If no response variable is assigned, a frequency chart by 
category is created.

Example: Displaying the Mean Horsepower 
for Each Car Type

In this example, you want to display the mean horsepower for each car type in a line 
plot. The result shows that sports cars have the highest average horsepower and hybrid 
cars have the lowest average horsepower.

To create this example:

1 In the Tasks section, expand the Graph folder and double-click Line Chart. The 
user interface for the Line Chart task opens.

2 On the Data tab, select the SASHELP.CARS data set.

3 Assign columns to these roles:

Role Column Name

Category variable Type

Response variable Horsepower

4 To run the task, click .
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Assigning Data to Roles

To run the Line Chart task, you must assign a column to the Category variable role.

Role Description

Category variable specifies the variable that classifies the 
observations into distinct subsets.

Response variable specifies a numeric response variable for the 
plot.

Group variable specifies a variable that is used to group the 
data.
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Role Description

URL variable specifies a character variable that contains 
URLs for web pages to be displayed when 
parts of the plot are selected within an HTML 
page.

Setting Options

Option Name Description

Title and Footnote

You can specify a custom title and footnote for the output.

Statistics

Mean calculates the mean of the response variable.

Sum calculates the sum of the response variable.

Line Details

Apply line color specifies the color for the line when you do 
not assign a column to the Group variable 
role.

Line thickness specifies the thickness (in pixels) of the line.

Transparency specifies the degree of transparency for the 
plot. The range is 0 (completely opaque) to 1 
(completely transparent).

Use solid line specifies a solid pattern for the line.

Line Labels

Show line labels displays the label from the response variable. 
If you assign a column to the Group variable 
role, each line is labeled with the group value.
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Option Name Description

Category Axis

Reverse specifies that the values of the tick marks are 
displayed in reverse (descending) order.

Show values in data order places the discrete tick values in the order in 
which they appear in the data.

Show label enables you to display a label for the axis. By 
default, the label is the variable name.
To customize this label, enter this label in the 
Custom label box.

Response Axis

Show grid creates grid lines at each tick on the axis.

Append statistics to axis label includes the name of the calculated statistic in 
the axis label. For example, if you are 
calculating the mean, the axis label could be 
Weight (Mean).

Custom label enables you to customize the label for the 
response axis. By default, the axis label is the 
name of the variable.

Legend Details

Show legend specifies whether to display a legend in the 
output.

Legend location specifies whether the legend is placed 
outside or inside of the axis area.

Graph Size

You can specify the width and height of the graph in inches.
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Pie Chart Task

About the Pie Chart Task

The Pie Chart task creates pie charts that represent the relative contribution of the parts 
to the whole by displaying data as wedge-shaped "slices" of a circle. Each slice 
represents a category of data. The size of a slice represents the contribution of the data 
to the total chart statistic.

Example: Pie Chart That Shows Total MSRP 
for Each Car Type by Region

In this example, you want to compare the manufacturer’s suggested retail price (MSRP) 
for each car type grouped by region of origin. The resulting pie chart consists of six 
rings—one for each car type. The rings are then subset into the MSRP values for the 
three regions: Asia, Europe, and USA. Using this chart, you can compare the total 
MSRP values for each region. The ring for the SUV car type shows that the USA has 
the highest MSRP and that Europe has the lowest MSRP.

To create this example:

1 In the Tasks section, expand the Graph folder and double-click Pie Chart. The user 
interface for the Pie Chart task opens.

2 On the Data tab, select the SASHELP.CARS data set.

3 Assign columns to these roles:

Role Column Name

Category variable Origin

Response variable MSRP

Group variable Type
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4 To run the task, click .

Here is the result:
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Assigning Data to Roles

To run the Pie Chart task, you must assign a column to the Category variable role.

Role Description

Category variable specifies the variable that classifies the 
observations into distinct subsets.

Response variable specifies a numeric response variable for the 
plot.

Group variable specifies a variable that is used to group the 
data.

URL variable specifies a character variable that contains 
URLs for web pages to be displayed when 
parts of the plot are selected within an HTML 
page.

Setting Options

Option Name Description

Title and Footnote

You can specify a custom title and footnote for the output.

Orientation

Starting point specifies where to create the first slice in the 
pie chart. The remaining slices appear 
counterclockwise.

Center the first slice specifies whether to offset the first slice.

Pie Details
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Option Name Description

Data skin specifies a special effect to be used on all 
filled bars.

Transparency specifies the degree of transparency for the 
plot. The range is 0 (completely opaque) to 1 
(completely transparent).

Pie Labels

Location specifies whether to display the label inside or 
outside the slice in the pie chart. By default, 
the Pie Chart task determines the best 
location for the slice.

Font size specifies the font size of the label for each 
slice.

Graph Size

You can specify the width and height of the graph in inches.

Scatter Plot Task

About the Scatter Plot Task

The Scatter Plot task creates plots that show the relationships between two or three 
variables by revealing patterns or concentrations of data points. For example, a two-
dimensional scatter plot can display the heights and weights of all students in a class.

Example: Scatter Plot of Height versus 
Weight

In this example, you want to create a scatter plot of height versus weight.
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To create this example:

1 In the Tasks section, expand the Graph folder and double-click Scatter Plot. The 
user interface for the Scatter Plot task opens.

2 On the Data tab, select the SASHELP.CLASS data set.

3 Assign columns to these roles:

Role Column Name

X variable Height

Y variable Weight

4 To run the task, click .
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Assigning Data to Roles

To run the Scatter Plot task, you must assign columns to the X variable and Y variable 
role.

Role Description

X variable specifies the variable for the x axis.

Y variable specifies the variable for the y axis.
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Role Description

Group variable specifies a variable that is used to group the 
data. The plot elements for each group value 
are automatically distinguished by different 
visual attributes.

Marker label variable displays a label for each data point. If you 
specify a variable, the values of that variable 
are used for the data labels. If you do not 
specify a variable, then the values of the Y 
variable are used for the data labels.

URL variable specifies a character variable that contains 
URLs for web pages to be displayed when 
parts of the plot are selected within an HTML 
page.

Setting Options

Option Name Description

Title and Footnote

You can specify a custom title and footnote for the output.

Marker Details

You can specify the symbol type, color, and size of the markers. You can also specify the 
degree of transparency for the plot. The range is 0 (completely opaque) to 1 (completely 
transparent).

Marker Labels

Font size specifies the appearance of the labels in the 
plot when you assign a variable to the Marker 
label variable role.

X Axis, Y Axis
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Option Name Description

Show grid lines creates grid lines at each tick on the axis.

Show label displays the label for the axis. By default, the 
label is the variable name.
To customize, enter this label in the Custom 
label box.

Legend Details

Show legend displays a legend in the output.

Legend location specifies whether the legend is placed 
outside or inside of the axis area.

Graph Size

You can specify the width and height of the graph in inches.

Series Plot Task

About the Series Plot Task

The Series Plot task creates a line plot. Series plots display a series of line segments 
that connect observations of input data.

Example: Series Plot of Stock Trends

In this example, you want to create a series plot that shows stock trends.

To create this example:

1 In the Tasks section, expand the Graph folder and double-click Series Plot. The 
user interface for the Series Plot task opens.
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2 On the Data tab, select the SASHELP.STOCKS data set.

3 Assign columns to these roles:

Role Column Name

X variable Date

Y variable Open

Group variable Stock

4 To run the task, click .
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The resulting series plot shows the stock values for three companies.

Assigning Data to Roles

To run the Series Plot task, you must assign columns to the X variable and Y variable 
roles.

Role Description

X variable specifies the variable for the x axis.

Y variable specifies the variable for the y axis.
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Role Description

Group variable specifies a variable that is used to group the 
data.

URL variable specifies a character variable that contains 
URLs for web pages to be displayed when 
parts of the plot are selected within an HTML 
page.

Setting Options

Option Name Description

Title and Footnote

You can specify a custom title and footnote for the output.

Plot Details

You can specify the symbol type, color, and size of the markers in the scatter plot. You can 
also specify the degree of transparency for the plot. The range is 0 (completely opaque) to 1 
(completely transparent).

Plot Labels

Show plot labels adds a label for the curve. You can also 
specify the size of this text.

X Axis, Y Axis

Show grid lines creates grid lines at each tick on the axis.

Show label displays the label for the axis. By default, the 
label is the variable name.
To customize, enter this label in the Custom 
label box.

Legend Details
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Option Name Description

Show legend displays a legend in the output.

Legend location specifies whether the legend is placed 
outside or inside of the axis area.

Graph Size

You can specify the width and height of the graph in inches.

Simple HBar Task

About the Simple HBar Task

The Simple HBar task creates a simple horizontal bar chart. You can customize the title, 
footnotes, axes, and legends for the horizontal bar chart.

Example: Horizontal Bar Chart of Mileage by 
Origin and Type

To create this horizontal bar chart:

1 In the Tasks section, expand the Graphs folder and double-click Simple HBar. The 
user interface for the Simple HBar task opens.

2 On the Data tab, select the SASHELP.CARS data set.

3 Assign columns to these roles:

Role Column Name

Category variable Origin

Response variable MPG_City
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Role Column Name

Group variable Type

4 To run the task, click .

Here are the results:
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Assigning Data to Roles

To run the Simple HBar task, you must assign a column to the Category variable role.

Role Description

Category variable specifies the variable that classifies the 
observations into distinct subsets.

Response variable specifies a numeric response variable for the 
plot.

Group variable specifies a variable that is used to group the 
data.

URL variable specifies a character variable that contains 
URLs for web pages to be displayed when 
parts of the plot are selected within an HTML 
page.

Setting Options

Option Name Description

Title and Footnote

You can specify a custom title and footnote for the output.

Group Layout

Cluster displays group values as separate adjacent 
bars that replace the single category bar. 
Each set of group values is centered at the 
midpoint tick mark for the category.
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Option Name Description

Stack overlays group values without any clustering. 
Each group is represented by unique visual 
attributes that are derived from the 
GraphData1... GraphDatan style elements in 
the current style.

Statistics

Mean calculates the mean of the response variable.

Sum calculates the sum of the response variable.

Bar Details

Apply bar color specifies the color for the bars when a column 
is not assigned to the Group variable role.

Transparency specifies the degree of transparency for the 
plot. The range is 0 (completely opaque) to 1 
(completely transparent).

Data skin specifies a special effect to be used on all 
filled bars.

Bar Labels

Show bar labels displays the values of the calculated 
response as data labels.

Category Axis

Reverse specifies that the values of the tick marks are 
displayed in reverse (descending) order.

Show values in data order places the discrete tick values in the order in 
which they appear in the data.

Show label enables you to display a label for the axis. 
Enter this label in the Custom label box.

Response Axis
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Option Name Description

Show grid creates grid lines at each tick on the axis.

Append statistics to axis label includes the name of the calculated statistic in 
the axis label. For example, if you are 
calculating the mean, the axis label could be 
Weight (Mean).

Custom Label enables you to customize the label for the 
response axis. By default, the axis label is the 
name of the variable.

Legend Details

Legend location specifies whether the legend is placed 
outside or inside of the axis area.

Graph Size

You can specify the width and height of the graph in inches.
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About the High-Performance Tasks

The high-performance tasks are designed to be used with large data sets.

Bin Continuous Data Task

About the Bin Continuous Data Task

The Bin Continuous Data task is a data preparation task. This task divides the data 
values of a continuous variable into intervals and replaces the values for each interval 
with a single value that is representative of the interval.

Note: This task is available only if you are running SAS 9.4.

Example: Winsorized Binning

In this example, the task provides the basic Winsorized statistical information for the 
input data.

To create this example:

1 To create the Work.Ex12 data set, enter this code into a Program tab:

data ex12;
   length id 8;
   do id=1 to 10000;
      x1 = ranuni(101);
      x2 = 10*ranuni(201);
      x3 = 100*ranuni(301);
      output;
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   end;
run;

Click .

2 In the Tasks section, expand the High Performance folder and double-click Bin 
Continuous Data. The user interface for the Bin Continuous Data task opens.

3 On the Data tab, select the WORK.EX12 data set.

4 To the Variables to bin role, assign the x1 and x2 columns.

5 Select the Options tab and set these options:

n In the Number of bins box, enter 10.

n From the Method drop-down list, select Winsorized binning.

6 To run the task, click .
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Here is a subset of the results:

162 Chapter 9 / High-Performance Tasks



Assigning Data to Roles

To run the Bin Continuous Data task, you must assign a variable to the Variables to 
bin role.

Role Description

Roles

Variables to bin specifies one or more variables as input 
variables for binning. The specified variables 
must be interval variables.

Additional Roles

Frequency count specifies a numeric variable that contains the 
frequency of occurrence for each observation. 
If the frequency value is less than 1 or is 
missing, the observation is not used in the 
analysis. By default, each observation is 
assigned a frequency of 1.

Setting Options

Option Name Description

Methods

Number of bins specifies the global number of binning levels 
for all binning variables. This value can be 
any integer between 2 and 1,000, inclusive. 
The default number of binning levels is 16.
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Option Name Description

Method specifies which binning method to use.

n Bucket binning creates equal-length bins 
and assigns the data to one of these bins. 
You can choose the number of bins during 
the binning. The default number of bins 
(the binning level) is 16. 

n Winsorized binning is similar to bucket 
binning except that both tails are cut off to 
obtain a smooth binning result. This 
technique is often used to remove outliers 
during the data preparation stage. 
You must specify a value for the Winsor 
rate option. Valid values are from 0.0 to 0.5 
(exclusive).

n Pseudo-quantile binning mimics the 
results of the quantile binning method but 
is more efficient by consuming less CPU 
time and memory.

Tables

Select tables to display In the results, you can specify whether to 
include no tables, the default tables for the 
task, or customized tables.
If you create customized tables, you can 
choose from these options:
n Basic statistics displays the mean, 

pseudo-median, standard deviation, 
minimum, maximum, and number of bins 
for each binning variable. 

n Quantile statistics displays the estimated 
quantiles and extremes table.

Output Data Sets

You can specify whether to save the results to an output table. If the table is created, it is 
saved in the Work library by default. In the Additional variables to include in the output 
data set role, specify any columns from the input data set that you want to include in the 
output data set.
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High-Performance CorrelationsTask

About the High-Performance Correlations 
Task

Correlation is a statistical procedure for describing the relationship between numeric 
variables. The relationship is described by calculating correlation coefficients for the 
variables. The High-Performance Correlations task calculates a Pearson product-
moment correlation. This is a parametric measure of association for two continuous 
random variables. Correlations range from –1 to 1.

Note: This task is available only if you are running SAS 9.4.

Example: Correlation between Engine Size 
and the Number of Cylinders

To create this example:

1 Create the Work.Fitness data set. For more information, see “FITNESS Data set” on 
page 257.

2 In the Tasks section, expand the High Performance folder and double-click 
Correlations. The user interface for theHigh-Performance Correlations Analysis 
task opens.

3 On the Data tab, select the WORK.FITNESS data set.

4 To the Analysis variables role, assign the Weight, Oxygen, and RunTime 
columns.

5 To run the task, click .
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Here are the results:

Assigning Data to Roles

To run the High-Performance Correlations task, you must assign two columns to the 
Analysis variables role.

Role Description

Analysis variables specifies the columns to use to calculate the 
correlation coefficients.

Frequency count specifies a numeric column whose value 
represents the frequency of the observation.
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Role Description

Weight specifies the weights to use in the calculation 
of Pearson weighted product-moment 
correlation.

Setting Options

Option Name Description

Methods

Missing values specifies whether to include missing values in 
the calculations.
n If you select the Use non-missing values 

for all selected variables options, any 
observations that have missing values are 
excluded from the analysis.

n If you select the Use non-missing values 
for pairs of variables option, the data for 
an observation contributes to the 
correlation between two variables as long 
as both values are nonmissing. As a result, 
the correlations that are calculated for the 
analysis variable might be based on a 
different number of observations.

Tables

You can specify whether the results include only the tables that the task automatically 
generates, the default tables and any additional tables that you selected, or no tables. By 
default, only the correlations table is displayed in the results.
You can also include these values in the tables:
n covariances
n sum of squares and cross-products
n corrected sum of squares and cross-products
n descriptive statistics

High-Performance CorrelationsTask 167



Option Name Description

Display p-values specifies whether to display the probabilities 
that are associated with each correlation 
coefficient.

Order correlations from highest to lowest displays the ordered correlation coefficients 
for each variable. Correlations are ordered 
from highest to lowest in absolute value.

Output Data Set

You can specify whether to save the results to an output data set, which is saved in the Work 
library by default.
By default, the output data set contains the correlations. You can also include covariances, 
sum of squares and cross-products, and corrected sum of squares and cross-products.

Generalized Linear Models

About the Generalized Linear Models Task

The Generalized Linear Models task is a high-performance task that provides model 
fitting and model building for generalized linear models. It fits models for standard 
distributions such as normal, Poisson, and Tweedie in the exponential family. This task 
also fits multinomial models for ordinal and nominal responses. The task provides 
forward, backward, and stepwise selection methods.

Note: This task is available only if you are running SAS 9.4.

Example: Model Selection

To create this example:

1 Create the Work.getStarted data set. For more information, see “GETSTARTED 
Data Set” on page 258.
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2 In the Tasks section, expand the High Performance folder and double-click 
Generalized Linear Models. The user interface for the Generalized Linear Models 
task opens.

3 On the Data tab, select the WORK.GETSTARTED data set.

4 Assign columns to these roles:

Role Description

Response variable Y
From the Distribution drop-down list, 
select Poisson.

Classification variables C1
C2
C3
C4
C5

5 Click the Models tab. From the Selection method drop-down list under the Model 
Selection heading, select Forward selection.

6 To run the task, click .
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Here is a subset of the results:
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Assigning Data to Roles

To run the Generalized Linear Model task, you must assign a column to the Response 
variable role.

Role Description

Roles

Response variable specifies the numeric column that contains 
the count values. The dependent count 
variable should be only nonnegative integer 
values in the input data set.
You can specify these distributions for your 
model:
n Binary
n Gamma
n Inverse Gaussian
n Multinomial
n Negative binomial
n Normal
n Poisson
You can specify these link functions for your 
model:
n complementary log-log
n log-log
n logit
n generalized logit
n probit
n identity
n reciprocal
n reciprocal square
n logarithm
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Role Description

Response variables (continued) If you select Default for the link function, then 
the default link function for the model 
distribution is used.
Here is the list of distributions with the corresponding 
default link function:

n Binomial distribution uses the logit link 
function.

n Gamma distribution uses the reciprocal link 
function.

n Inverse Gaussian distribution uses the 
reciprocal square link function.

n Multinomial distribution uses the 
cumulative logit link function.

n Negative binomial distribution uses the log 
link function.

n Normal distribution uses the identity link 
function.

n Poisson distribution uses the log link 
function.

Continuous variables specifies the independent covariates 
(regressors) for the regression model. If you 
do not specify a continuous variable, the task 
fits a model that contains only an intercept.

Classification variables specifies the variables to use to group 
(classify) data in the analysis. Classification 
variables can be either character or numeric.

Additional Roles

Frequency count specifies the numeric column that contains 
the frequency of occurrence for each 
observation.

Weight variable specifies the column to use as a weight to 
perform a weighted analysis of the data.
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Building a Model

Requirements for Building a Model

By default, no effects are specified, which results in the task fitting an intercept-only 
model. To specify an effect, you must assign at least one variable to the Continuous 
variables or Classification variables role. You can select combinations of variables to 
create crossed, factorial, or polynomial effects.

Create a Main Effect

1 Select the variable name in the Variables box.

2 Click Add to add the variable to the Model effects box.

Create Crossed Effects (Interactions)

1 Select two or more variables in the Variables box. To select more than one variable, 
press Ctrl.

2 Click Cross. 

Create a Two-Way Factorial Model

1 Select two or more variables in the Variables box.

2 Click Two-way Factorial. 

For example, if you select the Height, Weight, and Age variables and then click Two-
way Factorial, these model effects are created: Age, Height, Weight, Age*Height, 
Age*Weight, and Height*Weight*Age.

Create a Full Factorial Model

1 Select two or more variables in the Variables box.

2 Click Full Factorial.
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For example, if you select the Height, Weight, and Age variables and then click Full 
Factorial, these model effects are created: Age, Height, Weight, Age*Height, 
Age*Weight, Height*Weight, and Age*Height*Weight.

Create N-Way Factorial

1 Select two or more variables in the Variables box.

2 Click N-way Factorial to add these effects to the Model effects box.

For example, if you select the Height, Weight, and Age variables and then specify the 
value of N as 3, when you click N-way Factorial, these model effects are created: Age, 
Height, Weight, Age*Height, Age*Weight, Height*Weight, and Age*Height*Weight.

Create Polynomial Effects

1 Select one variable in the Variables box. 

2 Specify higher-degree crossings by adjusting the number in the N field.

3 Click Polynomial, Degree=N to add the polynomial effects to the Model effects 
box.

Create Polynomial Effects of the N Order

1 Select one variable in the Variables box. 

2 Specify higher-degree crossings by adjusting the number in the N field.

3 Click Polynomial, Order=N to add the polynomial effects to the Model effects box.

For example, if you select the Age and Height variables and then you specify 3 in the N 
field, when you click Polynomial, Order=N, these model effects are created: Age, 
Age*Age, Age*Age*Age, Height, Height*Height, and Height*Height*Height.

Setting the Model Options

Option Description

Model
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Option Description

Include an intercept in the model specifies whether to include the intercept in 
the model.

Offset variable specifies a variable to be used as an offset to 
the linear predictor. An offset plays the role of 
an effect whose coefficient is known to be 1. 
Observations that have missing values for the 
offset variable are excluded from the analysis.

Model Selection

Selection method specifies the model selection method for the 
model. The task performs model selection by 
examining whether effects should be added 
to or removed from the model according to 
the rules that are defined by the selection 
method.
Here are the valid values for the selection 
methods:
n None fits the full model.
n Forward selection started with no effects 

in the model and adds effects based on the 
Significance level to add an effect to the 
model option.

n Backward elimination starts with all the 
effects in the model and deletes effects 
based on the value in the Significance 
level to remove an effect from the model 
option.

n Stepwise regression is similar to the 
forward selection model. However, effects 
that are already in the model do not 
necessarily stay there. Effects are added to 
the model based on the Significance level 
to add an effect to the model option and 
are removed from the model based on the 
Significance level to remove an effect 
from the model option.

Select best model by specifies what criterion to use to select the 
best model.
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Setting Options

Option Description

Tables

You can specify whether to include any output tables in the results.
Here are the additional tables that you can include:
n Confidence limits for estimates
n Correlations of parameter estimates
n Covariances of parameter estimates

Output Data Set

You can specify whether to create an output data set. By default, the data set is saved in the 
Work library. In the output, you can also include these statistics:
n linear predictors η = x ′β
n predicted values
n lower confidence limit for predicted values
n upper confidence limit for predicted values
n residuals
n Pearson residuals
n adjusted Pearson residuals
You can also select any columns from the input data set to include in the output data.

Optimization

Method specifies the optimization technique to use.

Maximum number of iterations specifies the maximum number of iterations 
to perform for the selected optimization 
technique.
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Replace Missing Values Task

About the Replace Missing Values Task

The Replace Missing Values task performs high-performance numeric variable 
imputation. Imputation is a common step in data preparation. This task can replace 
numeric missing values with a specified value. This task can also replace numeric 
missing values with the mean, the pseudo-median, or some random value between the 
minimum value and the maximum value of the nonmissing values.

Assigning Data to Roles

Role Description

Roles

Replace missing values in the variables 
with the mean

replaces missing values with the mean for the 
variable.

Replace missing values in the variables 
with the pseudo-median

replaces missing values with the pseudo-
median of the variable. If there is no 
nonmissing value, the pseudo-median is 0.

Replace missing values in the variables 
with a random number

replaces missing values with a random value 
that is drawn between the minimum and 
maximum of the variable. If there is no 
nonmissing value, the random value is 0.

Additional Roles

Frequency count specifies a numeric variable that contains the 
frequency of occurrence for each observation. 
If the frequency value is less than 1 or is 
missing, the observation is not used in the 
analysis. By default, each observation is 
assigned a frequency of 1.
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Setting Options

Option Name Description

Output Data Set

You can specify whether to create an output data set. This output data set includes the data, 
imputation indicator variables (0 for not imputed or 1 for imputed), and imputed variables. You 
can also include any variables from the input data set.
By default, this table is saved in the Work library.

Random Sampling Task

About the Random Sampling Task

The Random Sampling task is a high-performance procedure that performs either 
simple random sampling or stratified sampling. The output from this task includes an 
output data set and the sample data, a table with performance information, and a table 
with frequency information for the population and sample.
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Assigning Data to Roles

If you want to perform stratified sampling, you must assign a column to the Stratify by 
role. Otherwise, the Stratify by role is optional.

Role Description

Stratify by specifies the variables to use to partition the 
input table into mutually exclusive, 
nonoverlapping subsets that are known as 
strata. Each stratum is defined by a set of 
values of the strata variables, and each 
stratum is sampled separately. The complete 
sample is the union of the samples that are 
taken from all the strata.
Note: If you do not assign any variables to 
this role, then the entire input table is treated 
as a single stratum.
You can allocate the total sample size among 
the strata in proportion to the size of the 
stratum. For example, the variable GENDER 
has possible values of M and F, and the 
variable VOTED has possible values of Y and 
N. If you assign both GENDER and VOTED 
to the Stratify by role, then the input table is 
partitioned into four strata: males who voted, 
males who did not vote, females who voted, 
and females who did not vote.
The input table contains 20,000 rows, and the values 
are distributed as follows:

n 7,000 males who voted
n 4,000 males who did not vote 
n 5,000 females who voted 
n 4,000 females who did not vote 
Therefore, the proportion of males who voted 
is 7,000/20,000=0.35 or 35%. The 
proportions in the sample should reflect the 
proportions of the strata in the input table. For 
example, if your sample table contains 100 
observations, then 35% of the values in the 
sample must be selected from the males who 
voted stratum to reflect the proportions in the 
input table.
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Creating the Output Data Set

By default, the output data set is saved in the Work library. You can select the numeric 
and character variables from the input data set to include in the output data. Select the 
Include all input observations and a sampling indicator variable to produce an 
output table with the same number of rows as the input table. The output table has an 
additional partition indicator (_PARTIND_) to indicate whether an observation is 
included in the sample (1) or not (0).

Setting Options

Option Name Description

Methods

Sample by specifies the sample size in the desired 
number of rows or in the desired percentage 
of input rows. For example, if you specify 3% 
of rows and there are 400 input rows, then 
the resulting sample has 12 rows. By default, 
the number of desired rows is 1, and the 
desired percentage of input rows is 10.
Note: If you assign variables to the Stratify 
by role, then the sample size specification 
that you make here applies to each stratum 
rather than to the entire input table.

Random seed specifies the initial seed for the generation of 
random numbers. If you set this value to zero 
or a negative number, then a seed that is 
based on the system clock is used to produce 
the sample.
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Option Name Description

Ignore case of character stratification 
values

distinguishes stratified variables that share 
the same normalized value when you perform 
stratified sampling. For example, if a target 
has three distinct values, “A”, “B”, and “b”, 
and you want to treat “B” and “b” as different 
levels, you need to select this option. 
Otherwise, “B” and “b” are treated as the 
same level. The task normalizes a value as 
follows:

1 Leading blanks are removed.

2 The value is truncated to 32 characters.

3 Letters are changed from lowercase to 
uppercase.
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Summary Statistics Task

About the Summary Statistics Task

The Summary Statistics task provides data summarization tools to compute descriptive 
statistics for variables across all observations and within groups of observations. You 
can also summarize your data in a graphical display, such as a histogram.

For example, you could use this task to create a report on the number of new sales, 
arranged by product type and country.

Example: Summary Statistics of Unit Sales

In this example, you want to analyze unit sales. In addition to the tabular results, you 
choose to display a histogram of the distribution.

To create this example:

1 In the Tasks section, expand the Statistics folder and double-click Summary 
Statistics. The user interface for the Summary Statistics task opens.

2 On the Data tab, select the SASHELP.PRICEDATA data set.

3 To the Analysis variables role, assign the sale column. 

4 On the Options tab, expand the Plots section and select the Histogram check box.

5 To run the task, click .
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Here are the results:

Assigning Data to Roles

To run the Summary Statistics task, you must assign a column to the Analysis 
variables role.

Role Description

Roles
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Role Description

Analysis variables The variables that you assign to this role are 
the numeric variables for which you want 
statistics. You must assign at least one 
variable to this role.

Classification variables The variables that you assign to this role are 
character or discrete numeric variables that 
are used to divide the input data into 
categories or subgroups. The statistics are 
calculated on all selected analysis variables 
for each unique combination of classification 
variables.

Additional Roles

Group analysis by The variables that you assign to this role are 
used to compute separate statistics for each 
distinct value or combination of values of the 
Group analysis by variables. The data is 
automatically sorted by the variables in this 
role before the statistics are computed.

Frequency count When you assign a variable to this role, each 
observation in the table is assumed to 
represent n observations, where n is the 
value of the frequency count for that row. 
Statistics are calculated accordingly. You can 
assign a maximum of one variable to this role.

Weight variable If you assign a variable to this role, the value 
of the variable for each observation is used to 
calculate weighted means, variances, and 
sums. You can assign a maximum of one 
variable to this role.

Setting Options

Option Name Description
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Basic Statistics

Mean is the arithmetic average, calculated by 
adding the values of an analysis variable and 
dividing this sum by the number of 
nonmissing observations.

Standard deviation is a statistical measure of the variability of a 
group of data values. This measure, which is 
the most widely used measure of the 
dispersion of a frequency distribution, is equal 
to the positive square root of the variance.

Minimum value is the smallest value for an analysis variable.

Maximum value is the largest value for an analysis variable.

Median is the middle value for an analysis variable.

Number of observations is the total number of observations with 
nonmissing values.

Number of missing values is the number of observations with missing 
values.

Additional Statistics

Standard error is the standard deviation of the sample mean. 
The standard error is defined as the ratio of 
the sample standard deviation to the square 
root of the sample size.
Note: This option is available only if Degrees 
of freedom is selected in the Divisor for 
standard deviation and variance drop-down 
list.

Variance is a statistical measure of dispersion of data 
values. This measure is an average of the 
total squared dispersion between each 
observation and the sample mean.

Mode is the most frequent value for the analysis 
variable.
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Range is the difference between the largest and the 
smallest values in the data.

Sum is the sum of all values in the analysis 
variable.

Sum of weights is the sum of the numeric variable that is used 
to weight each observation.
Note: You cannot compute the sum of the 
weights unless you assign a variable to the 
Weight variable role.

Confidence limits for the mean are the two-sided confidence limits for the 
mean. A two-sided 100(1 − α) %  confidence 
interval for the mean has the following upper 
and lower limits:x̄ ± t(1− α2 ;n−1)

s
n  , where s is 

1
n − 1 Σ(xi − x̄)2 and t(1− α2 ;n−1)

 is the 1 − α
2  of 

the Student’s t statistics with n − 1 degrees of 
freedom.

Coefficient of variation is a unitless measure of relative variability. 
This measure is defined as the ratio of the 
standard deviation to the mean expressed as 
a percentage. The coefficient of variation is 
meaningful only if the variable is measured on 
a ratio scale.

Skewness is skewness, which measures the tendency of 
the deviations to be larger in one direction 
than in the other.

Kurtosis is the kurtosis, which measures the heaviness 
of tails.

Percentile Statistics

1st, 5th, 10th, Lower quartile, Median, 
Upper quartile, 90th, 95th, 99th, 
Interquartile range

choose the percentiles and quantiles to 
compute.

Summary Statistics Task 189



Quantile method specifies the method that is used to compute the 
quantiles, median, and percentiles.

Order statistics
reads all of the data into memory and sorts 
it by the unique values.

Piecewise-parabolic algorithm
approximates the quantile and is a less 
memory-intensive method.

Plots

Histogram creates a graph that is used to determine the 
distribution of the data. If you add a normal 
density curve, the task uses the sample mean 
and sample standard deviation for μ and σ. If 
you add a kernel density curve, the task uses 
the AMISE method to compute the kernel 
density estimates.
To include the statistics in the graph, select 
the Add inset statistics check box.

Comparative box plot (when classification 
variable is specified)

creates a graph that shows a measure of 
central location (the median), two measures 
of dispersion (the range and interquartile 
range), the skewness (from the orientation of 
the median relative to the quartiles), and 
potential outliers. Box plots are especially 
useful in comparing two or more sets of data.
You can choose to add the overall inset 
statistics to the graph or only the inset 
statistics for each group.

Plot combines histogram and box plot 
(when no classification variable is 
specified)

displays the histogram and box plots together 
in a single panel, sharing common X axes.

Methods
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Divisor for standard deviation and 
variance

specifies the divisor to use in the calculation of the 
variance and standard deviation. Here are the valid 
options:

Degrees of freedom
n − 1
By default, the divisor for the variance is 
the degrees of freedom.

Number of observations
n

Sum of weights minus one
(Σiwi) − 1

Sum of weights
Σiwi

Output Data Set

You can specify whether to save the statistics in an output data set. By default, this data set is 
saved in the Work library.

Distribution Analysis Task

About the Distribution Analysis Task

Distribution analysis provides information about the distribution of numeric variables. A 
variety of plots such as histograms, probability plots, and quantile-quantile plots can be 
used in this analysis.

Example: Distribution Analysis of Sales for 
Each Region

In this example, you want to analyze the sales for each region. Because the data 
contains three regions, you get three sets of results.
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To create this example:

1 In the Tasks section, expand the Statistics folder and double-click Distribution 
Analysis. The user interface for the Distribution Analysis task opens.

2 On the Data tab, select the SASHELP.PRICEDATA data set.

3 Assign columns to these roles:

Role Column Name

Analysis variables sale

Classification variables regionName

4 Click the Options tab. In the Checking for Normality group, select the Goodness-
of-fit tests, Histogram with normal curve, and Normal quantile-quantile plot 
options. For the quantile-quantile plot, also select the Add a reference line check 
box.

5 To run the task, click .

192 Chapter 10 / Statistics Tasks



Here is a subset of the results:
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Assigning Data to Roles

To run the Distribution Analysis task, you must assign a column to the Analysis 
variables and select a plot or test on the Options tab.

Role Description

Roles

Analysis variables specifies the analysis variables and their 
order in the results.

Classification variables specifies the variables that are used to group 
the analysis variables into classification 
levels. You can assign only two columns to 
this role.

Additional Roles
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Role Description

Frequency count specifies a numeric variable whose value 
represents the frequency of the observation. 
The Distribution Analysis task assumes that 
each observation represents n observations, 
where n is the value of the variable.

Group analysis by specifies the variables that the Distribution 
Analysis task uses to form groups.

Setting Options

Option Name Description

Exploring Data

Select the Histogram check box to create a histogram of the data. You can also specify 
whether to superimpose a kernel density estimate and the normal density curve on the 
histogram. Finally, you can specify whether to include an inset box of selected statistics in the 
graph.

Checking for Normality

Goodness-of-fit tests requests tests for normality that include a 
series of goodness-of-fit tests based on the 
empirical distribution function. The table 
provides test statistics and p-values for the 
Shapiro-Wilk test (provided the sample size is 
less than or equal to 2,000), the Kolmogorov-
Smirnov test, the Anderson-Darling test, and 
the Cramér-von Mises test.

Histogram with normal curve displays fitted normal density curve on the 
histogram. The normal distribution has a 
mean of μ and a standard deviation of σ.
You can also specify whether to include an 
inset box of selected statistics in the graph.

Distribution Analysis Task 195



Option Name Description

Normal probability plot creates a probability plot, which compares 
ordered variable values with the percentiles of 
the normal distribution. If the data distribution 
matches the normal distribution, the points on 
the plot form a linear pattern. Probability plots 
are preferable for graphical estimation of 
percentiles.
The distribution reference line on the plot is 
created from the maximum likelihood 
estimate for the parameter.
You can also specify whether to include an 
inset box of selected statistics in the graph.

Normal quantile-quantile plot creates quantile-quantile plots (Q-Q plots) 
and compares ordered variable values with 
quantiles of the normal distribution. If the data 
distribution matches the normal distribution, 
the points on the plot form a linear pattern. Q-
Q plots are preferable for graphical estimation 
of distribution parameters.
The distribution reference line on the plot is 
created from the maximum likelihood 
estimate for the parameter.
You can also specify whether to include an 
inset box of selected statistics in the graph.

Fitting Distributions

Beta

Histogram fits beta distribution with threshold parameter 
θ, scale parameter σ, and shape parameters 
α and β.

Probability plot specifies a beta probability plot for shape 
parameters α and β.

Quantile-quantile plot specifies a beta Q-Q plot for shape 
parameters α and β.

Exponential
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Option Name Description

Histogram fits exponential distribution with threshold 
parameter θ and scale parameter σ.

Probability plot specifies an exponential probability plot.

Quantile-quantile plot specifies an exponential Q-Q plot.

Gamma

Histogram fits gamma distribution with threshold 
parameter θ, scale parameter σ, and shape 
parameter α.

Probability plot specifies a gamma probability plot for shape 
parameter α.

Quantile-quantile plot specifies a gamma Q-Q plot for shape 
parameter α.

Lognormal

Histogram fits lognormal distribution with threshold 
parameter θ, scale parameter ζ, and shape 
parameter σ.

Probability plot specifies a lognormal probability plot for 
shape parameter σ.

Quantile-quantile plot specifies a lognormal Q-Q plot for shape 
parameter σ.

Weibull

Histogram fits Weibull distribution with threshold 
parameter θ, scale parameter ζ, and shape 
parameter c.

Probability plot specifies a two-parameter Weibull probability 
plot.
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Option Name Description

Quantile-quantile plot specifies a two-parameter Weibull Q-Q plot.

One-Way Frequencies Task

About the One-Way Frequencies Task

The One-Way Frequencies task generates frequency tables from your data. You can 
also use this task to perform binomial and chi-square tests.

You might want to use this task to analyze the efficiency of a new drug. For example, 
suppose a group of medical researchers are interested in evaluating the efficacy of a 
new treatment for a skin condition. Dermatologists from participating clinics are trained 
to conduct the study and to evaluate the condition. After the training, two dermatologists 
examine patients with the skin condition from a pilot study and rate the same patients. 
The One-Way Frequencies task can be used to evaluate the agreement of the 
diagnoses.

Example: One-Way Frequencies of Unit Sales

In this example, you want to analyze unit sales for each sales region.

To create this example:

1 In the Tasks section, expand the Statistics folder and double-click One-Way 
Frequencies. The user interface for the One-Way Frequencies task opens.

2 On the Data tab, select the SASHELP.PRICEDATA data set.

3 Assign columns to these roles:
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Role Column Name

Analysis variables sale

Group analysis by regionName

4 To run the task, click .

Here is a subset of the results:
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Assigning Data to Roles

To run the One-Way Frequencies task, you must assign a column to the Analysis 
variables role.

Role Description

Roles

Analysis variables specifies the variables to be analyzed. For 
each variable that you assign to this role, the 
task creates a one-way frequency table. You 
must assign at least one variable to this role.

Additional Roles

Frequency count specifies the variable to use as the frequency 
count. When you assign a variable to this 
role, each observation in the table is assumed 
to represent n observations. In this example, 
n is the value of the frequency count for that 
row. You can assign only one variable to this 
role.

Group analysis by specifies one or more variables to sort the 
table by. Analyses are performed on each 
group.

Setting Options

Option Name Description

Plots

By default, plots are included in the results. Select the Show frequencies table check box to 
create the frequency and cumulative frequency plots. Select the Asymptotic test check box 
for the chi-square goodness-of-fit to create the deviation plot.
To suppress the plots from the results, select the Suppress plots check box.
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Option Name Description

Frequency Table

Show frequency table specifies whether to create the frequency 
table.

Include percentages creates a table that contains the frequencies 
and percentages of total frequencies for each 
value of the analysis variable.

Include cumulative frequencies and 
percentages

creates a table that contains the frequencies 
and cumulative frequencies for each value of 
the analysis variable.

Statistics

Binomial proportions

Select the tests to perform. For binomial proportions, specify a test proportion (null hypothesis 
proportion value) and confidence level.

Chi-square goodness-of-fit

Select the tests to perform.
To compute the Monte Carlo estimates of the exact p-values instead of directly computing the 
exact p-values, select the Use Monte Carlo estimation check box. Monte Carlo estimation 
can be useful for large problems that require a great amount of time and memory for exact 
computations but for which asymptotic approximations might be insufficient.

Exact Computations Methods

Limit computation time specifies the time limit (in seconds) for the 
computation of each p-value for each 
crosstabulation table. The default is 300 
seconds (or 5 minutes).

Missing Values

Show frequencies includes missing values in the frequency 
tables.
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Option Name Description

Include in calculations includes the frequencies of missing values in 
binomial or chi-square tests and in the 
calculations of percentages.

Correlations Task

About the Correlations Task

Correlation is a statistical procedure for describing the relationship between numeric 
variables. The relationship is described by calculating correlation coefficients for the 
variables. By default, the Correlations task calculates a Pearson product-moment 
correlation. This is a parametric measure of association for two continuous random 
variables. The correlations range from –1 to 1.

Example: Correlations in the Sashelp.Cars 
Data Set

To create this example:

1 In the Tasks section, expand the Statistics folder and double-click Correlation. The 
user interface for the Correlations task opens.

2 On the Data tab, select the SASHELP.CARS data set.

3 Assign columns to these roles:

Role Column

Analysis variables EngineSize
Horsepower
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Role Column

Correlate with Cylinders
MPG_Highway

4 To run the task, click .

Here are the results:
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Assigning Data to Roles

To run the Correlations task, you must assign at least two columns to the Analysis 
variables role, or you must assign at least one column to the Analysis variables role 
and one column to the Correlate with role.

Roles Description

Roles

Analysis variables lists the variables for which to compute 
correlation coefficients.

Correlate with lists the variables with which the correlations 
of the analysis variables are to be computed.

Partial variables removes the correlation of these variables 
from the analysis and correlates with 
variables before calculating the correlation.

Additional Roles

Frequency count lists a numeric variable whose value 
represents the frequency of the observation. 
If you assign a variable to this role, the task 
assumes that each observation represents n 
observations, where n is the value of the 
frequency variable. If n is not an integer, SAS 
truncates it. If n is less than 1 or is missing, 
the observation is excluded from the analysis. 
The sum of the frequency variable represents 
the total number of observations.

Weight lists the weights to use in the calculation of 
Pearson weighted product-moment 
correlation.

Group analysis by enables you to obtain separate analyses of 
observations in groups that are defined by the 
BY variables.
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Setting Options

Option Name Description

Methods

Missing values specifies how to treat observations with 
missing values. If you select the Use 
nonmissing values for all selected 
variables option, all observations with 
missing values are excluded from the 
analysis. If you select the Use nonmissing 
values for pairs of variables option, the 
correlation statistics are computed using the 
nonmissing pairs of variables.

Tables
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Option Name Description

By default, the results contain a table with the correlations and p-values. You can also include 
these statistics:
Correlations

Selecting this option includes the correlations in the results. You can also specify 
probabilities that are associated with each correlation coefficient and whether to order the 
correlations from highest to lowest in absolute value.

Covariances
Selecting this option includes the variance and covariance matrix in the results. Also, the 
Pearson correlations are displayed. If you assign a column to the Partial variables role, 
the task computes a partial covariance matrix.

Sum of squares and cross-products
Selecting this option displays a table of the sums of squares and cross products in the 
results. The Pearson correlations are also included in the results. If you assign a column to 
the Partial variables role, the unpartial sums of squares and cross-products matrix is 
displayed.

Corrected sum of squares and cross-products
Selecting this option displays a table of the corrected sums of squares and cross products. 
The Pearson correlations are also inclued in the results. If you assign a column to the 
Partial variables role, the task computes both an unpartial and a partial corrected sum of 
squares and cross-products matrix.

Descriptive statistics
Selecting this option includes the simple descriptive statistics for each variable. Even if you 
do not select this option and you choose to create an output data set, the data set contains 
the descriptive statistics for the variables.

Fisher’s z transformation
For a Pearson correlation, you can use the Fisher transformation options to request 
confidence limits and p-values under a specified alternative (null) hypothesis, H0 : ρ = ρ0, 
for correlation coefficients that use Fisher’s z transformation. If you select the Fisher’s z 
transformation check box, you must specify a value in the Alternative hypothesis box.
You can choose from these types of confidence limits:

n Two-sided confidence limits requests two-sided confidence limits for the test of the 
null hypothesis, H0 : ρ = ρ0. This is the default.

n Lower confidence limit requests a lower confidence limit for the test of the one-sided 
null hypothesis, H0 : ρ ≤ ρ0.

n Upper confidence limit requests an upper confidence limit for the test of the one-
sided null hypothesis, H0 : ρ ≥ ρ0.

By default, the level of the confidence limits for the correlation is 95%.
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Option Name Description

Nonparametric Correlations

Spearman’s rank-order correlation calculates Spearman rank-order correlation. 
This is a nonparametric measure of 
association that is based on the rank of the 
data values. The correlations range from –1 
to 1.

Kendall’s tau-b calculates Kendall tau-b. This is a 
nonparametric measure of association that is 
based on the number of concordances and 
discordances in paired observations. 
Concordance occurs when paired 
observations vary together, and discordance 
occurs when paired observations vary 
differently. Kendall's tau-b ranges from –1 to 
1.

Hoeffding’s measure of dependence calculates Hoeffding's measure of 
dependence, D. This is a nonparametric 
measure of association that detects more 
general departures from independence. This 
D statistic is 30 times larger than the usual 
definition and scales the range between –0.5 
and 1 so that only large positive values 
indicate dependence.

Plots

You can include either of these plots in your results:
n a scatter plot matrix for variables. You can also choose to include a histogram of the 

analysis variables in the symmetric matrix plot.
n a scatter plot for each applicable pair of distinct variables from the analysis variables. You 

can specify whether to display the prediction ellipses for new observations or the 
confidence ellipses for the mean.

You can also specify the number of variables to plot and the maximum number of points to 
plot.

Output Data Set
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Option Name Description

You can specify whether to create an output data set that contains the Pearson correlation 
statistics. This data set also includes means, standard deviations, and the number of 
observations. By default, this data set is saved in the Work library.
You can also choose to include these statistics in the output data set:
n Correlations – By default, the output data set contains the correlation coefficients with the 

corresponding _TYPE_ variable value of ‘CORR’.
n Covariances – When you select this option, the output data set contains the covariance 

matrix with the corresponding _TYPE_ variable value of ‘COV’.
n Sum of squares and cross-products – If you assign a column to the Partial variables 

role, the output data set does not contain a sum of squares and cross-products matrix.
n Corrected sum of squares and cross-products — If you assign a column to the Partial 

variables role, the output data set contains a partial corrected sum of squares and cross-
products matrix.

Table Analysis Task

About the Table Analysis Task

The Table Analysis task enables you to generate crosstabulation tables, also known as 
contingency tables, from your data.

Example:

To create this example:

1 In the Tasks section, expand the Statistics folder and double-click Table Analysis. 
The user interface for the Table Analysis task opens.

2 On the Data tab, select the SASHELP.CARS data set.

3 Assign columns to these roles:
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Role Column

Row variable Type

Column variable DriveTrain

4 To run the task, click .

Here is a sample of the results:
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Assigning Data to Roles

To run the Table Analysis task, you must first assign at least one column to the Role 
variables or Column variables roles. After you have assigned a row variable or a 
column variable, you can assign a column to the Strata variable role.

Roles Description

Roles

Row variables creates the rows for two-way to n-way 
frequency and crosstabulation tables.

Column variables creates the columns for two-way to n-way 
frequency and crosstabulation tables.
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Roles Description

Strata variables creates the separate tables for n-way 
frequency and crosstabulation tables.

Additional Roles

Frequency count specifies that each row in the table is 
assumed to represent n observations. In this 
example, n is the value of the frequency 
count for that observation.

Setting Options

Option Name Description

Plots

By default, plots are included in the results. To suppress these plots, select the Suppress 
plots check box.

Frequency Table

Frequencies

Observed displays the frequency count for each cell.

Expected displays the expected cell frequency for each 
cell.

Deviation displays the deviation of the cell frequency 
from the expected value for each cell.

Percentages

Cell display of overall percentages in 
crosstabulation tables.

Row display of row percentages in crosstabulation 
table cells.
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Option Name Description

Column display of column percentages in 
crosstabulation table cells.

Cumulative

Column percentages displays the cumulative column percentage in 
each cell.

Frequencies and percentages displays the cumulative frequencies and 
percentages in one-way frequency tables.

Cell contributions to the chi-square 
statistics

displays each table cell’s contribution to the 
Pearson chi-square statistic in the 
crosstabulation table.

Statistics

Chi-square statistics requests chi-square tests of homogeneity or 
independence and measures of association 
that are based on the chi-square statistic. The 
tests include the Pearson chi-square, 
likelihood-ratio chi-square, and Mantel-
Haenszel chi-square. For 2×2 tables, this test 
includes Fisher's exact test and the 
continuity-adjusted chi-square.

Measures of association computes several measures of association 
and their asymptotic standard errors (ASE). 
The measures include gamma, Kendall's tau-
b, Stuart's tau-c, Somers' D (C|R), Somers' D 
(R|C), the Pearson and Spearman correlation 
coefficients, lambda (symmetric and 
asymmetric), and uncertainty coefficients 
(symmetric and asymmetric).

Cochran-Mantel-Haenszel statistics requests Cochran-Mantel-Haenszel statistics, 
which test for association between the row 
and column variables after adjusting for the 
remaining variables in a multiway table. 
These statistics include the CMH correlation 
statistic, the row mean scores (ANOVA), and 
the adjusted relative risks and odds ratios.
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Option Name Description

Measures of agreement (for square tables) computes tests and measures of 
classification agreement for square tables. 
This option provides McNemar's test for 2×2 
tables and Bowker's test of symmetry for 
tables with more than two response 
categories. It also produces the simple kappa 
coefficient, the weighted kappa coefficient, 
the asymptotic standard errors for the simple 
and weighted kappas, and the corresponding 
confidence limits. When there are multiple 
strata and two response categories, this 
option also computes Cochran's Q test.

Odds ratio and relative risk (for 2x2 tables) requests relative risk measures and their 
asymptotic Walk confidence limits for 2x2 
tables.

Binomial proportions and risk differences 
(for 2x2 tables)

requests risks (binomial proportions) and risk 
differences for 2x2 tables.

Methods

Missing value treatment specifies how to treat missing values:

Exclude missing values
specifies that an observation is excluded 
from a table if the observation has a 
missing value for any of the variables.

Display missing value frequencies
displays the frequencies of the missing 
values in the frequency and 
crosstabulation tables. These frequencies 
are not included in any computations of 
percentages, tests, or measures.

Include missing values in calculations
treats the missing values as valid for all 
variables.

Exact Test

Fisher’s exact test requests Fisher’s exact test for tables that are 
larger than 2x2.
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One-Sample t Test Task

About the One-Sample t Test Task

A one-sample t test compares the mean of the sample to the null hypothesis mean.

To compare an individual mean with a sample size of n to a value m, use t = x̄ − m
s
n

where x̄ is the sample mean of the observations and s2 is the sample variance of the 
observations.

For example, you want to perform a one-sample t test on the horsepower values in the 
Sashelp.Cars data set. The null hypothesis is 300.

Example: One-Sample t Test for Horsepower

To create this example:

1 In the Tasks section, expand the Introductory Statistics folder and double-click 
One-sample t Test. The user interface for the One-Sample t Test task opens.

2 On the Data tab, select the SASHELP.CARS data set.

3 To the Analysis variable role, assign the Horsepower column.

4 On the Options tab, enter 300 in the Alternative hypothesis field.

5 To run the task, click .
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Here is a subset of the results:
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Assigning Data to Roles

To run the One-Sample t Test task, you must assign a numeric column to the Analysis 
variable role.

Setting Options

Option Name Description

Test
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Option Name Description

Tails specifies the number of sides (or tails) and 
direction of the statistical tests and test-based 
confidence intervals. You can choose from 
these options:
n Two-tailed test specifies two-sided tests 

and confidence intervals for means.
n Upper one-tailed test specifies upper one-

sided tests in which the alternative 
hypothesis indicates a mean greater than 
the null value, and upper one-sided 
confidence intervals between the lower 
confidence limit and infinity.

n Lower one-tailed test specifies lower one-
sided tests in which the alternative 
hypothesis indicates a mean less than the 
null value, and lower one-sided confidence 
intervals between minus infinity and the 
upper confidence limit.

Alternative hypothesis specifies the value of the null hypothesis. By 
default, the null hypothesis has a value of 0.

Normality Assumption

Tests for normality runs tests for normality that include a series 
of goodness-of-fit tests based on the 
empirical distribution function. The table 
provides test statistics and p-values for the 
Shapiro-Wilk test (provided the sample size is 
less than or equal to 2000), the Kolmogorov-
Smirnov test, the Anderson-Darling test, and 
the Cramér-von Mises test.

Nonparametric Tests
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Option Name Description

Sign test and Wilcoxon signed rank test generates the results from these tests:
n The sign test statistic is M = (n + − n −) / 2 , 

where n+ is the number of values that are 
greater than μ0, and n- is the number of 
values that are less than μ0. Values equal 
to μ0 are discarded.

n The Wilcoxon signed rank statistic S is 

calculated as S = ∑
i:|xi−μ0|>0

ri+ −
nt(nt + 1)

4  , 

where r+
i is the rank of xi − μ0 after 

discarding values of xi − μ0 , and nt is the 
number of xi values not equal to μ0. 
Average ranks are used for tied values.

Plots

Histogram and box plot creates a histogram and box plot together in a 
single panel, sharing common X axes.

Normality plot creates a normal quantile-quantile (Q-Q) plot.

Confidence interval plot creates a plot of the confidence interval for 
the means.

Paired-sample t Test Task

About the Paired-sample t Test Task

A paired-sample t test compares the mean of the differences in the observations to a 
given number, the null hypothesis difference. The paired-sample t test is used when the 
two samples are correlated, such as two measures of blood pressure from the same 
person.

218 Chapter 10 / Statistics Tasks



To compare n paired differences to a value m, use t = d̄ − m
sd
n

, where d̄  is the sample 

mean of the paired differences and s2
d is the sample variance of the paired differences.

Example: Determining the Distribution of 
Price - Cost

In this example, you want to compare the means of differences in price and cost in the 
Sashelp.Pricedata data set. The null hypothesis for this test is 30.

To create this example:

1 In the Tasks section, expand the Introductory Statistics folder and double-click 
Paired-sample t Test. The user interface for the Paired-sample t Test task opens.

2 On the Data tab, select the SASHELP.PRICEDATA data set.

3 Assign columns to these roles:

Role Column Name

Group 1 variable price

Group 2 variable cost

4 On the Options tab, enter 30 in the Alternative field.

5 To run the task, click .

Paired-sample t Test Task 219



Here is a subset of the results:
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Assigning Data to Roles

To run the Paired-sample t Test, you must assign columns to the Group 1 variable and 
Group 2 variable roles. The task compares these two variables. Because paired t tests 
are performed by subtracting each value of the Group 2 variable from the 
corresponding value of the Group 1 variable, the designation of the variables matters.

Setting Options

Option Name Description

Test
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Option Name Description

Tails specifies the number of sides (or tails) and 
direction of the statistical tests and test-based 
confidence intervals. You can choose from 
these options:
n Two-tailed test specifies two-sided tests 

and confidence intervals for means.
n Upper one-tailed test specifies upper one-

sided tests in which the alternative 
hypothesis indicates a mean greater than 
the null value. The upper one-sided 
confidence intervals range between the 
lower confidence limit and infinity.

n Lower one-tailed test specifies lower one-
sided tests in which the alternative 
hypothesis indicates a mean less than the 
null value. The lower one-sided confidence 
intervals range between minus infinity and 
the upper confidence limit.

Alternative specifies the value of the null hypothesis.

Normality Assumption

Tests for normality runs tests for normality that include a series 
of goodness-of-fit tests based on the 
empirical distribution function. The table 
provides test statistics and p-values for the 
Shapiro-Wilk test (provided the sample size is 
less than or equal to 2000), the Kolmogorov-
Smirnov test, the Anderson-Darling test, and 
the Cramér-von Mises test.

Nonparametric Tests
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Option Name Description

Sign test and Wilcoxon signed rank test generates the results from these tests:
n The sign test statistic is M = (n + − n −) / 2 , 

where n+ is the number of values that are 
greater than μ0, and n- is the number of 
values that are less than μ0. Values equal 
to μ0 are discarded.

n The Wilcoxon signed rank statistic S is 

calculated as S = ∑
i:|xi−μ0|>0

ri+ −
nt(nt + 1)

4  , 

where r+
i is the rank of xi − μ0 after 

discarding values of xi − μ0 and nt is the 
number of xi values not equal to μ0. 
Average ranks are used for tied values.

Plots

Histogram and box plot creates a histogram and box plot together in a 
single panel, sharing common X axes.

Normality plot creates a normal quantile-quantile (Q-Q) plot.

Agreement plot plots the second response in each pair 
against the first response, with the mean 
shown as a large bold symbol. A diagonal line 
with slope=0 and y-intercept=1 is overlaid. 
The location of the points with respect to the 
diagonal line reveals the strength and 
direction of the difference or ratio. The tighter 
the clustering along the same direction as the 
line, the stronger the positive correlation of 
the two measurements for each subject. 
Clustering along a direction perpendicular to 
the line indicates negative correlation.
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Option Name Description

Response profile plot creates a plot where a line is drawn for each 
observation from left to right that connects the 
first response to the second response. The 
mean first response and mean second 
response are connected with a bold line. The 
more extreme the slope, the stronger the 
effect. A wide spread of profiles indicates high 
between-subject variability. Consistent 
positive slopes indicate strong positive 
correlation. Widely varying slopes indicate 
lack of correlation. Consistent negative slopes 
indicate strong negative correlation.

Confidence interval plot creates a plot of the confidence interval for 
the means.

Two-Sample t Test Task

About the Two-Sample t Test Task

A two-sample t test compares the mean of the first sample minus the mean of the 
second sample to a given number, the null hypothesis difference.

To compare means from two independent samples with n1 and n2 observations to a 

value m, use t =
(x1̄ − x̄2) − m

s
1
n1

+
1
n2

. In this example, s2 is the pooled variance 

s 2 =
(n1 − 1)s12 + (n1 − 1)s22

n1 + n2 − 2 , and s2
1 and s2

2 are the sample variances of the two groups. 

The use of this t statistic depends on the assumption that σ12 = σ22, where σ12 and σ22 are 
the population variances of the two groups.
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Example: Two-Sample t Test

In this example, you want to analyze the height values for males and females in your 
class.

To create this example:

1 In the Tasks section, expand the Introductory Statistics folder and double-click 
Two-sample t Test. The user interface for the Two-Sample t Test task opens.

2 On the Data tab, select the SASHELP.CLASS data set.

3 Assign columns to these roles:

Role Column Name

Analysis variable Height

Groups variable Sex

4 To run the task, click .
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Here is a subset of the results:
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Assigning Data to Roles

To run the Two-Sample t Test task, you must assign a column to these roles:

Role Description

Analysis variable specifies the column to use in the analysis.

Groups variable specifies the column to use for grouping. This 
column must have only two levels.
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Setting Options

Option Name Description

Test

Tails specifies the number of sides (or tails) and 
direction of the statistical tests and test-based 
confidence intervals. You can choose from 
these options:
n Two-tailed test specifies two-sided tests 

and confidence intervals for means.
n Upper one-tailed test specifies upper one-

sided tests in which the alternative 
hypothesis indicates a mean greater than 
the null value, and upper one-sided 
confidence intervals between the lower 
confidence limit and infinity.

n Lower one-tailed test specifies lower one-
sided tests in which the alternative 
hypothesis indicates a mean less than the 
null value, and lower one-sided confidence 
intervals between minus infinity and the 
upper confidence limit.

Alternative hypothesis specifies the value of the null hypothesis.
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Option Name Description

Cox and Cochran probability 
approximation for unequal variances

calculates the Cochran and Cox 
approximation. This approximation of the p-
value of the tu is the value of p such that 

tu =

( s1
2

∑
i=1

n1
*

f 1iw1i
)t1 + ( s2

2

∑
i=1

n2
*

f 2iw2i
)t2

( s1
2

∑
i=1

n1
*

f 1iw1i
) + ( s2

2

∑
i=1

n2
*

f 2iw2i
) . In this 

example, t1 and t2 are the critical values of the 
t distribution corresponding to a significance 
level of p and sample sizes n1 and n2, 
respectively. The degrees of freedom is 
undefined when n1 ≠ n2.1

Normality Assumption

Tests for normality runs tests for normality that include a series 
of goodness-of-fit tests based on the 
empirical distribution function. The table 
provides test statistics and p-values for the 
Shapiro-Wilk test (provided the sample size is 
less than or equal to 2000), the Kolmogorov-
Smirnov test, the Anderson-Darling test, and 
the Cramér-von Mises test.

Nonparametric Tests

Wilcoxon rank-sum test generates an analysis of Wilcoxon scores. 
When there are two classification levels 
(samples), this option produces the Wilcoxon 
rank-sum test.

Plots

Histogram and box plot creates a histogram and box plot together in a 
single panel, sharing common X axes.

1Cochran, W. G., and G. M. Cox. 1950. Experimental Designs. New York, : Wiley.
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Option Name Description

Normality plot creates a normal quantile-quantile (Q-Q) plot.

Confidence intervals plot creates plots of the confidence interval for 
means. This plot is not created by default.

One-Way ANOVA Task

About the One-Way ANOVA Task

A one-way analysis of variance (ANOVA) considers one treatment factor with two or 
more treatment levels. The goal of the analysis is to test for differences among the 
means of the levels and to quantify these differences. If there are two treatment levels, 
then this analysis is equivalent to a t-test that compares two group means.

You might use the One-Way ANOVA task to do the following:

n study the effect of bacteria on the nitrogen content of red clover plants. The factor is 
the bacteria strain, and it has six levels.

n compare the life spans of three different brands of batteries. The factor is the brand, 
and it has three levels. 

Example: Testing for Differences in the 
Means for MPG_Highway by Car Type

In this example, you want to study the differences in the means for the number of 
highway miles per gallon for six car types.

To create this example:

1 In the Tasks section, expand the Statistics folder and double-click One-Way 
ANOVA. The user interface for the One-Way ANOVA task opens.
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2 On the Data tab, select the SASHELP.CARS data set.

3 Assign columns to these roles:

Role Column Name

Dependent variable MPG_Highway

Explanatory variable Type

4 To run the task, click .
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Here is a subset of the results:
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Assigning Data to Roles

To run the One-Way ANOVA task, you must assign columns to these roles:

Role Name Description

Dependent variable specifies a continuous numeric column.

Explanatory variable specifies a character or numeric column with 
values that specify the levels of the groups. 
The column that you assign to this role must 
have two or more distinct values.

One-Way ANOVA Task 233



Setting Options

Option Name Description

Normality Assumption

Tests for normality runs tests for normality that include a series 
of goodness-of-fit tests based on the 
empirical distribution function. The table 
provides test statistics and p-values for the 
Shapiro-Wilk test (provided the sample size is 
less than or equal to 2,000), the Kolmogorov-
Smirnov test, the Anderson-Darling test, and 
the Cramér-von Mises test.

Homogeneity of Variance
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Option Name Description

Test specifies the type of test to perform. Here are 
the valid values:
None

specifies that no test is performed.
Bartlett

computes accurate Type I error rates when 
the distribution of the data is normal.

Brown & Forsythe
is a variation of Levene's test. Equal 
variances are determined by using the 
absolute deviations from the group 
medians. Although this is a good test for 
determining variance differences, it can be 
resource intensive if your data contains 
several large groups.

Levene
computes the squared residuals to 
determine equal variance. Levene’s test is 
considered to be the standard 
homogeneity of variance test. This is the 
default.

O’Brien
specifies O’Brien’s test, which is a 
modification of Levene’s test that uses 
squared residuals.

Welch’s variance-weighted ANOVA tests the group means using a weighted 
variance. You can use this test if the 
assumption of equal variances is rejected.

Comparisons
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Option Name Description

You can select from these comparison methods:
Bonferroni

performs Bonferroni t tests of differences between means for all means of the main effect.
Duncan multiple range

performs Duncan’s multiple range test on all means of the main effect.
Gabriel

performs Gabriel’s multiple-comparison procedure on all means of the main effect.
Ryan-Einot-Gabriel-Welsch

performs the Ryan-Einot-Gabriel-Welsch multiple range test on all means of the main 
effect.

Scheffé
performs Scheffé’s multiple-comparison procedure on all means of the main effect.

Sidak
performs pairwise t tests on differences between means with levels adjusted according to 
Sidak’s inequality for all means of the main effect.

Student-Newman-Keuls
performs the Student-Newman-Keuls multiple range test on all main effect means.

Least significant difference (LSD)
performs pairwise t tests for all means of the main effect. In the case of equal cell sizes, 
this test is equivalent to Fisher’s least significant difference test.

Tukey studentized range (HSD)
performs Tukey’s studentized range test (HSD) on all means of the main effect. When the 
group sizes are different, this is the Tukey-Kramer test.

You can also specify the level of significance for the selected test.

Plots
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Option Name Description

By default, the results include a box plot. You can also specify to include these diagnostic 
plots:
n scatter plots of residuals, studentized residuals, and observed responses by predicted 

values
n studentized residuals by leverage
n Cook’s D by observations
n a Q-Q plot of residuals
n a residual histogram
n a residual-fit spread plot
For these diagnostic plots, you can specify whether to display them in a panel or as individual 
plots. You can also specify the maximum number of points to include in these plots.

Nonparametric One-Way ANOVA Task

About the Nonparametric One-Way ANOVA 
Task

The Nonparametric One-Way ANOVA task consists of nonparametric tests for location 
and scale differences across a one-way classification. The task also provides a 
standard analysis of variance on the raw data and statistics based on the empirical 
distribution function.

Example: Wilcoxon Scores for MPG_Highway 
Classified by Origin

To create this example:

1 In the Tasks section, expand the Statistics folder and double-click Nonparametric 
One-Way ANOVA. The user interface for the Nonparametric One-Way ANOVA task 
opens.
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2 On the Data tab, select the SASHELP.CARS data set.

3 Assign columns to these roles:

Role Column Name

Dependent variable MPG_Highway

Classification variable Origin

4 To run the task, click .
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Assigning Data to Roles

To run the Nonparametric One-Way ANOVA task, you must assign columns to the 
Dependent variable and Classification variable roles.

Role Name Description

Roles

Dependent variable specifies the column to use as the dependent 
variable.

Classification variable defines the subgroups. Separate analyses 
are performed for each subgroup. You can 
specify whether to treat missing values as a 
valid level.

Additional Roles

Frequency count specifies that each row in the table is 
assumed to represent n observations. In this 
example, n is the value of the frequency 
count for that observation.

Group analysis by sorts the table by these columns. The task 
performs analyses on each group.

Setting Options

Option Name Description

Plots
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Option Name Description

By default, plots are included in the results. These plots are determined by the options that 
you select. Here are some of the plots that you can create:
n By selecting the options in the Location Differences section, you can create a box plot of 

Wilcoxon scores, a stacked bar chart showing frequencies above or below the overall 
median, a box plot of Van der Waerden scores, and a box plot of Savage scores.

n By selecting the options in the Scale Differences section, you can create a box plot of 
Ansari-Bradley scores, a box plot of Klotz scores, a box plot of Mood scores, and a box plot 
of Siegel-Tukey scores.

n By selecting the options in the Location and Scale Differences section, you can create a 
box plot of Conover scores.

n By selecting the Empirical distribution function tests, including Kolmogorov-Smirnov 
and Cramer-von Mises tests option, you can create a plot of the empirical distribution test.

You can specify whether to display the p-values in the plot.
To suppress the plots from the results, select the Suppress plots check box.

Tests

Tests specifies whether to calculate only the asymptotic tests or both the 
asymptotic tests and exact tests for the various analyses.

Location Differences

Wilcoxon scores ranks of the observations.

Median scores equals 1 for observations greater than the median and 0 otherwise.

Van der Waerden 
scores

the quantiles of a standard normal distribution. These scores are also 
known as quantile normal scores.

Savage scores the expected values of order statistics from the exponential distribution 
with 1 subtracted to center the scores around 0.

Scale Differences

Ansari-Bradley 
scores

similar to the Siegel-Tukey scores, but assigns the same scores to 
corresponding extreme ranks.

Klotz scores the squares of the Van der Waerden (or quantile normal) scores.
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Option Name Description

Mood scores the square of the difference between each rank and the average rank.

Siegel-Tukey 
scores

scores are computed as 
a(1) = 1, a(n) = 2, a(n − 1) = 3, a(2) = 4, a(3) = 5, a(n − 2) = 6, ....
The score values continue to increase in this pattern toward the middle 
ranks until all observations are assigned a score.

Location and Scale Differences

Conover scores based on the squared ranks of the absolution deviations from the sample 
means.

Empirical 
distribution 
function tests, 
including 
Kolmogorov-
Smirnov and 
Cramer-von 
Mises tests

the empirical distribution function statistics (EDF).

Pairwise multiple 
comparison 
analysis 
(asymptotic only)

computes the Dwass, Steel, Critchlow-Fligner (DSCF) multiple 
comparison analyses.

Methods

Continuity Correction

Continuity 
correction for 
two sample 
Wilcoxon and 
Siegel-Tukey 
tests

uses a continuity correction for the asymptotic two-sample Wilcoxon and 
Siegel-Tukey tests by default. The task incorporates this correction when 
computing the standardized test statistic z by subtracting 0.5 from the 
numerator (S − E0(S)) if it is greater than zero. If the numerator is less 
than zero, the task adds 0.5.

Exact Statistics Computation

Use Monte Carlo 
estimation

requests the Monte Carlo estimation of the exact p-values instead of 
using the direct exact p-value computation. You can also specify the 
level of the confidence limits for the Monte Carlo p-value estimates.
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Option Name Description

Limit 
computation time

specifies the time limit for calculating each exact p-value. Calculating 
exact p-values can consume a large amount of time and memory.

Output Data Set

You can specify whether to save the statistics to a data set. By default, the data set is saved 
to the Work library.

Linear Regression Task

About the Linear Regression Task

Linear regression analysis tries to assign a linear function to your data by using the 
least squares method. Using the Linear Regression task, you can perform linear 
regression analysis on multiple dependent and independent variables.

Example: Predicting Weight Based on a 
Student’s Height

In this example, you want to use regression analysis to find out how well you can predict 
a child's weight if you know the child's height.

To create this example:

1 In the Tasks section, expand the Statistics folder and double-click Linear 
Regression. The user interface for the Linear Regression task opens.

2 On the Data tab, select the SASHELP.CLASS data set.

3 Assign columns to these roles:

Linear Regression Task 243



Role Column Name

Dependent variable Weight

Explanatory variables Height
Age

4 To run the task, click .
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Here are the results:
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Assigning Data to Roles

To run the Linear Regression task, you must assign columns to the Dependent 
variable and Explanatory variables roles.

Role Description

Role

Dependent variable specifies the numeric column to use as the 
dependent variable for the regression 
analysis. You must assign a numeric column 
to this role.

Explanatory variables specifies the numeric columns to use as the 
independent regressor (explanatory) columns 
for the regression model. You must assign at 
least one numeric column to this role.
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Role Description

Additional Roles

Frequency count lists a numeric variable whose value 
represents the frequency of the observation. 
If you assign a variable to this role, the task 
assumes that each observation represents n 
observations, where n is the value of the 
frequency variable. If n is not an integer, SAS 
truncates it. If n is less than 1 or is missing, 
the observation is excluded from the analysis. 
The sum of the frequency variable represents 
the total number of observations.

Weight lists the values that are relative weights for a 
weighted least squares fit.

Group analysis by sorts the table by the selected variables. 
Analyses are performed on each group.

Selecting a Model

Option Name Description

Methods

Confidence level specifies the significance level to use for the 
construction of confidence intervals.

Model

Include intercept includes the effect of the intercept in the 
regression equation. To exclude the intercept 
parameter from the model, clear this check 
box.

Model Selection

Linear Regression Task 249



Option Name Description

By default, the complete model that you specified is used to fit the model. However, you can 
also use one of these selection methods:
Forward selection

The forward selection method begins with no variables in the model. For each of the 
explanatory variables, this method calculates F statistics that reflect the variable's 
contribution to the model if it is included. The p-values for these F statistics are compared 
to the significance level that is specified for including a variable in the model. By default, 
this value is 0.05. To change this significance level, enter the value in the Significance 
level to add an effect to the model text box.
If no F statistic has a significance level greater than this value, the forward selection stops. 
Otherwise, the forward selection method adds the variable that has the largest F statistic to 
the model. The forward selection method then calculates F statistics again for the variables 
that still remain outside the model, and the evaluation process is repeated. Thus, variables 
are added one by one to the model until no remaining variable produces a significant F 
statistic. After a variable is added to the model, it stays there.

Backward elimination
The backward elimination method begins by calculating F statistics for a model, including 
all of the explanatory variables. Then the variables are deleted from the model one by one 
until all the variables that remain produce F statistics significant at the Significance level 
to remove an effect from the model value. (By default, this value is 0.05.) At each step, 
the variable that shows the smallest contribution to the model is deleted.
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Option Name Description

Stepwise selection
The stepwise method is a modification of the forward selection method. The stepwise 
method is differerent because the variables that are already in the model do not 
necessarily stay there. As in the forward selection method, variables are added one by one 
to the model, and the F statistic for a variable to be added must be significant at the 
Significance level to add an effect to the model value.
After a variable is added, the stepwise method looks at all the variables already included in 
the model and deletes any variable that does not produce an F statistic significant at the 
Significance level to remove an effect from the model value. Only after this check is 
made and the necessary deletions are accomplished can another variable be added to the 
model.
The stepwise process ends under either of these conditions:
n when no variable outside the model has an F statistic significant at the Significance 

level to add an effect to the model value and every variable in the model is significant 
at the Significance level to remove an effect from the model value.

n when the variable to be added to the model is the variable that was just deleted from it. 
Minimum R square improvement

The minimum R-square improvement method closely resembles the maximum R-square 
improvement method, but the variables that are chosen produce the smallest increase in R
2. For a given number of variables in the model, the maximum R-square and minimum R-
square methods usually produce the same "best" model, but the minimum R-square 
method considers more models of each size.

Maximum R square improvement
The maximum R-square improvement method does not settle on a single model. Instead, it 
tries to find the "best" one-variable model, the "best" two-variable model, and so on, 
although it is not guaranteed to find the model with the largest R2 for each size.
This method begins by finding the one-variable model that produces the highest R2. Then 
another variable, the one that yields the greatest increase in R2, is added. After the two-
variable model is obtained, each variable in the model is compared to each variable not in 
the model. For each comparison, this method determines whether removing one variable 
and replacing it with the other variable increases R2. After comparing all possible switches, 
this method makes the switch that produces the largest increase in R2. Comparisons begin 
again, and the process continues until this method finds that no further switch could 
increase R2. Thus, the resulting two-variable model is considered the "best" two-variable 
model that the method can find. Another variable is then added to the model, and the 
comparing-and-switching process is repeated to find the "best" three-variable model, and 
so on.
The difference between the stepwise selection method and the maximum R2 selection 
method is that in the maximum R2 method, all switches are evaluated before any switch is 
made. In the stepwise selection method, the "worst" variable might be removed without 
considering what adding the "best" remaining variable might accomplish.

Linear Regression Task 251



Option Name Description

All possible regressions
The Linear Regression task fits all possible regression models from the selected 
explanatory variables. You select the statistic by which to order the best-fitting models. You 
can choose from these statistics: R square, Adjusted R square, and Mallows’ Cp. You can 
also specify the number of best-fitting models to display.

Model Selection Statistics
Model Selection Plots

For each method, you can choose from these model selection statistics and model selection 
plots:
n adjusted R-square
n R-square (available for plots only)
n Akaike’s information criterion
n Bayesian information criterion
n Mallows’ Cp statistic
n Schwarz’ Bayesian information criterion

Setting Options

Option Name Description

Statistics

Parameter Estimates

Standardized regression coefficients displays the standardized regression 
coefficients. A standardized regression 
coefficient is computed by dividing a 
parameter estimate by the ratio of the sample 
standard deviation of the dependent variable 
to the sample standard deviation of the 
regressor.

Confidence limits for estimates displays the 100(1 − α) %  upper and lower 
confidence limits for the parameter estimates.
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Option Name Description

Sums of Squares

Sequential sum of squares (Type I) displays the sequential sums of squares 
(Type I SS) along with the parameter 
estimates for each term in the model.

Partial sum of squares (Type II) displays the partial sums of squares (Type II 
SS) along with the parameter estimates for 
each term in the model.

Partial and Semipartial Correlations

Squared partial correlations displays the squared partial correlation 
coefficients computed by using Type I and 
Type II sum of squares.

Squared semipartial correlations displays the squared semipartial correlation 
coefficients computed by using Type I and 
Type II sum of squares. This value is 
calculated as sum of squares divided by the 
corrected total sum of squares.

Collinearity

Collinearity analysis requests a detailed analysis of collinearity 
among the regressors. This includes 
eigenvalues, condition indices, and 
decomposition of the variances of the 
estimates with respect to each eigenvalue.

Tolerance values for estimates produces tolerance values for the estimates. 
Tolerance for a variable is defined as 1 − R 2, 
where R square is obtained from the 
regression of the variable on all other 
regressors in the model.

Variance inflation factors produces variance inflation factors with the 
parameter estimates. Variance inflation is the 
reciprocal of tolerance.

Heteroscedasticity

Linear Regression Task 253



Option Name Description

Heteroscedasticity analysis performs a test to confirmthat the first and 
second moments of the model are correctly 
specified.

Asymptotic covariance matrix displays the estimated asymptotic covariance 
matrix of the estimates under the hypothesis 
of heteroscedasticity and heteroscedasticity-
consistent standard errors of parameter 
estimates.

Autocorrelation

Durbin-Watson statistic calculates a Durbin-Watson statistic and a p-
value to test whether the errors have first-
order autocorrelation.

Plots
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Option Name Description

You can select the diagnostic, residual, and scatter plots to include in the results.
By default, these plots are included in the results:

n plots of the fit diagnostics:
o residuals versus the predicted values
o studentized residuals versus the predicted values
o studentized residuals versus the leverage
o normal quantile plot of the residuals
o dependent variable versus the predicted values
o Cook’s D versus observation number
o histogram of residuals
o residual-fit plot, which includes side-by-side quantile plots of the centered fit and the 

residuals
n residuals plot for each explanatory variable
n a scatter plot of the observed values by predicted values
You can also include these diagnostic plots:

n Rstudent statistic by predicted values plots studentized residuals by predicted values. If 
you select the Label extreme points option, observations with studentized residuals that 
lie outside the band between the reference lines RSTUDENT = ± 2 are deemed outliers.

n DFFITS statistic by observations plots the DFFITS statistic by observation number. If you 
select the Label extreme points option, observations with a DFFITS statistic greater in 
magnitude than 2 p

n  are deemed influential. The number of observations used is n, and 
the number of regressors is p.

n DFBETAS statistic by observation number for each explanatory variable produces 
panels of DFBETAS by observation number for the regressors in the model. You can view 
these plots as a panel or as individual plots. If you select the Label extreme points option, 
observations with a DFBETAS statistics greater in magnitude than 2

n  are deemed 
influential for that regressor. The number of observations used is n.

You can also include these scatter plots:

n Fit plot for a single explanatory variable produces a scatter plot of the data overlaid with 
the regression line, confidence band, and prediction band for models that depend on at 
most one regressor. The intercept is excluded. When the number of points exceeds the 
value for the Maximum number of plot points option, a heat map is displayed instead of a 
scatter plot.

n Partial regression plots for each explanatory variable produces partial regression plots 
for each regressor. If you display these plots in a panel, there is a maximum of six 
regressors per panel.
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Creating Output Data Sets

Option Name Description

Output Data Sets

You can create two types of output data sets. By default, these data sets are saved in the 
Work library.
Parameter estimates data set

outputs a data set that contains parameter estimates and other model fit summary 
statistics. Any model selection statistics that you selected on the Methods tab are included 
in the parameter estimates.

Observationwise statistics data set
outputs a data set that contains sums of squares and cross-products.
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About the Task Data Sets

To complete some of the examples in the task documentation, you might need to create 
one or more data sets. This appendix provides the SAS code that you need. To create 
these data sets, copy and paste this code into a Program tab in SAS Studio and click 

.

FITNESS Data set

To create the Fitness data set, enter this code into a Program tab:
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data Fitness;
   input Age Weight Oxygen RunTime @@;
   datalines;
44 89.47 44.609 11.37
40 75.07 45.313 10.07
44 85.84 54.297 8.65
42 68.15 59.571 8.17
38 89.02 49.874 .
47 77.45 44.811 11.63
40 75.98 45.681 11.95
43 81.19 49.091 10.85
44 81.42 39.442 13.08
38 81.87 60.055 8.63
44 73.03 50.541 10.13
45 87.66 37.388 14.03
45 66.45 44.754 11.12
47 79.15 47.273 10.60
54 83.12 51.855 10.33
49 81.42 49.156 8.95
51 69.63 40.836 10.95
51 77.91 46.672 10.00
48 91.63 46.774 10.25
49 73.37 . 10.08
57 73.37 39.407 12.63
54 79.38 46.080 11.17
52 76.32 45.441 9.63
50 70.87 54.625 8.92
51 67.25 45.118 11.08
54 91.63 39.203 12.88
51 73.71 45.790 10.47
57 59.08 50.545 9.93
49 76.32 . .
48 61.24 47.920 11.50
52 82.78 47.467 10.50
;

GETSTARTED Data Set

To create the getStarted data set, enter this code into a Program tab:

data getStarted;
   input C1-C5 Y Total;
   datalines;
0 3 1 1 3 2 28.361
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2 3 0 3 1 2 39.831
1 3 2 2 2 1 17.133
1 2 0 0 3 2 12.769
0 2 1 0 1 1 29.464
0 2 1 0 2 1 4.152
1 2 1 0 1 0 0.000
0 2 1 1 2 1 20.199
1 2 0 0 1 0 0.000
0 1 1 3 3 2 53.376
2 2 2 2 1 1 31.923
0 3 2 0 3 2 37.987
2 2 2 0 0 1 1.082
0 2 0 2 0 1 6.323
1 3 0 0 0 0 0.000
1 2 1 2 3 2 4.217
0 1 2 3 1 1 26.084
1 1 0 0 1 0 0.000
1 3 2 2 2 0 0.000
2 1 3 1 1 2 52.640
1 3 0 1 2 1 3.257
2 0 2 3 0 5 88.066
2 2 2 1 0 1 15.196
3 1 3 1 0 1 11.955
3 1 3 1 2 3 91.790
3 1 1 2 3 7 232.417
3 1 1 1 0 1 2.124
3 1 0 0 0 2 32.762
3 1 2 3 0 1 25.415
2 2 0 1 2 1 42.753
3 3 2 2 3 1 23.854
2 0 0 2 3 2 49.438
1 0 0 2 3 4 105.449
0 0 2 3 0 6 101.536
0 3 1 0 0 0 0.000
3 0 1 0 1 1 5.937
2 0 0 0 3 2 53.952
1 0 1 0 3 2 23.686
1 1 3 1 1 1 0.287
2 1 3 0 3 7 281.551
1 3 2 1 1 0 0.000
2 1 0 0 1 0 0.000
0 0 1 1 2 3 93.009
0 1 0 1 0 2 25.055
1 2 2 2 3 1 1.691
0 3 2 3 1 1 10.719
3 3 0 3 3 1 19.279
2 0 0 2 1 2 40.802
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2 2 3 0 3 3 72.924
0 2 0 3 0 1 10.216
3 0 1 2 2 2 87.773
2 1 2 3 1 0 0.000
3 2 0 3 1 0 0.000
3 0 3 0 0 2 62.016
1 3 2 2 1 3 36.355
2 3 2 0 3 1 23.190
1 0 1 2 1 1 11.784
2 1 2 2 2 5 204.527
3 0 1 1 2 5 115.937
0 1 1 3 2 1 44.028
2 2 1 3 1 4 52.247
1 1 0 0 1 1 17.621
3 3 1 2 1 2 10.706
2 2 0 2 3 3 81.506
0 1 0 0 2 2 81.835
0 1 2 0 1 2 20.647
3 2 2 2 0 1 3.110
2 2 3 0 0 1 13.679
1 2 2 3 2 1 6.486
3 3 2 2 1 2 30.025
0 0 3 1 3 6 202.172
3 2 3 1 2 3 44.221
0 3 0 0 0 1 27.645
3 3 3 0 3 2 22.470
2 3 2 0 2 0 0.000
1 3 0 2 0 1 1.628
1 3 1 0 2 0 0.000
3 2 3 3 0 1 20.684
3 1 0 2 0 4 108.000
0 1 2 2 1 1 4.615
0 2 3 2 2 1 12.461
0 3 2 0 1 3 53.798
2 1 1 2 0 1 36.320
1 0 3 0 0 0 0.000
0 0 3 2 0 1 19.902
0 2 3 1 0 0 0.000
2 2 2 1 3 2 31.815
3 3 3 0 0 0 0.000
2 2 1 3 3 2 17.915
0 2 3 2 3 2 69.315
1 3 1 2 1 0 0.000
3 0 1 1 1 4 94.050
2 1 1 1 3 6 242.266
0 2 0 3 2 1 40.885
2 0 1 1 2 2 74.708
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2 2 2 2 3 2 50.734
1 0 2 2 1 3 35.950
1 3 3 1 1 1 2.777
3 1 2 1 3 5 118.065
0 3 2 1 2 0 0.000
;

GREENE Data Set

To create the Greene data set, enter this code into a Program tab:

data greene;
   input firm year production cost @@;
datalines;
1 1955   5.36598   1.14867  1 1960   6.03787   1.45185
1 1965   6.37673   1.52257  1 1970   6.93245   1.76627
2 1955   6.54535   1.35041  2 1960   6.69827   1.71109
2 1965   7.40245   2.09519  2 1970   7.82644   2.39480
3 1955   8.07153   2.94628  3 1960   8.47679   3.25967
;

IN Data Set

To create the In data set, enter this code into a Program tab:

data in; 
   label q = "Quantity" 
         p = "Price" 
         s = "Price of Substitutes" 
         y = "Income" 
         u = "Unit Cost"; 
   drop i e1 e2; 
   p = 0; q = 0; 
   do i = 1 to 60; 
      y = 1 + .05*i  + .15*rannor(123); 
      u = 2          + .05*rannor(123) + .05*rannor(123); 
      s = 4 - .001*(i-10)*(i-110) + .5*rannor(123); 
      e1 = .15 * rannor(123); 
      e2 = .15 * rannor(123); 
      demandx = 1 + .3 * y + .35 * s + e1; 
      supplyx = -1 - 1 * u + e2 - .4*e1; 

IN Data Set 261



      q = 1.4/2.15 * demandx + .75/2.15 * supplyx; 
      p = ( - q + supplyx ) / -1.4; 
      output; 
   end; 
run; 

The output data set (IN) is saved in your Work library.

LONG97DATA Data Set

To create the In data set, enter this code into a Program tab:

data long97data; 
   input fem ment phd mar kid5 art lnart; 
datalines; 
0   7.99999860   1.38000000  1  2  3   1.25276290 
0   6.99999950   4.29000000  0  0  0  -0.69314720 
0  47.00000760   3.84999990  0  0  4   1.50407740 
0  19.00000190   3.58999990  1  1  1   0.40546510 
0   0.00000000   1.80999990  1  0  1   0.40546510 
0   6.00000050   3.58999990  1  1  1   0.40546510 
0   9.99999900   2.11999990  1  1  0  -0.69314720 
0   1.99999990   4.29000000  1  0  0  -0.69314720 
0   1.99999990   2.57999990  1  2  3   1.25276290 
0   3.99999900   1.80000000  1  1  3   1.25276290 
0   0.00000000   4.29000000  1  2  1   0.40546510 
0   3.00000000   2.76000000  1  1  0  -0.69314720 
0   9.99999900   3.41000010  1  1  1   0.40546510 
0   6.99999950   4.34000020  1  3  2   0.91629080 
0  15.00000100   3.84999990  1  2  5   1.70474800 
0   1.99999990   2.09999990  1  0  2   0.91629080 
0  13.00000000   4.29000000  1  0  2   0.91629080 
0  15.00000100   4.29000000  0  0  1   0.40546510 
0   4.99999810   2.26000000  1  1  0  -0.69314720 
0   6.00000050   2.09999990  0  0  0  -0.69314720 
0  12.00000000   2.26000000  1  0  3   1.25276290 
0  15.99999810   3.84999990  1  1  6   1.87180220 
0   6.99999950   4.29000000  0  0  4   1.50407740 
0   6.00000050   1.80000000  1  2  2   0.91629080 
0   1.99999990   2.26000000  0  0  2   0.91629080 
0   0.00000000   2.09999990  0  0  0  -0.69314720 
0  30.00000190   4.29000000  1  0  4   1.50407740 
0   9.99999900   4.29000000  1  2  1   0.40546510 
0   1.99999990   2.09999990  1  0  1   0.40546510 
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0   0.99999990   3.58999990  1  0  7   2.01490310 
0   3.00000000   3.42000010  1  1  2   0.91629080 
0   9.99999900   4.29000000  1  2  2   0.91629080 
0   9.99999900   4.29000000  0  0  2   0.91629080 
0   0.99999990   3.33999990  1  2  0  -0.69314720 
0   1.99999990   4.29000000  0  0  0  -0.69314720 
0  10.99999710   4.29000000  1  0  1   0.40546510 
0   4.99999810   3.61999990  1  0  4   1.50407740 
0   0.00000000   4.29000000  1  3  1   0.40546510 
0   3.99999900   4.34000020  1  1  1   0.40546510 
0   1.99999990   1.25000000  1  1  2   0.91629080 
0  19.00000190   4.34000020  0  0  7   2.01490310 
0   3.00000000   1.67000000  1  3  1   0.40546510 
0   0.00000000   3.47000000  0  0  0  -0.69314720 
0   0.99999990   2.26000000  1  1  1   0.40546510 
0   0.99999990   1.80000000  1  0  1   0.40546510 
0  17.00000000   4.34000020  1  2  2   0.91629080 
0   3.00000000   3.58999990  0  0  2   0.91629080 
0   0.99999990   1.75000000  1  2  1   0.40546510 
0   6.00000050   4.29000000  0  0  1   0.40546510 
0   0.00000000   2.09999990  1  1  0  -0.69314720 
0  15.00000100   4.29000000  1  2  0  -0.69314720 
0   0.00000000   2.09999990  1  1  0  -0.69314720 
0  26.99999810   3.31999990  1  2  2   0.91629080 
0   4.99999810   4.34000020  1  0  2   0.91629080 
0   6.99999950   3.41000010  0  0  4   1.50407740 
0   0.00000000   4.29000000  1  0  1   0.40546510 
0  10.99999710   3.19000010  1  0  2   0.91629080 
0  13.00000000   4.29000000  1  0  2   0.91629080 
0   3.99999900   1.74000000  1  2  1   0.40546510 
0   3.99999900   2.76000000  0  0  1   0.40546510 
0  26.99999810   3.58999990  1  1  7   2.01490310 
0   9.99999900   1.80999990  1  0  4   1.50407740 
0  13.00000000   4.29000000  1  1  2   0.91629080 
0   0.99999990   4.29000000  1  1  1   0.40546510 
0   6.00000050   2.76000000  0  0  1   0.40546510 
0   6.00000050   3.47000000  0  0  6   1.87180220 
0   4.99999810   2.50000000  1  2  2   0.91629080 
0   1.99999990   1.25000000  1  0  5   1.70474800 
0  13.99999710   3.58999990  1  1  3   1.25276290 
0   0.00000000   2.09999990  1  1  0  -0.69314720 
0  12.00000000   3.58999990  1  0  1   0.40546510 
0   6.99999950   3.58999990  1  3  0  -0.69314720 
0   3.00000000   1.75000000  1  0  1   0.40546510 
0   1.99999990   1.75000000  1  2  1   0.40546510 
0   1.99999990   3.58999990  1  1  1   0.40546510 
0   1.99999990   4.29000000  0  0  1   0.40546510 
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0   0.00000000   4.29000000  0  0  0  -0.69314720 
0   0.00000000   2.09999990  1  1  0  -0.69314720 
0   0.00000000   2.60999990  1  0  3   1.25276290 
0  30.00000190   4.29000000  1  0  5   1.70474800 
0  21.00000000   1.74000000  1  0 16   2.80336050 
0   4.99999810   2.76000000  1  0  1   0.40546510 
0   9.00000000   4.29000000  0  0  0  -0.69314720 
0   7.99999860   2.76000000  1  2  1   0.40546510 
0  25.00000000   4.29000000  1  2  3   1.25276290 
0   0.00000000   3.47000000  1  1  5   1.70474800 
0   4.99999810   2.57999990  1  2  0  -0.69314720 
0   0.99999990   2.14000010  1  0  0  -0.69314720 
0   4.99999810   2.26000000  0  0  0  -0.69314720 
0   0.00000000   4.29000000  1  2  3   1.25276290 
0  15.00000100   4.29000000  1  0  3   1.25276290 
0  30.00000190   4.29000000  0  0  3   1.25276290 
0   1.99999990   2.20000000  1  0  0  -0.69314720 
0   6.00000050   1.80000000  1  2  3   1.25276290 
0   0.00000000   2.09999990  1  2  1   0.40546510 
0  13.00000000   4.29000000  1  1  1   0.40546510 
0   0.00000000   4.29000000  0  0  0  -0.69314720 
0  12.00000000   2.09999990  1  1  0  -0.69314720 
0  30.00000190   4.29000000  1  2  2   0.91629080 
0   4.99999810   1.80999990  1  1  1   0.40546510 
0   9.99999900   4.34000020  1  0  1   0.40546510 
0   4.99999810   4.29000000  1  1  0  -0.69314720 
0   3.99999900   2.50000000  1  2  1   0.40546510 
0  13.00000000   2.05000000  1  2  4   1.50407740 
0   7.99999860   3.47000000  1  0  3   1.25276290 
0   6.00000050   2.60999990  1  1  1   0.40546510 
0   6.00000050   4.29000000  1  2  1   0.40546510 
0  25.00000000   4.29000000  0  0  2   0.91629080 
0   1.99999990   4.29000000  1  1  2   0.91629080 
0   9.00000000   4.34000020  1  0  6   1.87180220 
0   9.99999900   2.11999990  1  1  0  -0.69314720 
0   3.00000000   2.76000000  1  0  2   0.91629080 
0   1.99999990   4.29000000  1  2  0  -0.69314720 
0   0.00000000   2.50000000  1  0  1   0.40546510 
0   6.00000050   4.34000020  1  0  5   1.70474800 
0   7.99999860   2.76000000  1  1  2   0.91629080 
0   9.99999900   3.19000010  1  1  2   0.91629080 
0   7.99999860   4.61999990  0  0  3   1.25276290 
0   6.00000050   3.15000010  1  2  0  -0.69314720 
0  21.00000000   2.55000000  1  1  4   1.50407740 
0   3.99999900   1.52000000  1  0  0  -0.69314720 
0   1.99999990   1.72000000  1  2  4   1.50407740 
0   0.99999990   1.78000000  1  1  2   0.91629080 
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0  17.00000000   2.85999990  1  1  1   0.40546510 
0  30.00000190   4.61999990  1  2  0  -0.69314720 
0   4.99999810   4.13999990  0  0  1   0.40546510 
0  13.00000000   2.96000000  1  1  6   1.87180220 
0  10.99999710   2.55000000  1  0  1   0.40546510 
0  19.00000190   2.21000000  1  1  0  -0.69314720 
0   4.99999810   3.08999990  1  0  3   1.25276290 
0  66.00000760   4.54000000  1  2  4   1.50407740 
0   0.00000000   1.78000000  1  0  3   1.25276290 
0   3.00000000   2.21000000  1  3  0  -0.69314720 
0   3.00000000   2.39000010  1  1  1   0.40546510 
0   0.00000000   2.96000000  1  0  0  -0.69314720 
0   7.99999860   2.51000000  1  1  0  -0.69314720 
0   0.00000000   1.97000000  1  2  2   0.91629080 
0   4.99999810   4.13999990  0  0  0  -0.69314720 
0  29.00000000   4.25000000  1  1  4   1.50407740 
0  10.99999710   2.85999990  1  2  0  -0.69314720 
0  22.99999620   2.96000000  1  1  9   2.25129180 
0  45.99999240   2.96000000  1  2  2   0.91629080 
0   7.99999860   4.61999990  1  1  6   1.87180220 
0   4.99999810   3.69000010  1  2  0  -0.69314720 
0   0.99999990   3.15000010  1  1  0  -0.69314720 
0   9.00000000   4.61999990  0  0  2   0.91629080 
0   1.99999990   3.35999990  1  0  0  -0.69314720 
0   6.99999950   3.69000010  0  0  4   1.50407740 
0  10.99999710   3.54000000  1  0  1   0.40546510 
0  56.99999620   2.96000000  1  1  4   1.50407740 
0  15.99999810   2.55999990  1  1  1   0.40546510 
0   0.00000000   2.31999990  1  0  0  -0.69314720 
0   3.00000000   2.31999990  1  0  0  -0.69314720 
0   0.99999990   0.92000000  1  2  0  -0.69314720 
0   9.99999900   4.54000000  1  0  0  -0.69314720 
0  10.99999710   4.54000000  1  3  0  -0.69314720 
0  10.99999710   1.76000000  1  1  5   1.70474800 
0  15.99999810   2.55999990  0  0  1   0.40546510 
0   4.99999810   2.39000010  1  1  0  -0.69314720 
0   9.00000000   3.40000010  1  0  2   0.91629080 
0  19.99999620   2.86999990  1  2  2   0.91629080 
0  21.00000000   4.54000000  1  2  4   1.50407740 
0   4.99999810   2.82999990  1  0  4   1.50407740 
0   6.00000050   1.67999990  1  0  0  -0.69314720 
0  12.00000000   3.54000000  0  0  3   1.25276290 
0   0.00000000   1.76000000  1  0  2   0.91629080 
0  10.99999710   3.15000010  1  3  1   0.40546510 
0   3.00000000   2.51000000  1  0  0  -0.69314720 
0  15.99999810   3.69000010  1  1  0  -0.69314720 
0  10.99999710   1.76000000  1  1  4   1.50407740 
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0   4.99999810   1.86000000  1  1 12   2.52572870 
0   0.99999990   2.76000000  1  3  0  -0.69314720 
0  15.99999810   4.61999990  1  1  1   0.40546510 
0  12.00000000   4.25000000  1  0  5   1.70474800 
0  10.99999710   2.54000000  1  0  4   1.50407740 
0   0.00000000   2.20000000  1  1  0  -0.69314720 
0   0.00000000   1.76000000  1  0  2   0.91629080 
0   3.00000000   2.85999990  1  3  3   1.25276290 
0  13.00000000   3.40000010  1  2  0  -0.69314720 
0  45.00000000   4.54000000  1  1  1   0.40546510 
0  47.00000760   1.86000000  1  1  9   2.25129180 
0   6.99999950   1.52000000  1  0  0  -0.69314720 
0   6.99999950   2.55999990  1  1  2   0.91629080 
0  19.00000190   2.21000000  1  0  0  -0.69314720 
0   9.00000000   3.69000010  1  0  7   2.01490310 
0  76.99998470   1.78000000  1  1  1   0.40546510 
0   0.00000000   1.17999990  1  1  0  -0.69314720 
0   3.99999900   2.00000000  1  0  1   0.40546510 
0  19.00000190   2.21000000  1  0  0  -0.69314720 
0  12.00000000   4.13999990  1  2  0  -0.69314720 
0   0.99999990   2.85999990  1  3  0  -0.69314720 
0  17.00000000   2.85999990  1  1  1   0.40546510 
0   6.00000050   2.54000000  0  0  7   2.01490310 
0   3.99999900   2.85999990  1  1  0  -0.69314720 
0   6.00000050   2.52000000  0  0  4   1.50407740 
0   3.00000000   1.52000000  1  1  2   0.91629080 
0   4.99999810   3.08999990  1  1  3   1.25276290 
0   3.00000000   1.17999990  1  1  0  -0.69314720 
0   3.00000000   1.42000000  1  0  0  -0.69314720 
0  15.00000100   4.61999990  0  0  7   2.01490310 
0   0.00000000   2.96000000  1  2  1   0.40546510 
0   9.99999900   4.54000000  0  0  2   0.91629080 
0  41.99999620   4.54000000  0  0  7   2.01490310 
0   3.00000000   2.51000000  1  2  1   0.40546510 
0   6.99999950   3.15000010  1  1  2   0.91629080 
0   0.00000000   2.50000000  1  0  1   0.40546510 
0   6.00000050   2.96000000  1  3  1   0.40546510 
0   3.99999900   1.67999990  1  0  0  -0.69314720 
0   0.00000000   1.22000000  1  1  1   0.40546510 
0   1.99999990   1.52000000  1  0  1   0.40546510 
0   4.99999810   2.21000000  1  1  0  -0.69314720 
0   0.99999990   3.92000010  1  1  0  -0.69314720 
0  13.00000000   4.54000000  1  0  5   1.70474800 
0   0.00000000   1.17999990  1  0  2   0.91629080 
0  26.00000000   3.69000010  1  0  3   1.25276290 
0   0.99999990   1.72000000  1  0  2   0.91629080 
0  25.00000000   2.57999990  1  1  5   1.70474800 

266 Appendix 1 / Input Data Sets for Task Examples



0   3.00000000   1.52000000  0  0  3   1.25276290 
0  47.00000760   1.86000000  1  1  4   1.50407740 
0   3.99999900   2.50000000  1  0  5   1.70474800 
0   0.99999990   4.61999990  1  0  1   0.40546510 
0   6.99999950   1.40000000  1  2  0  -0.69314720 
0   4.99999810   4.54000000  1  0  3   1.25276290 
0  26.99999810   1.67999990  1  1  0  -0.69314720 
0   0.99999990   2.82999990  1  0  2   0.91629080 
0   4.99999810   3.35999990  0  0  1   0.40546510 
0   0.00000000   1.97000000  1  1  7   2.01490310 
0  12.00000000   3.40000010  0  0  1   0.40546510 
0   3.99999900   1.74000000  1  1  1   0.40546510 
0   0.00000000   2.96000000  0  0  0  -0.69314720 
0  25.00000000   2.57999990  1  1  4   1.50407740 
0   3.00000000   4.54000000  1  1  1   0.40546510 
0   1.99999990   3.15000010  1  1  0  -0.69314720 
0  12.00000000   2.96000000  1  2  0  -0.69314720 
0  15.99999810   3.54000000  1  2  2   0.91629080 
0   4.99999810   2.96000000  1  1  3   1.25276290 
0  12.00000000   4.25000000  1  0  1   0.40546510 
0   4.99999810   2.55999990  1  1  2   0.91629080 
0   4.99999810   1.86000000  1  0  1   0.40546510 
0   3.00000000   4.61999990  1  1  1   0.40546510 
0   3.99999900   2.85999990  0  0  2   0.91629080 
0   4.99999810   3.15000010  1  1  5   1.70474800 
0   0.00000000   2.51000000  1  0  2   0.91629080 
0  26.99999810   3.15000010  1  1  5   1.70474800 
0   4.99999810   2.51000000  1  0  2   0.91629080 
0   0.00000000   1.52000000  1  1  0  -0.69314720 
0  17.99999810   4.29000000  0  0  6   1.87180220 
0   4.99999810   4.29000000  1  1  4   1.50407740 
0   7.99999860   4.29000000  1  2  2   0.91629080 
0   3.99999900   2.09999990  1  0  2   0.91629080 
0  35.00000760   4.29000000  1  1 12   2.52572870 
0   4.99999810   4.29000000  0  0  2   0.91629080 
0   9.00000000   3.58999990  1  1  1   0.40546510 
0   6.00000050   4.29000000  1  0  1   0.40546510 
0  24.00000190   4.29000000  1  0  2   0.91629080 
0   0.00000000   2.09999990  1  1  0  -0.69314720 
0   4.99999810   1.80999990  1  1  0  -0.69314720 
0  19.00000190   4.29000000  0  0  7   2.01490310 
0   3.00000000   4.29000000  0  0  1   0.40546510 
0   1.99999990   4.29000000  1  1  1   0.40546510 
0   3.99999900   1.25000000  1  0  3   1.25276290 
0   9.99999900   3.58999990  1  0  1   0.40546510 
0   7.99999860   2.09999990  1  1  1   0.40546510 
0   1.99999990   4.29000000  1  0  4   1.50407740 
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0  19.00000190   4.29000000  1  1  3   1.25276290 
0   0.99999990   3.47000000  1  1  1   0.40546510 
0   3.00000000   3.19000010  1  0  1   0.40546510 
0   4.99999810   3.19000010  1  2  1   0.40546510 
0   0.00000000   2.09999990  1  0  1   0.40546510 
0  21.00000000   3.58999990  1  1  5   1.70474800 
0  13.99999710   4.29000000  1  1  1   0.40546510 
0   0.00000000   2.09999990  1  0  0  -0.69314720 
0   6.99999950   2.76000000  1  1  1   0.40546510 
0   4.99999810   2.60999990  1  0  3   1.25276290 
0  22.00000000   4.29000000  1  0  4   1.50407740 
0  19.99999620   3.41000010  0  0  7   2.01490310 
0  38.00000380   4.29000000  1  0  3   1.25276290 
0  19.00000190   4.29000000  0  0  4   1.50407740 
0   3.00000000   2.26000000  0  0  2   0.91629080 
0  15.99999810   3.58999990  0  0  3   1.25276290 
0   1.99999990   4.29000000  1  1  0  -0.69314720 
0   3.00000000   2.05000000  0  0  1   0.40546510 
0  12.00000000   4.29000000  1  2  1   0.40546510 
0  35.00000760   4.29000000  0  0  0  -0.69314720 
0  19.00000190   4.29000000  1  0  0  -0.69314720 
0   1.99999990   4.29000000  0  0  0  -0.69314720 
0   6.99999950   2.76000000  0  0  1   0.40546510 
0   3.99999900   2.09999990  1  2  3   1.25276290 
0  13.99999710   2.35999990  0  0  1   0.40546510 
0   9.00000000   4.29000000  0  0  0  -0.69314720 
0   7.99999860   3.58999990  0  0  0  -0.69314720 
0  12.00000000   4.29000000  1  1  2   0.91629080 
0   3.00000000   4.29000000  1  1  0  -0.69314720 
0   0.99999990   4.29000000  1  0  1   0.40546510 
0   9.99999900   4.29000000  0  0  1   0.40546510 
0  21.00000000   3.41000010  0  0  4   1.50407740 
0  13.00000000   4.29000000  1  1  0  -0.69314720 
0  17.00000000   4.29000000  1  0  2   0.91629080 
0   4.99999810   4.29000000  0  0  0  -0.69314720 
0   1.99999990   2.14000010  0  0  0  -0.69314720 
0   7.99999860   4.29000000  1  0  0  -0.69314720 
0   1.99999990   2.50000000  1  1  2   0.91629080 
0   4.99999810   2.60999990  1  1  3   1.25276290 
0   0.99999990   1.80999990  1  2  0  -0.69314720 
0   1.99999990   2.26000000  1  1  0  -0.69314720 
0   3.99999900   3.61999990  1  2  1   0.40546510 
0   9.00000000   4.29000000  1  2  1   0.40546510 
0   9.00000000   4.29000000  0  0  0  -0.69314720 
0  17.00000000   4.29000000  0  0  2   0.91629080 
0  24.00000190   4.29000000  1  2  0  -0.69314720 
0   3.99999900   3.47000000  1  0  4   1.50407740 

268 Appendix 1 / Input Data Sets for Task Examples



0  13.99999710   4.29000000  1  1  2   0.91629080 
0   4.99999810   3.58999990  1  1  1   0.40546510 
0   9.99999900   1.80999990  0  0  1   0.40546510 
0  17.99999810   4.29000000  1  1  3   1.25276290 
0   0.99999990   4.29000000  1  1  0  -0.69314720 
0   0.00000000   2.09999990  1  0  1   0.40546510 
0   3.99999900   2.15000010  1  2  0  -0.69314720 
0   7.99999860   4.29000000  1  0  0  -0.69314720 
0   0.99999990   2.26000000  1  0  1   0.40546510 
0   7.99999860   4.29000000  1  0  0  -0.69314720 
0  13.00000000   4.29000000  1  2  0  -0.69314720 
0   4.99999810   3.58999990  1  2  0  -0.69314720 
0   6.99999950   3.41000010  1  2  0  -0.69314720 
0   6.99999950   3.58999990  0  0  3   1.25276290 
0   4.99999810   3.61999990  1  1  3   1.25276290 
0   0.00000000   2.09999990  1  3  1   0.40546510 
0  13.99999710   4.29000000  0  0  1   0.40546510 
0   6.00000050   4.29000000  1  0  0  -0.69314720 
0   4.99999810   2.26000000  1  1  1   0.40546510 
0   7.99999860   2.76000000  1  0  3   1.25276290 
0   3.99999900   2.60999990  1  1  1   0.40546510 
0   9.00000000   4.29000000  0  0  2   0.91629080 
0   3.00000000   2.09999990  1  1  2   0.91629080 
0   1.99999990   3.47000000  1  1  0  -0.69314720 
0   0.00000000   2.09999990  0  0  0  -0.69314720 
0  10.99999710   4.29000000  0  0  1   0.40546510 
0   9.00000000   4.29000000  0  0  1   0.40546510 
0   7.99999860   2.96000000  1  0  1   0.40546510 
0   1.99999990   2.96000000  1  0  2   0.91629080 
0  17.99999810   4.61999990  1  0  3   1.25276290 
0   3.00000000   1.42000000  1  0  3   1.25276290 
0   1.99999990   4.54000000  1  0  1   0.40546510 
0   6.99999950   2.52000000  1  0  0  -0.69314720 
0   9.99999900   4.54000000  1  1  2   0.91629080 
0  15.99999810   2.00000000  1  1  1   0.40546510 
0   4.99999810   2.54000000  1  0  0  -0.69314720 
0   0.00000000   2.50000000  1  0  2   0.91629080 
0   7.99999860   4.54000000  0  0  0  -0.69314720 
0   9.99999900   3.35999990  0  0  1   0.40546510 
0  17.99999810   3.40000010  1  1  0  -0.69314720 
0  12.00000000   1.67999990  1  1  1   0.40546510 
0   9.00000000   2.00000000  0  0  1   0.40546510 
0  39.00000000   2.85999990  1  0  1   0.40546510 
0  17.99999810   4.61999990  1  0  1   0.40546510 
0  15.00000100   4.13999990  1  0  1   0.40546510 
0  15.99999810   4.13999990  1  0  2   0.91629080 
0   1.99999990   2.96000000  0  0  0  -0.69314720 
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0   6.99999950   2.82999990  1  2  3   1.25276290 
0  24.00000190   2.55000000  1  0  2   0.91629080 
0   7.99999860   1.67999990  1  0  1   0.40546510 
0   6.99999950   2.00000000  0  0  1   0.40546510 
0  10.99999710   2.00000000  1  1  1   0.40546510 
0   0.00000000   2.96000000  1  1  4   1.50407740 
0   3.99999900   1.50500000  1  0  4   1.50407740 
0  21.00000000   3.54000000  1  0  2   0.91629080 
0   6.00000050   3.40000010  0  0  1   0.40546510 
0   6.00000050   4.61999990  0  0  0  -0.69314720 
0   7.99999860   2.82999990  0  0  3   1.25276290 
0   3.99999900   2.54000000  1  0  1   0.40546510 
0  12.00000000   2.86999990  0  0  1   0.40546510 
0  15.00000100   1.86000000  0  0  1   0.40546510 
0   0.00000000   3.92000010  1  1  1   0.40546510 
0   4.99999810   3.69000010  1  1  1   0.40546510 
0  15.00000100   2.85999990  1  2  4   1.50407740 
0   4.99999810   4.54000000  0  0  0  -0.69314720 
0   7.99999860   4.61999990  0  0  0  -0.69314720 
0  13.00000000   2.85999990  1  1  0  -0.69314720 
0   1.99999990   3.40000010  0  0  1   0.40546510 
0   6.00000050   2.57999990  1  2  4   1.50407740 
0  19.99999620   4.25000000  1  0  3   1.25276290 
0   6.99999950   1.76000000  1  1  2   0.91629080 
0   6.99999950   2.85999990  1  3  0  -0.69314720 
0  15.99999810   3.69000010  1  2  4   1.50407740 
0  13.00000000   3.40000010  1  0  0  -0.69314720 
0   0.00000000   3.40000010  1  2  0  -0.69314720 
0   0.99999990   4.54000000  1  2  0  -0.69314720 
0  12.00000000   2.86999990  0  0  3   1.25276290 
0   6.99999950   1.76000000  1  0  4   1.50407740 
0   3.99999900   4.25000000  0  0  1   0.40546510 
0   0.00000000   3.92000010  0  0  3   1.25276290 
0   3.99999900   3.35999990  1  0  2   0.91629080 
0   3.99999900   2.31999990  1  0  1   0.40546510 
0  36.99999240   4.54000000  0  0  2   0.91629080 
0  22.99999620   3.35999990  1  1  0  -0.69314720 
0   7.99999860   2.00000000  1  3  2   0.91629080 
0   7.99999860   3.92000010  1  1  1   0.40546510 
0   1.99999990   3.92000010  0  0  1   0.40546510 
0   0.00000000   3.35999990  0  0  1   0.40546510 
0   0.99999990   1.78000000  1  0  1   0.40546510 
0  21.00000000   3.54000000  1  1  1   0.40546510 
0   9.99999900   3.92000010  0  0  2   0.91629080 
0   7.99999860   2.31999990  0  0  3   1.25276290 
0  33.99999240   1.67999990  1  0  1   0.40546510 
0  13.99999710   3.08999990  0  0  2   0.91629080 
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0   6.00000050   2.57999990  1  1  0  -0.69314720 
0  13.99999710   3.40000010  0  0  6   1.87180220 
0  12.00000000   2.86999990  0  0  3   1.25276290 
0  17.99999810   4.61999990  0  0  4   1.50407740 
0   3.00000000   2.96000000  1  3  0  -0.69314720 
0   6.00000050   1.86000000  1  2  2   0.91629080 
0   1.99999990   1.22000000  1  1  0  -0.69314720 
0  10.99999710   2.51000000  1  2  6   1.87180220 
0  10.99999710   2.51000000  1  0  8   2.14006610 
0   4.99999810   3.69000010  1  0  2   0.91629080 
0   7.99999860   2.96000000  1  0  3   1.25276290 
0   3.99999900   1.78000000  1  0  1   0.40546510 
0   0.99999990   1.22000000  1  1  1   0.40546510 
0   7.99999860   2.85999990  1  0  0  -0.69314720 
0  19.00000190   3.69000010  0  0  7   2.01490310 
0   1.99999990   2.11999990  0  0  0  -0.69314720 
0   9.99999900   2.52000000  1  1  2   0.91629080 
0   3.99999900   2.31999990  1  0  1   0.40546510 
0   3.00000000   4.61999990  1  0  2   0.91629080 
0   1.99999990   3.54000000  1  2  4   1.50407740 
0   0.99999990   2.50000000  1  0  0  -0.69314720 
0   4.99999810   1.67999990  0  0  0  -0.69314720 
0   1.99999990   3.40000010  1  1  1   0.40546510 
0   4.99999810   3.92000010  0  0  0  -0.69314720 
0  52.99998090   4.54000000  1  1  5   1.70474800 
0  54.99998860   4.54000000  0  0  2   0.91629080 
0   0.00000000   2.50000000  0  0  0  -0.69314720 
0  10.99999710   4.54000000  1  0  2   0.91629080 
0  25.00000000   3.54000000  0  0  3   1.25276290 
0   4.99999810   1.52000000  1  0  2   0.91629080 
0   1.99999990   3.92000010  1  2  0  -0.69314720 
0   7.99999860   4.61999990  1  0  2   0.91629080 
0   0.00000000   3.92000010  1  0  3   1.25276290 
0   4.99999810   2.31999990  1  2  0  -0.69314720 
0   7.99999860   2.96000000  1  2  2   0.91629080 
0   6.99999950   2.85999990  1  2  1   0.40546510 
0  13.99999710   1.95000000  1  1  3   1.25276290 
0   1.99999990   3.92000010  1  2  1   0.40546510 
0   4.99999810   2.86999990  0  0  1   0.40546510 
0  24.00000190   3.69000010  1  0  3   1.25276290 
0   3.00000000   3.69000010  1  0  0  -0.69314720 
0   3.99999900   2.39000010  0  0  2   0.91629080 
0   3.00000000   1.95000000  1  2  3   1.25276290 
0  10.99999710   3.35999990  0  0  5   1.70474800 
0   3.99999900   2.39000010  1  1  2   0.91629080 
0  26.00000000   3.69000010  0  0  2   0.91629080 
0   3.99999900   2.96000000  1  1  5   1.70474800 
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0   1.99999990   3.21000000  1  0  0  -0.69314720 
0   0.00000000   2.11999990  1  2  0  -0.69314720 
0  52.99998090   4.54000000  1  1  2   0.91629080 
0   3.99999900   2.31999990  1  0  3   1.25276290 
0   6.00000050   2.54000000  1  1  3   1.25276290 
0   1.99999990   2.85999990  1  1  1   0.40546510 
0  13.99999710   3.47000000  1  0  3   1.25276290 
0  15.00000100   2.86999990  0  0  4   1.50407740 
0   3.99999900   2.31999990  1  0  0  -0.69314720 
0  15.00000100   1.86000000  1  2  4   1.50407740 
0   3.99999900   1.95000000  1  0  2   0.91629080 
0   1.99999990   2.31999990  1  2  0  -0.69314720 
0  19.99999620   4.25000000  1  2  1   0.40546510 
0   3.99999900   1.97000000  0  0  6   1.87180220 
0  41.99999620   1.86000000  1  0 19   2.97041440 
0   7.99999860   3.69000010  1  1  0  -0.69314720 
0   3.00000000   4.54000000  1  1  0  -0.69314720 
0   9.00000000   3.54000000  1  0  4   1.50407740 
0   9.99999900   4.54000000  1  1  1   0.40546510 
0   6.99999950   2.85999990  1  2 11   2.44234700 
0  25.00000000   3.35999990  1  0  0  -0.69314720 
0   3.00000000   2.85999990  0  0  0  -0.69314720 
0   3.99999900   2.96000000  1  2  0  -0.69314720 
0  22.00000000   2.55999990  1  2  1   0.40546510 
0   7.99999860   1.63000000  1  0  2   0.91629080 
0  13.99999710   2.96000000  0  0  0  -0.69314720 
0   0.00000000   2.96000000  1  0  1   0.40546510 
0   7.99999860   1.63000000  1  1  1   0.40546510 
0   0.00000000   2.96000000  0  0  0  -0.69314720 
0  21.00000000   2.96000000  1  2  2   0.91629080 
0   6.99999950   2.96000000  1  0  1   0.40546510 
0  30.99998860   4.54000000  1  2  3   1.25276290 
0   1.99999990   4.54000000  1  2  2   0.91629080 
0   9.99999900   2.15000010  0  0  1   0.40546510 
0   6.00000050   4.54000000  1  1  2   0.91629080 
0  12.00000000   2.21000000  1  2  2   0.91629080 
0   0.99999990   2.21000000  1  1  0  -0.69314720 
0  29.00000000   4.54000000  0  0  2   0.91629080 
0   9.99999900   2.21000000  1  1  3   1.25276290 
0   6.00000050   2.21000000  1  0  0  -0.69314720 
0  36.99999240   4.54000000  1  0  3   1.25276290 
0   4.99999810   4.54000000  0  0  4   1.50407740 
1   9.00000000   2.11999990  0  0  0  -0.69314720 
1   1.99999990   2.11999990  1  0  0  -0.69314720 
1   1.99999990   2.11999990  1  0  2   0.91629080 
1   3.00000000   2.11999990  1  0  3   1.25276290 
1   9.00000000   2.11999990  1  1  1   0.40546510 
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1  10.99999710   2.39000010  0  0  3   1.25276290 
1   4.99999810   2.57999990  0  0  2   0.91629080 
1   6.99999950   3.19000010  1  0  4   1.50407740 
1   4.99999810   3.75000000  0  0  0  -0.69314720 
1   3.00000000   3.58999990  0  0  1   0.40546510 
1   1.99999990   2.57999990  0  0  2   0.91629080 
1   0.00000000   3.75000000  0  0  3   1.25276290 
1   4.99999810   3.75000000  1  0  0  -0.69314720 
1   0.99999990   3.75000000  0  0  0  -0.69314720 
1   3.99999900   1.22000000  1  2  2   0.91629080 
1  13.99999710   3.75000000  0  0  0  -0.69314720 
1   6.99999950   3.75000000  1  0  0  -0.69314720 
1  26.00000000   3.75000000  0  0  0  -0.69314720 
1   7.99999860   3.75000000  0  0  2   0.91629080 
1   3.00000000   3.75000000  0  0  4   1.50407740 
1   6.00000050   3.75000000  0  0  0  -0.69314720 
1  21.00000000   3.75000000  0  0  1   0.40546510 
1   7.99999860   3.75000000  1  0  2   0.91629080 
1   3.99999900   3.75000000  0  0  0  -0.69314720 
1   6.99999950   3.75000000  1  1  1   0.40546510 
1   0.00000000   3.75000000  1  0  2   0.91629080 
1   0.00000000   2.54000000  1  1  0  -0.69314720 
1   0.99999990   2.54000000  1  0  0  -0.69314720 
1   3.99999900   2.76000000  0  0  0  -0.69314720 
1   1.99999990   4.13999990  0  0  0  -0.69314720 
1   3.99999900   0.92000000  0  0  1   0.40546510 
1   0.00000000   1.00500000  0  0  0  -0.69314720 
1   6.00000050   3.08999990  0  0  2   0.91629080 
1   3.00000000   3.08999990  1  1  2   0.91629080 
1   0.00000000   1.79000000  0  0  0  -0.69314720 
1   3.00000000   1.40000000  0  0  1   0.40546510 
1   3.00000000   1.40000000  0  0  4   1.50407740 
1   0.00000000   1.40000000  1  0  2   0.91629080 
1   0.00000000   1.40000000  0  0  2   0.91629080 
1  13.99999710   1.40000000  0  0  0  -0.69314720 
1  12.00000000   1.40000000  0  0  1   0.40546510 
1   1.99999990   1.40000000  0  0  1   0.40546510 
1   6.00000050   2.00000000  0  0  1   0.40546510 
1  10.99999710   4.34000020  1  0  2   0.91629080 
1   6.00000050   4.34000020  1  0  4   1.50407740 
1   0.00000000   1.75000000  0  0  0  -0.69314720 
1  36.00000000   2.09999990  1  0  6   1.87180220 
1   7.99999860   2.09999990  0  0  1   0.40546510 
1   1.99999990   2.09999990  0  0  0  -0.69314720 
1  10.99999710   3.58999990  1  0  2   0.91629080 
1  10.99999710   3.58999990  1  2  2   0.91629080 
1  17.99999810   3.58999990  0  0  0  -0.69314720 
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1   3.99999900   3.58999990  0  0  0  -0.69314720 
1  17.99999810   3.58999990  1  0 10   2.35137530 
1   7.99999860   3.58999990  0  0  1   0.40546510 
1  19.00000190   3.41000010  1  0  3   1.25276290 
1   3.99999900   3.41000010  1  0  4   1.50407740 
1   4.99999810   3.41000010  1  2  0  -0.69314720 
1   6.99999950   3.40000010  0  0  1   0.40546510 
1   3.99999900   3.40000010  1  1  2   0.91629080 
1   4.99999810   3.40000010  1  0  4   1.50407740 
1  13.99999710   3.40000010  1  0  1   0.40546510 
1   3.99999900   3.40000010  1  0  0  -0.69314720 
1   3.99999900   2.52000000  0  0  3   1.25276290 
1   0.00000000   2.52000000  0  0  1   0.40546510 
1  15.00000100   3.69000010  1  1  2   0.91629080 
1   0.99999990   3.69000010  1  0  1   0.40546510 
1   3.00000000   3.69000010  1  1  0  -0.69314720 
1  17.99999810   3.69000010  0  0  1   0.40546510 
1  15.00000100   2.86999990  0  0  0  -0.69314720 
1   4.99999810   2.86999990  1  0  1   0.40546510 
1  17.99999810   2.86999990  1  0  1   0.40546510 
1   9.00000000   2.86999990  0  0  2   0.91629080 
1   6.00000050   2.86999990  0  0  4   1.50407740 
1  15.00000100   2.86999990  1  0  1   0.40546510 
1   3.99999900   3.35999990  0  0  2   0.91629080 
1   1.99999990   3.35999990  1  2  0  -0.69314720 
1   3.00000000   3.35999990  0  0  2   0.91629080 
1   6.99999950   3.35999990  0  0  0  -0.69314720 
1  15.99999810   4.54000000  1  0  4   1.50407740 
1  48.00000000   4.54000000  1  2  2   0.91629080 
1  15.00000100   4.54000000  1  0  5   1.70474800 
1  36.99999240   4.54000000  0  0  1   0.40546510 
1   9.99999900   4.54000000  1  0  2   0.91629080 
1  13.00000000   4.54000000  0  0  2   0.91629080 
1   6.00000050   4.54000000  1  2  0  -0.69314720 
1  13.00000000   0.75500000  0  0  0  -0.69314720 
1   6.99999950   4.54000000  1  1  2   0.91629080 
1   9.00000000   4.54000000  1  0  2   0.91629080 
1   4.99999810   4.54000000  0  0  2   0.91629080 
1  15.00000100   4.54000000  0  0  6   1.87180220 
1   3.00000000   4.54000000  0  0  3   1.25276290 
1  13.99999710   4.54000000  0  0  0  -0.69314720 
1   1.99999990   1.28000000  1  0  1   0.40546510 
1   3.99999900   1.28000000  1  0  4   1.50407740 
1   3.99999900   1.28000000  1  0  0  -0.69314720 
1   0.00000000   2.50000000  1  1  0  -0.69314720 
1  47.00000760   3.84999990  1  2  2   0.91629080 
1  29.00000000   3.84999990  1  0  1   0.40546510 

274 Appendix 1 / Input Data Sets for Task Examples



1   0.99999990   3.84999990  1  1  5   1.70474800 
1  17.99999810   3.84999990  0  0  1   0.40546510 
1  13.00000000   2.05000000  0  0  1   0.40546510 
1  17.00000000   2.05000000  0  0  1   0.40546510 
1   1.99999990   2.05000000  0  0  2   0.91629080 
1   3.99999900   1.78000000  1  0  4   1.50407740 
1   0.99999990   1.17999990  1  0  1   0.40546510 
1   3.00000000   1.52000000  1  0  0  -0.69314720 
1   9.00000000   1.48000000  1  0  2   0.91629080 
1  12.00000000   4.29000000  0  0  0  -0.69314720 
1  17.00000000   4.29000000  0  0  1   0.40546510 
1   4.99999810   4.29000000  0  0  3   1.25276290 
1   1.99999990   3.08999990  1  0  2   0.91629080 
1   0.00000000   3.08999990  0  0  2   0.91629080 
1   3.00000000   3.61999990  0  0  5   1.70474800 
1   6.99999950   3.61999990  0  0  0  -0.69314720 
1   7.99999860   3.61999990  0  0  0  -0.69314720 
1   0.00000000   4.29000000  0  0  0  -0.69314720 
1   6.00000050   2.60999990  1  1  1   0.40546510 
1   6.99999950   2.60999990  1  0  1   0.40546510 
1   9.00000000   2.09999990  0  0  0  -0.69314720 
1   7.99999860   2.96000000  1  0  2   0.91629080 
1   9.99999900   2.39000010  0  0  0  -0.69314720 
1   3.00000000   1.95000000  1  0  1   0.40546510 
1  13.99999710   3.41000010  0  0  2   0.91629080 
1   0.99999990   4.29000000  0  0  2   0.91629080 
1  10.99999710   3.58999990  0  0  2   0.91629080 
1   9.99999900   4.61999990  0  0  1   0.40546510 
1   6.00000050   2.14000010  0  0  1   0.40546510 
1  10.99999710   2.85999990  0  0  0  -0.69314720 
1   4.99999810   3.47000000  0  0  2   0.91629080 
1  13.99999710   4.61999990  1  1  3   1.25276290 
1   9.00000000   3.19000010  1  3  1   0.40546510 
1   0.99999990   2.51000000  0  0  1   0.40546510 
1   0.00000000   2.11999990  0  0  0  -0.69314720 
1   3.00000000   3.19000010  0  0  0  -0.69314720 
1   3.99999900   1.74000000  1  1  2   0.91629080 
1   0.00000000   1.25000000  1  0  0  -0.69314720 
1   6.99999950   3.69000010  1  0  0  -0.69314720 
1   4.99999810   3.21000000  0  0  0  -0.69314720 
1  15.00000100   4.61999990  1  1  0  -0.69314720 
1  24.00000190   2.85999990  1  0  5   1.70474800 
1   9.00000000   2.39000010  1  1  1   0.40546510 
1   0.00000000   1.17999990  1  0  3   1.25276290 
1   6.99999950   3.35999990  0  0  2   0.91629080 
1   7.99999860   1.97000000  0  0  2   0.91629080 
1  22.00000000   1.64000000  1  0  1   0.40546510 
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1   6.99999950   3.92000010  1  0  2   0.91629080 
1   6.00000050   3.31999990  0  0  6   1.87180220 
1   6.00000050   2.57999990  0  0  5   1.70474800 
1  22.99999620   4.54000000  0  0  2   0.91629080 
1   1.99999990   2.39000010  1  0  0  -0.69314720 
1   9.00000000   3.58999990  0  0  4   1.50407740 
1   6.99999950   3.69000010  0  0  2   0.91629080 
1   9.99999900   3.19000010  0  0  2   0.91629080 
1   3.99999900   2.31999990  0  0  2   0.91629080 
1  10.99999710   3.47000000  1  1  2   0.91629080 
1   3.99999900   3.69000010  0  0  2   0.91629080 
1   4.99999810   2.31999990  1  1  3   1.25276290 
1  10.99999710   3.19000010  0  0  1   0.40546510 
1  19.00000190   4.54000000  0  0  1   0.40546510 
1   3.00000000   3.35999990  1  1  0  -0.69314720 
1   4.99999810   2.57999990  1  0  2   0.91629080 
1   6.99999950   3.21000000  1  1  2   0.91629080 
1   3.00000000   1.40000000  0  0  1   0.40546510 
1   9.99999900   2.50000000  0  0  4   1.50407740 
1   0.00000000   3.19000010  1  2  0  -0.69314720 
1   3.00000000   3.35999990  0  0  0  -0.69314720 
1   9.00000000   3.15000010  0  0  6   1.87180220 
1   6.99999950   1.45000000  1  0  2   0.91629080 
1   6.99999950   2.85999990  1  2  1   0.40546510 
1  48.99999240   4.61999990  1  1  3   1.25276290 
1   1.99999990   3.69000010  1  0  0  -0.69314720 
1  19.00000190   2.96000000  1  0  1   0.40546510 
1  12.00000000   3.08999990  1  1  1   0.40546510 
1   0.99999990   3.08999990  0  0  0  -0.69314720 
1  12.00000000   4.61999990  0  0  2   0.91629080 
1  13.00000000   2.85999990  1  0  0  -0.69314720 
1   1.99999990   3.21000000  0  0  0  -0.69314720 
1   3.00000000   2.82999990  1  0  2   0.91629080 
1  22.00000000   4.29000000  0  0  1   0.40546510 
1  35.00000760   4.29000000  0  0  0  -0.69314720 
1   0.99999990   3.08999990  1  0  2   0.91629080 
1   3.99999900   3.69000010  0  0  0  -0.69314720 
1   0.99999990   1.79000000  1  0  0  -0.69314720 
1   1.99999990   3.35999990  1  1  0  -0.69314720 
1  13.99999710   2.57999990  1  0  4   1.50407740 
1  24.00000190   3.75000000  0  0  1   0.40546510 
1   4.99999810   3.19000010  0  0  2   0.91629080 
1   0.99999990   2.09999990  0  0  0  -0.69314720 
1   7.99999860   3.58999990  1  1  0  -0.69314720 
1   0.99999990   3.92000010  0  0  0  -0.69314720 
1  24.00000190   3.31999990  1  1  1   0.40546510 
1   1.99999990   2.00000000  0  0  0  -0.69314720 
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1   1.99999990   3.47000000  1  0  0  -0.69314720 
1  13.99999710   3.21000000  1  0  4   1.50407740 
1   4.99999810   2.05000000  0  0  3   1.25276290 
1   0.99999990   2.52000000  0  0  0  -0.69314720 
1   6.99999950   3.15000010  1  0  0  -0.69314720 
1  38.00000380   1.86000000  1  2  6   1.87180220 
1   3.00000000   2.85999990  0  0  2   0.91629080 
1   3.99999900   4.29000000  1  1  4   1.50407740 
1   0.00000000   1.25500000  1  2  0  -0.69314720 
1  19.00000190   3.21000000  1  0  5   1.70474800 
1   4.99999810   2.31999990  1  1  1   0.40546510 
1   3.00000000   3.19000010  0  0  4   1.50407740 
1   1.99999990   3.19000010  1  0  1   0.40546510 
1  10.99999710   3.35999990  1  0  3   1.25276290 
1  13.99999710   3.54000000  1  1  1   0.40546510 
1   6.00000050   1.86000000  1  0  0  -0.69314720 
1  13.00000000   1.50500000  0  0  0  -0.69314720 
1   6.99999950   2.39000010  1  0  1   0.40546510 
1  10.99999710   4.29000000  1  1  2   0.91629080 
1   9.00000000   2.00000000  1  1  0  -0.69314720 
1   3.99999900   3.92000010  0  0  1   0.40546510 
1   6.00000050   4.29000000  1  0  2   0.91629080 
1   6.00000050   3.35999990  0  0  1   0.40546510 
1  13.99999710   4.61999990  1  0  3   1.25276290 
1   6.00000050   2.00000000  0  0  1   0.40546510 
1   4.99999810   3.58999990  1  0  2   0.91629080 
1   6.00000050   2.86999990  0  0  1   0.40546510 
1   3.99999900   2.96000000  0  0  0  -0.69314720 
1  10.99999710   3.47000000  1  0  0  -0.69314720 
1   7.99999860   3.19000010  1  0  4   1.50407740 
1   3.00000000   2.85999990  1  1  0  -0.69314720 
1  15.99999810   2.52000000  1  0  2   0.91629080 
1   6.00000050   4.29000000  0  0  1   0.40546510 
1   0.00000000   1.25500000  0  0  1   0.40546510 
1   1.99999990   1.83000000  1  0  0  -0.69314720 
1  12.00000000   4.29000000  0  0  3   1.25276290 
1   7.99999860   2.96000000  1  0  0  -0.69314720 
1   0.99999990   2.31999990  1  0  1   0.40546510 
1  10.99999710   1.22000000  1  1  0  -0.69314720 
1  10.99999710   4.29000000  1  0  1   0.40546510 
1   1.99999990   4.25000000  0  0  1   0.40546510 
1  36.00000000   2.55000000  0  0  2   0.91629080 
1  10.99999710   1.95000000  1  0  1   0.40546510 
1   1.99999990   3.69000010  0  0  0  -0.69314720 
1  25.00000000   4.29000000  0  0  1   0.40546510 
1   4.99999810   3.19000010  1  0  2   0.91629080 
1  12.00000000   3.54000000  1  1  4   1.50407740 
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1   4.99999810   3.54000000  1  0  4   1.50407740 
1   7.99999860   3.54000000  1  1  0  -0.69314720 
1   0.99999990   1.86000000  1  1  3   1.25276290 
1   3.00000000   4.61999990  0  0  4   1.50407740 
1  15.99999810   4.61999990  1  0  1   0.40546510 
1   9.99999900   4.61999990  1  0  3   1.25276290 
1  13.00000000   4.54000000  1  0  1   0.40546510 
1   0.99999990   3.47000000  1  0  0  -0.69314720 
1  15.99999810   2.85999990  0  0  0  -0.69314720 
1   6.99999950   2.00000000  1  0  0  -0.69314720 
1   1.99999990   2.00000000  0  0  0  -0.69314720 
1   3.00000000   2.60999990  1  0  0  -0.69314720 
1   6.00000050   2.05000000  0  0  0  -0.69314720 
1   6.00000050   2.05000000  0  0  0  -0.69314720 
1   4.99999810   3.54000000  0  0  0  -0.69314720 
1   0.00000000   0.92000000  1  0  2   0.91629080 
1   0.00000000   1.79000000  1  0  0  -0.69314720 
1   6.00000050   2.00000000  1  0  0  -0.69314720 
1   7.99999860   3.15000010  0  0  4   1.50407740 
1  15.99999810   2.26000000  1  0  5   1.70474800 
1   3.99999900   2.26000000  0  0  1   0.40546510 
1   0.99999990   4.29000000  1  0  6   1.87180220 
1  21.00000000   4.29000000  1  0  1   0.40546510 
1   9.00000000   4.54000000  0  0  1   0.40546510 
1   3.00000000   3.35999990  1  1  0  -0.69314720 
1   1.99999990   2.52000000  0  0  0  -0.69314720 
1   9.99999900   4.29000000  0  0  3   1.25276290 
1   9.00000000   4.29000000  0  0  0  -0.69314720 
1  12.00000000   4.54000000  0  0  2   0.91629080 
1   0.00000000   2.50000000  0  0  0  -0.69314720 
1   1.99999990   2.76000000  0  0  1   0.40546510 
1   0.00000000   2.55000000  1  1  0  -0.69314720 
1   0.00000000   4.61999990  1  0  0  -0.69314720 
1   6.00000050   1.63000000  0  0  2   0.91629080 
1   3.00000000   3.47000000  1  0  1   0.40546510 
1  30.99998860   3.41000010  1  0  2   0.91629080 
1   0.99999990   4.29000000  0  0  0  -0.69314720 
1   6.99999950   2.96000000  1  0  0  -0.69314720 
1   0.00000000   4.61999990  1  0  5   1.70474800 
1  12.00000000   3.58999990  1  0  0  -0.69314720 
1  12.00000000   3.69000010  1  0  3   1.25276290 
1   1.99999990   4.54000000  1  0  1   0.40546510 
1  10.99999710   3.33999990  0  0  4   1.50407740 
1   1.99999990   2.51000000  1  1  4   1.50407740 
1   3.99999900   3.15000010  1  0  3   1.25276290 
1   3.00000000   3.19000010  1  0  1   0.40546510 
1  17.99999810   3.19000010  0  0  1   0.40546510 
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1   1.99999990   3.84999990  0  0  1   0.40546510 
1   3.99999900   3.33999990  1  1  2   0.91629080 
1  15.00000100   4.29000000  0  0  2   0.91629080 
1   3.99999900   4.29000000  0  0  2   0.91629080 
1  21.00000000   4.29000000  0  0  2   0.91629080 
1   3.99999900   4.29000000  1  1  0  -0.69314720 
1   0.00000000   2.96000000  1  0  0  -0.69314720 
1   0.99999990   1.78000000  1  0  0  -0.69314720 
1  17.00000000   3.54000000  1  2  1   0.40546510 
1   3.00000000   3.69000010  1  0  0  -0.69314720 
1   1.99999990   3.35999990  0  0  3   1.25276290 
1   1.99999990   3.54000000  1  0  0  -0.69314720 
1   0.99999990   3.54000000  1  1  0  -0.69314720 
1   3.00000000   1.22000000  1  1  3   1.25276290 
1   3.99999900   3.35999990  0  0  1   0.40546510 
1   1.99999990   2.21000000  0  0  1   0.40546510 
1   3.99999900   2.25000000  0  0  1   0.40546510 
1  17.00000000   4.61999990  1  1  2   0.91629080 
1   4.99999810   3.58999990  1  0  1   0.40546510 
1   0.99999990   4.29000000  1  0  0  -0.69314720 
1   1.99999990   2.11999990  0  0  2   0.91629080 
1   3.00000000   2.26000000  0  0  2   0.91629080 
1   3.00000000   2.26000000  1  0  4   1.50407740 
1   4.99999810   4.29000000  0  0  0  -0.69314720 
1   3.00000000   3.58999990  1  1  3   1.25276290 
1  13.00000000   4.29000000  1  2  1   0.40546510 
1   1.99999990   2.00000000  0  0  1   0.40546510 
1   0.00000000   1.97000000  1  2  0  -0.69314720 
1   7.99999860   3.92000010  1  0  0  -0.69314720 
1  39.00000000   2.85999990  0  0  4   1.50407740 
1  26.00000000   2.82999990  0  0  2   0.91629080 
1   3.00000000   3.35999990  1  1  3   1.25276290 
1  22.99999620   2.55999990  0  0  4   1.50407740 
1   7.99999860   1.63000000  0  0  1   0.40546510 
1  22.00000000   4.61999990  0  0  3   1.25276290 
1   4.99999810   4.61999990  0  0  1   0.40546510 
1  21.00000000   4.29000000  1  0  3   1.25276290 
1   6.00000050   4.29000000  1  1  0  -0.69314720 
1   3.99999900   4.29000000  1  1  2   0.91629080 
1  24.00000190   4.29000000  1  0  6   1.87180220 
1   6.00000050   4.29000000  1  0  1   0.40546510 
1  33.99999240   3.35999990  0  0  1   0.40546510 
1   0.00000000   3.21000000  0  0  2   0.91629080 
1   9.99999900   2.00000000  0  0  1   0.40546510 
1   1.99999990   3.21000000  1  2  2   0.91629080 
1   3.00000000   2.57999990  1  2  2   0.91629080 
1   3.00000000   2.57999990  1  0  0  -0.69314720 
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1   0.99999990   2.82999990  0  0  0  -0.69314720 
1   6.00000050   3.19000010  0  0  1   0.40546510 
1   3.00000000   3.47000000  0  0  1   0.40546510 
1  22.99999620   4.61999990  1  0  2   0.91629080 
1  13.00000000   4.25000000  1  0  4   1.50407740 
1   4.99999810   1.86000000  1  0  2   0.91629080 
1   9.00000000   4.29000000  1  1  0  -0.69314720 
1   9.00000000   3.35999990  0  0  0  -0.69314720 
1   9.99999900   1.80000000  1  0  2   0.91629080 
1   0.00000000   1.65500000  0  0  1   0.40546510 
1   6.00000050   2.85999990  0  0  0  -0.69314720 
1  13.99999710   4.61999990  0  0  2   0.91629080 
1   3.00000000   4.29000000  0  0  0  -0.69314720 
1   4.99999810   2.35999990  1  0  4   1.50407740 
1  10.99999710   1.80999990  1  0  1   0.40546510 
1  32.00001140   3.58999990  1  0  1   0.40546510 
1   9.99999900   1.76000000  0  0  0  -0.69314720 
1   4.99999810   2.00000000  1  0  1   0.40546510 
1  13.99999710   3.58999990  0  0  5   1.70474800 
1   6.00000050   2.26000000  1  0  3   1.25276290 
1   3.99999900   2.26000000  0  0  1   0.40546510 
1   3.99999900   1.76000000  1  1  1   0.40546510 
1   0.99999990   3.58999990  1  0  1   0.40546510 
1   0.99999990   3.58999990  1  0  0  -0.69314720 
1   4.99999810   2.82999990  1  1  1   0.40546510 
1   1.99999990   2.57999990  0  0  1   0.40546510 
1  17.99999810   4.61999990  1  0  1   0.40546510 
1  15.00000100   2.31999990  0  0  1   0.40546510 
1   0.00000000   2.39000010  1  0  0  -0.69314720 
1  22.00000000   2.96000000  1  0  3   1.25276290 
1  10.99999710   2.11999990  0  0  0  -0.69314720 
1  17.99999810   4.61999990  1  0  1   0.40546510 
1   3.00000000   2.25000000  1  0  1   0.40546510 
1   7.99999860   1.76000000  1  0  1   0.40546510 
1  12.00000000   4.54000000  0  0  6   1.87180220 
1   9.99999900   3.69000010  1  1  2   0.91629080 
1   1.99999990   1.25000000  0  0  0  -0.69314720 
1   4.99999810   1.25000000  1  0  1   0.40546510 
1   3.99999900   3.19000010  1  0  0  -0.69314720 
1   0.00000000   2.57999990  1  2  0  -0.69314720 
1   6.99999950   2.00000000  1  1  2   0.91629080 
1   0.99999990   2.76000000  0  0  0  -0.69314720 
1   3.99999900   2.54000000  0  0  2   0.91629080 
1   0.00000000   3.19000010  0  0  0  -0.69314720 
1   9.00000000   3.08999990  1  2  1   0.40546510 
1   3.99999900   3.19000010  0  0  2   0.91629080 
1   0.00000000   3.08999990  0  0  0  -0.69314720 
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1   7.99999860   2.26000000  0  0  2   0.91629080 
1   9.00000000   2.26000000  1  1  1   0.40546510 
1   7.99999860   3.35999990  1  0  2   0.91629080 
1   9.00000000   3.15000010  1  0  1   0.40546510 
1   3.99999900   4.54000000  1  0  0  -0.69314720 
1   0.00000000   3.58999990  1  0  2   0.91629080 
1   3.00000000   3.47000000  1  0  1   0.40546510 
1   1.99999990   2.85999990  1  1  1   0.40546510 
1   6.00000050   2.26000000  1  0  0  -0.69314720 
1   3.99999900   3.47000000  1  1  2   0.91629080 
1   0.00000000   2.76000000  1  0  0  -0.69314720 
1   1.99999990   3.58999990  1  2  0  -0.69314720 
1  13.00000000   3.75000000  0  0  5   1.70474800 
1   1.99999990   2.57999990  1  2  1   0.40546510 
1   1.99999990   3.58999990  1  1  2   0.91629080 
1  15.99999810   1.89000000  1  2  3   1.25276290 
1   9.00000000   3.15000010  0  0  7   2.01490310 
1  12.00000000   2.86999990  0  0  5   1.70474800 
1   0.99999990   2.11999990  1  2  0  -0.69314720 
1   3.99999900   4.61999990  1  0  1   0.40546510 
1   0.00000000   2.39000010  0  0  0  -0.69314720 
1  10.99999710   2.11999990  0  0  0  -0.69314720 
1   4.99999810   1.80999990  1  0  0  -0.69314720 
1   7.99999860   2.31999990  0  0  4   1.50407740 
1  15.00000100   2.39000010  0  0  0  -0.69314720 
1   6.00000050   3.75000000  1  0  3   1.25276290 
1   0.00000000   2.00000000  0  0  0  -0.69314720 
1  13.99999710   3.58999990  1  1  0  -0.69314720 
1   4.99999810   4.29000000  0  0  2   0.91629080 
1   0.00000000   2.57999990  1  0  0  -0.69314720 
1   4.99999810   4.61999990  1  0  0  -0.69314720 
1   3.00000000   1.50500000  0  0  0  -0.69314720 
1   3.99999900   3.75000000  1  0  2   0.91629080 
1   3.99999900   3.75000000  1  2  0  -0.69314720 
1   0.00000000   1.75000000  1  0  1   0.40546510 
1   0.00000000   2.11999990  1  0  1   0.40546510 
1   4.99999810   3.75000000  0  0  2   0.91629080 
1   0.00000000   0.75500000  0  0  0  -0.69314720 
1   6.99999950   2.25000000  0  0  1   0.40546510 
1   3.00000000   3.19000010  0  0  1   0.40546510 
; 
 

The output data set (LONG97DATA) is saved in your Work library.
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MROZ Data Set

To create the Mroz data set, enter this code into a Program tab:

data mroz; 
   input inlf nwifeinc educ exper expersq age kidslt6 kidsge6 lwage; 
datalines; 
1 10.91006    12 14  196   32  1   0   1.210154 
1 19.49998    12 5   25    30  0   2   0.3285121 
1 12.03991    12 15  225   35  1   3   1.514138 
1 6.799996    12 6   36    34  0   3   0.0921233 
1 20.10006    14 7   49    31  1   2   1.524272 
1 9.859054    12 33  1089  54  0   0   1.55648 
1 9.152048    16 11  121   37  0   2   2.12026 
1 10.90004    12 35  1225  54  0   0   2.059634 
1 17.305      12 24  576   48  0   2   0.7543364 
1 12.925      12 21  441   39  0   2   1.544899 
1 24.29995    12 15  225   33  0   1   1.401922 
1 19.70007    11 14  196   42  0   1   1.524272 
1 15.00001    12 0   0     30  1   2   0.7339532 
1 14.6        12 14  196   43  0   2   0.8183691 
1 24.63091    10 6   36    43  0   1   1.302831 
1 17.53103    11 9   81    35  0   3   0.2980284 
1 14.09998    12 20  400   43  0   2   1.16761 
1 15.839      12 6   36    39  0   5   1.643839 
1 14.1        12 23  529   45  0   0   0.6931472 
1 10.29996    12 9   81    35  0   4   2.021932 
1 22.65498    16 5   25    42  0   2   1.254248 
1 8.090048    12 11  121   30  0   0   1.272958 
1 17.479      13 18  324   48  0   0   1.178655 
1 9.56        12 15  225   45  0   0   1.178655 
1 8.274953    12 4   16    31  1   1   0.7675587 
1 27.34999    17 21  441   43  0   2   1.331812 
1 16          12 31  961   59  0   0   1.386294 
1 16.99998    12 9   81    32  0   3   1.55327 
1 15.10006    17 7   49    31  1   0   1.981815 
1 15.69998    12 7   49    42  0   0   1.76936 
1 5.11896     11 32  1024  50  0   0   0.4308079 
1 16.75001    16 11  121   59  0   0   0.8997548 
1 13.59993    13 16  256   36  0   2   1.76663 
1 17.10005    12 14  196   51  0   1   1.272958 
1 16.73405    16 27  729   45  0   3   1.336789 
1 14.19698    11 0   0     42  0   1   0.9017048 
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1 10.31999    12 17  289   46  0   0   0.8651237 
1 11.3841     10 28  784   46  0   1   1.511847 
1 14.59408    14 24  576   51  0   0   1.726029 
1 17.50044    17 11  121   30  0   0   2.683142 
1 15.51       12 1   1     30  1   2   0.9852943 
1 21.99998    12 14  196   57  0   0   1.365939 
1 22.5        16 6   36    31  1   2   0.9450337 
1 19.994      12 10  100   48  0   2   1.512376 
1 14.13       12 6   36    30  0   3   0.6931472 
1 5.000013    12 4   16    34  0   2   1.244788 
1 21.1549     16 10  100   48  0   2   0.7011649 
1 7.141946    12 22  484   45  0   0   1.519863 
1 16.65007    12 16  256   51  0   0   0.8209686 
1 6.352       12 6   36    30  0   2   0.9698315 
1 27.31395    12 12  144   46  0   1   0.8285082 
1 14.5        12 32  1024  58  0   0   0.0943096 
1 16.25799    12 15  225   37  0   8   0.1625439 
1 9.5         8  17  289   52  0   0   0.4700036 
1 7.999956    10 34  1156  52  0   0   0.6292484 
1 12.50003    16 9   81    31  0   0   1.39716 
1 14.00003    14 37  1369  55  0   0   2.265444 
1 20.80007    17 10  100   34  0   0   2.084541 
1 19.38511    14 35  1225  55  0   0   1.525839 
1 12.38699    12 6   36    39  0   2   0.7621601 
1 28.5        14 19  361   40  0   3   1.481605 
1 15.04991    12 10  100   43  0   4   1.262826 
1 10.49998    8  11  121   48  0   0   0.9996756 
1 11.81       12 15  225   47  0   0   1.832582 
1 6.950073    12 12  144   41  0   4   2.479308 
1 12.41997    8  12  144   36  0   0   1.279015 
1 17.4        17 14  196   46  0   2   1.937936 
1 15.5        12 11  121   34  0   0   1.070453 
1 21.21704    12 9   81    41  0   3   1.123923 
1 18          12 24  576   51  0   1   1.321756 
1 11.89992    12 12  144   33  0   0   1.745 
1 26.75196    12 13  169   52  0   0   1.301744 
1 12.14996    9  29  841   58  0   0   1.641866 
1 10.19999    10 11  121   34  2   4   2.10702 
1 8.120015    12 13  169   31  0   1   1.467068 
1 10.65996    12 19  361   48  0   1   1.605811 
1 18.10001    12 2   4     32  0   2   -1.029739 
1 8.599986    17 24  576   49  0   0   1.087686 
1 13.665      15 9   81    32  2   2   0 
1 32.34996    12 6   36    58  0   0   0.9382087 
1 12.08501    6  22  484   50  0   0   -0.1505904 
1 12.15       14 30  900   60  0   0   0 
1 17.69502    12 10  100   50  0   1   1.073671 
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1 24.7        14 6   36    56  0   0   1.265848 
1 2.133992    9  29  841   51  0   0   0.486369 
1 20.95005    17 29  841   54  0   1   2.12026 
1 10.50008    13 36  1296  59  0   0   1.129853 
1 10.55       9  19  361   46  0   2   0.9932518 
1 45.75       15 8   64    46  0   1   1.658628 
1 13.63204    12 13  169   39  1   3   0.3474122 
1 18.23894    12 16  256   44  0   2   1.568324 
1 17.09       12 11  121   33  2   0   0.5108456 
1 30.2349     12 15  225   33  1   2   0.1148454 
1 28.7        12 6   36    48  0   2   -0.6931472 
1 19.63       12 13  169   31  0   4   -0.3364523 
1 12.82494    12 22  484   45  0   1   1.028226 
1 23.8        12 24  576   45  0   1   1.580689 
1 26.30003    13 2   4     32  0   2   0.5558946 
1 20.69991    12 6   36    47  0   0   0.9014207 
1 26          13 2   4     34  0   2   0.8843046 
1 10.87702    12 2   4     37  0   1   0.4282046 
1 25.61206    12 14  196   36  0   1   1.058415 
1 20.98899    12 9   81    47  1   2   0.8783396 
1 70.74993    16 11  121   48  0   1   1.654908 
1 17.05       12 9   81    42  0   2   1.321756 
1 21          13 6   36    33  0   3   0.3285121 
1 8.12        11 19  361   46  0   0   1.386294 
1 20.88599    12 26  676   47  0   3   1.172885 
1 17.66892    12 19  361   44  0   1   1.224187 
1 25.20003    12 3   9     36  0   4   0.2876571 
1 14.24501    17 7   49    31  2   0   2.230262 
1 14.3        14 28  784   55  0   0   1.504077 
1 23.70001    16 13  169   45  0   1   1.531152 
1 46          17 9   81    47  0   0   1.375158 
1 42.9999     12 15  225   46  0   3   1.760269 
1 14.749      11 20  400   49  0   0   -0.6931472 
1 16.15005    12 29  841   49  0   0   1.406489 
1 17.774      12 9   81    45  0   2   1.791759 
1 91          17 1   1     38  1   3   1.299292 
1 22.29993    10 8   64    47  0   0   1.351004 
1 34.60001    13 19  361   54  0   3   1.016281 
1 9.620002    11 23  529   41  0   0   1.075344 
1 10.89995    12 3   9     43  0   2   1.478965 
1 14.49994    16 13  169   31  1   1   1.689487 
1 22.00002    17 8   64    47  0   0   2.288598 
1 17.90008    12 17  289   35  0   2   -1.822631 
1 23.67506    16 4   16    45  0   3   -0.9607652 
1 11.79996    12 15  225   33  1   0   1.290994 
1 16.14195    16 11  121   54  0   1   0.8648711 
1 18.39997    8  7   49    35  0   4   1.540452 
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1 15.49995    12 0   0     31  1   2   0.6162121 
1 17.324      12 0   0     55  0   0   1.648659 
1 19.205      12 10  100   34  0   2   1.193498 
1 21.30006    13 8   64    38  0   1   2.143976 
1 23.56       11 2   4     45  0   1   0.7244036 
1 20.85       12 4   16    47  0   1   0.9416075 
1 26.15       12 6   36    39  0   2   0.7827594 
1 17          14 18  324   36  1   0   1.832582 
1 20.72       12 3   9     33  1   2   1.203963 
1 17.00009    12 22  484   50  0   0   1.491645 
1 16          12 33  1089  58  0   0   1.892133 
1 19.50005    17 28  784   49  0   0   2.130895 
1 12          14 23  529   41  0   2   1.480604 
1 13.73191    12 27  729   51  0   1   0.8943313 
1 27.19999    9  11  121   53  0   0   0.2025325 
1 5.315       12 6   36    36  1   2   0.4855078 
1 16          12 11  121   46  0   2   1.098612 
1 27.87198    12 14  196   36  0   2   1.55327 
1 40.00001    14 17  289   53  0   1   0.121598 
1 15.90003    16 17  289   40  0   3   2.001804 
1 27.49997    17 14  196   42  0   2   1.495037 
1 17.02005    15 11  121   33  1   1   0.9052298 
1 22.39494    12 7   49    43  0   3   0.6325476 
1 11.1        16 8   64    31  1   0   1.386294 
1 32.70001    17 6   36    47  0   0   2.102914 
1 27.79996    17 8   64    54  0   0   1.959644 
1 2.199994    12 4   16    33  1   3   0.5108456 
1 19.72095    16 25  625   43  0   0   1.236924 
1 9.999988    13 24  576   46  0   1   1.443313 
1 13.19997    12 11  121   35  0   3   1.021659 
1 12.70897    11 19  361   37  0   3   0.6361535 
1 27.30005    16 9   81    37  0   2   1.616453 
1 21.2        14 19  361   34  0   3   0.2231435 
1 14.4        16 14  196   43  1   0   1.049807 
1 20.57596    12 22  484   46  0   0   1.415052 
1 12.49999    9  6   36    35  0   3   0.5753766 
1 17.50022    17 23  529   46  0   0   2.606682 
1 44.00004    14 15  225   46  0   0   1.517915 
1 13.11895    12 6   36    43  0   2   0.7550416 
1 14.00006    12 11  121   30  0   0   1.094972 
1 9.645086    11 2   4     41  0   2   0.9421144 
1 17.39705    12 22  484   54  0   1   1.724943 
1 7.799889    12 10  100   31  0   1   1.031546 
1 13.13398    10 14  196   44  0   0   0.4743691 
1 25.6        12 12  144   32  0   1   0.8109302 
1 13.90003    5  9   81    47  0   0   0.7092666 
1 19.29794    17 13  169   46  0   1   1.710549 
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1 9.200016    11 18  324   37  0   0   0.4602689 
1 37.99999    12 8   64    51  0   2   1.331812 
1 44          12 11  121   49  0   1   1.098612 
1 21.37202    14 9   81    36  0   4   2.157999 
1 23.66802    11 9   81    39  0   1   1.437581 
1 9           12 14  196   48  0   2   1.544899 
1 25.19995    14 9   81    38  0   2   1.410597 
1 21.22       12 2   4     40  0   2   3.218876 
1 33.96991    10 12  144   39  1   5   0.9681619 
1 17.07       16 15  225   37  0   0   1.791759 
1 6.016024    13 11  121   49  0   1   1.68873 
1 17.10001    12 7   49    33  0   3   -0.409172 
1 8.237       12 9   81    30  0   0   0.2231435 
1 13.30008    12 19  361   54  0   0   0.8221558 
1 16.00002    11 11  121   39  0   4   1.241702 
1 12.53999    12 8   64    43  0   3   1.427124 
1 18.00004    9  13  169   31  0   3   1.497097 
1 31.2        13 4   16    33  0   3   0.5596158 
1 20.74991    12 7   49    40  0   3   1.300028 
1 11.09992    12 19  361   36  0   1   1.88443 
1 20.68       12 14  196   51  0   0   0.9555114 
1 18.00001    13 14  196   44  0   1   1.582087 
1 32.43007    16 3   9     42  0   3   1.755614 
1 32.90003    12 9   81    40  0   1   1.513103 
1 24.10001    16 7   49    34  1   1   2.251892 
1 17.80039    17 7   49    30  0   0   2.364432 
1 20.50002    12 14  196   54  0   0   0.1053505 
1 10.4999     12 29  841   51  0   0   1.399729 
1 10.43703    9  19  361   44  0   2   0.9884625 
1 18.19499    12 14  196   43  0   1   1.090647 
1 12.84508    12 16  256   34  0   1   1.154614 
1 13.8        13 10  100   45  0   0   1.266948 
1 22.2        12 12  144   39  0   0   2.885192 
1 6.699941    12 24  576   50  0   0   1.22888 
1 6.250016    12 6   36    52  0   0   1.203963 
1 15.60001    12 9   81    41  0   2   1.35738 
1 3.30001     10 14  196   59  0   0   0.8377236 
1 3.670978    12 26  676   52  0   0   0.5369611 
1 7.789997    16 7   49    46  0   0   0.7487238 
1 18.27199    12 4   16    41  1   5   2.295873 
1 10.95398    11 15  225   33  0   2   1.107803 
1 13.49999    12 23  529   45  0   0   0.6208453 
1 11.20001    10 1   1     36  1   2   -2.054164 
1 20.99991    12 29  841   48  0   1   1.892012 
1 25.7        12 9   81    47  0   1   1.729725 
1 8.932994    12 6   36    45  0   0   0.4693784 
1 19.15998    12 11  121   37  0   2   0.9808417 
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1 26.58999    16 17  289   46  0   4   2.069492 
1 22.40001    17 6   36    43  0   3   1.675188 
1 20.633      12 7   49    42  0   2   1.386294 
1 28.20001    17 2   4     34  1   2   1.799215 
1 28.8        12 24  576   52  0   0   1.832582 
1 8.999997    12 4   16    37  0   3   1.090647 
1 11.39994    12 11  121   37  0   1   1.443124 
1 10.40001    8  25  625   52  0   0   1.25036 
1 19.08006    12 11  121   30  1   0   1.602313 
1 9.46604     13 2   4     31  0   1   1.018559 
1 6.50006     12 19  361   38  0   1   1.297053 
1 29.11701    12 7   49    43  0   3   1.685194 
1 19.10302    8  2   4     49  0   1   -0.4209849 
1 16.34997    12 20  400   55  0   0   1.562095 
1 32.02502    17 10  100   38  0   2   2.146528 
1 16.70006    17 19  361   52  0   0   2.347463 
1 4.811038    12 17  289   48  0   0   0.9698315 
1 24.62601    13 12  144   32  0   2   1.924146 
1 17.40001    12 11  121   32  0   1   1.626728 
1 13.02504    12 6   36    38  0   2   -0.0392607 
1 19.00698    12 10  100   46  0   3   1.460149 
1 14.03       12 4   16    40  0   3   1.955394 
1 14.89991    9  2   4     31  0   4   0.9263599 
1 25.00006    10 13  169   43  0   1   2.066192 
1 10.70007    12 21  441   51  0   0   1.422843 
1 24.25       16 9   81    30  1   0   2.101032 
1 39.13997    13 4   16    52  0   0   2.261461 
1 7.199973    8  2   4     30  1   5   0.7013138 
1 31.811      16 19  361   51  0   0   2.031013 
1 10.00005    13 4   16    31  0   2   1.162369 
1 20.66       12 9   81    34  0   4   0.4700036 
1 13.49998    11 14  196   49  0   0   1.410597 
1 25.38       13 6   36    35  1   3   0.3930551 
1 18.27498    12 24  576   53  1   0   1.290994 
1 39.213      12 1   1     32  0   3   0 
1 10.49994    10 13  169   38  0   3   0.9571255 
1 34.857      12 3   9     54  0   0   0.5596158 
1 28.502      17 10  100   47  0   1   1.568616 
1 12.99996    15 16  256   45  0   1   1.710188 
1 41.39991    16 9   81    47  0   1   1.410597 
1 14.78       10 19  361   59  0   0   0.2231435 
1 15.05       11 4   16    32  0   1   0.5108456 
1 29.69998    12 10  100   45  0   1   1.332392 
1 16.16502    12 5   25    40  0   4   0.8601859 
1 25.20516    14 7   49    47  0   2   2.32278 
1 14.2        16 3   9     36  1   2   1.919595 
1 18.15897    14 38  1444  56  0   0   1.976107 
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1 28.98106    8  16  256   41  0   1   0.8954347 
1 13.392      7  13  169   48  0   3   0.1812376 
1 9.17502     12 1   1     36  1   2   0.4953058 
1 27.03985    12 7   49    41  0   0   0.5777924 
1 13.14995    14 15  225   41  0   0   1.078818 
1 16.40007    12 10  100   36  0   3   1.603199 
1 21.29999    12 2   4     37  0   3   0.6208453 
1 17.20102    12 19  361   38  0   0   2.083894 
1 8.560026    14 25  625   43  0   2   1.379169 
1 6.49084     16 25  625   54  0   0   1.112384 
1 12.49997    12 7   49    38  0   1   1.067122 
1 27.00002    12 15  225   30  1   0   1.118807 
1 53.50005    12 11  121   49  0   0   1.588541 
1 52.49995    13 25  625   45  0   1   1.390311 
1 38.39998    13 19  361   51  0   0   1.714806 
1 13.89194    10 4   16    34  0   0   0.2010615 
1 3.899993    12 14  196   34  0   2   0.987271 
1 34.2        12 19  361   41  0   1   0.9835007 
1 19.70008    12 18  324   49  0   1   2.233171 
1 18.49995    12 14  196   32  0   0   1.143618 
1 10.99998    14 11  121   32  0   0   -0.6113829 
1 43.30001    17 4   16    32  0   2   2.153052 
1 18.76001    10 29  841   47  0   0   1.299837 
1 4.800096    9  21  441   39  0   1   0.8409204 
1 21.5        12 24  576   49  0   0   1.058484 
1 28.03994    12 19  361   37  0   3   1.152658 
1 26          16 31  961   59  0   0   1.293576 
1 27          12 28  784   50  0   0   1.832582 
1 17.79969    17 15  225   32  0   1   2.32718 
1 17.40195    12 27  729   46  0   0   1.166146 
1 19.30999    17 13  169   43  0   2   2.034993 
1 9.99998     11 4   16    37  0   3   0.6792511 
1 11.17998    16 10  100   32  0   2   1.547137 
1 18.85696    11 8   64    39  0   1   0.7530186 
1 12.30002    13 4   16    34  0   2   0.8472836 
1 13.67712    11 18  324   39  0   1   0.871126 
1 9.559997    8  3   9     45  0   3   0.2282505 
1 24.49998    11 11  121   50  0   0   0.0896578 
1 23.15       12 8   64    40  0   1   1.321756 
1 15.59088    10 10  100   30  0   1   1.196102 
1 14.42092    17 33  1089  57  0   0   1.636119 
1 17.45491    12 19  361   39  0   1   1.892012 
1 9.800019    12 35  1225  53  0   0   1.518309 
1 17.57446    17 21  441   48  0   1   2.472159 
1 16.555      14 7   49    46  0   1   1.321756 
1 13.29497    12 18  324   47  0   0   1.473641 
1 11.844      12 4   16    43  0   1   1.369479 
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1 46.64506    12 12  144   47  0   0   1.203963 
1 14.69999    12 16  256   47  0   1   1.198729 
1 26.09008    12 14  196   47  0   0   1.27021 
1 9.9         12 3   9     46  0   0   0.4700036 
1 9.048026    9  1   1     34  0   4   0.7999817 
1 30.75006    10 27  729   48  0   0   1.565946 
1 8.49994     12 12  144   30  0   1   1.758978 
1 22.24999    12 6   36    51  0   1   0.8580258 
1 42.91       12 9   81    52  0   5   0.6931472 
1 33.3        12 2   4     37  0   2   0.6418539 
1 13.8199     12 6   36    32  0   2   1.63374 
1 23.60001    17 9   81    36  0   2   1.703748 
1 13.00007    12 16  256   35  0   2   1.844004 
1 20.74994    17 22  484   45  0   0   1.966119 
1 6.3         12 26  676   56  0   0   0.8649974 
1 7.788925    10 11  121   40  0   2   0.9333052 
1 10.47004    12 11  121   45  1   2   0.7792332 
1 12          12 15  225   32  0   2   0.9555114 
1 16.97992    12 13  169   45  0   0   1.316247 
1 17.9        12 6   36    40  0   2   1.475906 
1 15.53994    12 20  400   38  0   1   1.491397 
1 9.883986    12 17  289   49  0   4   1.45575 
1 28.59995    16 8   64    47  0   1   0.5108456 
1 17.66001    13 13  169   52  0   0   1.180438 
1 25.99992    13 15  225   34  0   1   1.688489 
1 13.60201    12 14  196   44  0   2   0.7907275 
1 15.8        16 14  196   36  0   3   1.401799 
1 41.09999    17 6   36    50  0   0   -0.433556 
1 10.77504    12 24  576   45  0   0   1.683172 
1 9.000047    14 10  100   44  0   2   -1.766677 
1 24.39899    12 2   4     57  0   2   3.155595 
1 37.30009    17 9   81    35  0   0   2.259521 
1 27.99995    12 23  529   46  0   0   1.306926 
1 13.7        14 12  144   30  2   1   0.7984977 
1 17.20994    12 8   64    42  0   3   0.5590442 
1 14.00001    12 16  256   34  0   1   0.1479026 
1 35.75502    17 10  100   45  0   2   1.944495 
1 23.5        16 7   49    35  1   2   1.378338 
1 31.99993    16 19  361   40  0   0   3.064745 
1 17.15       12 2   4     32  0   1   -0.7419173 
1 20.25002    9  9   81    54  0   0   0.7657004 
1 5.485985    12 14  196   38  0   3   0.619393 
1 25.07504    12 9   81    43  0   3   1.465452 
1 18.21995    16 16  256   54  0   0   2.18926 
1 26          14 7   49    39  0   3   1.021659 
1 34.50007    12 6   36    37  0   1   0.9770095 
1 12.4        12 22  484   46  0   2   0.9162908 
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1 10.78685    11 9   81    56  0   0   2.905096 
1 16.32301    12 9   81    41  0   3   -0.1996712 
1 30.5        16 14  196   45  0   1   0.6931472 
1 51.29963    17 17  289   44  0   1   2.733393 
1 33.04997    17 12  144   50  0   1   1.868335 
1 34.75001    14 13  169   37  0   5   2.12026 
1 16.40004    12 8   64    44  0   1   1.515193 
1 19.70007    14 10  100   32  0   2   0.9146093 
1 6.600003    12 16  256   34  1   1   1.499556 
1 9.020008    10 1   1     32  0   2   0.8030772 
1 10.40001    12 6   36    37  0   3   0.7280316 
1 14.51999    13 4   16    44  0   1   0.51641 
1 17.2        16 8   64    34  0   2   1.226448 
1 43          12 4   16    33  1   3   0.9162908 
1 13.87196    7  15  225   43  0   3   1.376471 
1 -0.0290575  16 7   49    35  0   2   1.828975 
1 16.76994    14 14  196   43  0   1   1.368283 
1 7.8         12 16  256   34  0   0   1.064711 
1 14.50006    10 15  225   36  0   3   1.406489 
1 7.9         12 23  529   41  0   2   1.047319 
1 79.80001    16 19  361   41  0   0   1.948093 
1 7.17597     10 4   16    35  0   3   1.078001 
1 17.50698    12 12  144   32  1   3   0.6539385 
1 20.6        14 12  144   30  0   0   1.927892 
1 18.55992    12 25  625   43  0   0   1.361028 
1 9.3         6  14  196   54  0   0   0.6931472 
1 5.120008    15 14  196   35  0   2   1.604687 
1 14.50004    12 11  121   50  0   0   0.1839036 
1 19.8        17 7   49    34  1   1   3.113515 
1 18.29995    14 18  324   52  0   0   1.926829 
1 33.99994    13 4   16    35  0   3   1.270126 
1 11.62794    6  37  1369  55  0   0   0.6826927 
1 11.80005    16 13  169   35  0   0   1.68107 
1 39.09998    14 14  196   49  0   1   0.556296 
1 18.43007    15 17  289   38  2   2   1.62822 
1 21          14 5   25    42  0   2   0.9162908 
1 59          8  2   4     48  0   1   1.341558 
1 25.3        14 0   0     51  0   0   0 
1 23.24899    12 3   9     43  0   2   1.122231 
1 24.92809    12 21  441   43  0   1   0.5401708 
1 14.78199    12 20  400   38  0   1   1.391506 
1 18.90003    12 19  361   44  0   1   1.697174 
1 21          12 4   16    36  1   3   3.218876 
1 10.00001    12 19  361   38  0   0   0.8711678 
1 29.30997    8  11  121   47  0   0   1.16733 
1 13.14003    12 14  196   34  0   2   1.216988 
1 25.08999    17 8   64    40  1   2   0.5753766 
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1 14.59993    12 13  169   31  0   1   1.151616 
1 1.200001    12 24  576   46  0   0   0.9942513 
1 32          14 1   1     36  0   3   0.5263249 
1 16.11997    13 1   1     39  1   2   -1.543182 
1 26.50002    17 3   9     36  0   2   1.912043 
1 12.75006    8  4   16    37  0   4   0.5542873 
1 12.9        12 21  441   39  0   4   0.9162908 
1 10.69998    11 10  100   36  1   3   1.500939 
1 14.43403    12 13  169   49  0   2   0.9446838 
1 23.709      12 9   81    45  1   1   1.241269 
1 15.1        17 14  196   32  2   0   1.564984 
1 18.19998    10 2   4     36  0   5   0.8380265 
1 22.64106    12 21  441   40  0   1   1.668857 
1 21.64008    13 22  484   43  0   2   1.769429 
1 23.99998    12 14  196   33  0   1   1.226448 
1 16.00002    12 7   49    30  0   1   1.406489 
0 21.025      12 2   4     49  0   1   . 
0 23.6        16 5   25    30  2   0   . 
0 22.8        12 12  144   30  1   0   . 
0 35.91       12 1   1     41  0   4   . 
0 21.7        12 12  144   45  0   1   . 
0 21.823      12 4   16    43  0   5   . 
0 31          13 9   81    42  0   1   . 
0 15.3        12 9   81    60  0   0   . 
0 12.925      12 6   36    57  0   0   . 
0 15.83       10 5   25    38  0   2   . 
0 30.2        12 5   25    56  0   0   . 
0 16.6        12 8   64    32  0   3   . 
0 11          7  2   4     49  0   1   . 
0 15          12 6   36    55  0   0   . 
0 20.528      9  0   0     36  1   1   . 
0 13.126      12 3   9     44  0   3   . 
0 15.55       10 7   49    44  0   1   . 
0 18.01       14 3   9     35  1   2   . 
0 18.874      14 10  100   44  2   3   . 
0 24.8        12 3   9     45  0   1   . 
0 17.5        12 2   4     34  1   0   . 
0 16.15       17 12  144   30  2   0   . 
0 15.189      8  15  225   39  0   1   . 
0 6           12 5   25    36  0   2   . 
0 37.25       17 4   16    38  0   2   . 
0 27.76       12 10  100   53  0   0   . 
0 9.09        12 1   1     36  0   2   . 
0 14.5        12 8   64    32  1   1   . 
0 19.7        9  20  400   51  0   3   . 
0 16.788      11 4   16    38  0   0   . 
0 18.52       12 7   49    33  2   0   . 
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0 20.95       12 10  100   54  0   0   . 
0 7.574       9  3   9     38  0   3   . 
0 10.027      11 5   25    30  2   2   . 
0 5           12 10  100   34  2   3   . 
0 7.04        9  0   0     34  0   1   . 
0 40.8        12 3   9     50  0   2   . 
0 16.05       17 10  100   30  2   0   . 
0 33.1        12 2   4     38  0   2   . 
0 33.856      14 10  100   54  0   0   . 
0 20.5        12 4   16    30  1   2   . 
0 28.6        12 0   0     55  0   0   . 
0 18.75       10 10  100   51  0   1   . 
0 20.3        12 5   25    44  0   1   . 
0 13.42       12 0   0     53  0   0   . 
0 18.4        10 0   0     42  0   2   . 
0 16.682      12 19  361   38  0   2   . 
0 32.685      13 2   4     38  1   3   . 
0 7.05        12 12  144   41  1   4   . 
0 10.867      8  5   25    35  0   3   . 
0 18.22       12 5   25    33  1   2   . 
0 26.613      13 5   25    48  0   0   . 
0 25          12 10  100   47  0   0   . 
0 15.7        12 0   0     34  0   5   . 
0 40.25       13 4   16    33  2   1   . 
0 73.6        13 3   9     31  3   1   . 
0 10.592      8  2   4     58  0   0   . 
0 8           12 1   1     49  0   0   . 
0 13.4        8  0   0     55  0   1   . 
0 23.7        14 1   1     44  0   0   . 
0 18.9        9  1   1     44  0   0   . 
0 48.3        16 6   36    36  0   3   . 
0 24.47       12 12  144   38  0   3   . 
0 28.63       16 6   36    37  0   3   . 
0 25.32       12 9   81    47  0   0   . 
0 13.53       12 14  196   47  0   3   . 
0 14.8        12 13  169   32  1   1   . 
0 17.4        12 8   64    43  1   2   . 
0 15.98       11 0   0     42  1   4   . 
0 16.576      12 1   1     56  0   0   . 
0 21.85       13 3   9     38  0   5   . 
0 14.6        12 13  169   52  0   2   . 
0 21.6        12 3   9     50  0   0   . 
0 24          16 8   64    33  0   0   . 
0 20.883      16 8   64    44  0   2   . 
0 19.5        12 18  324   41  0   1   . 
0 42.8        12 2   4     45  0   1   . 
0 41.5        14 3   9     53  0   0   . 
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0 18.965      14 5   25    53  0   0   . 
0 16.1        12 2   4     42  0   1   . 
0 14.7        13 10  100   32  2   0   . 
0 18.8        12 30  900   56  0   0   . 
0 14.75       11 1   1     37  1   3   . 
0 21          12 5   25    40  1   2   . 
0 35.4        15 8   64    54  0   3   . 
0 10.7        7  0   0     53  0   0   . 
0 24.5        12 4   16    48  0   1   . 
0 17.045      12 2   4     36  1   2   . 
0 18.8        12 30  900   57  0   0   . 
0 14          12 25  625   51  0   0   . 
0 18.214      13 3   9     33  0   4   . 
0 20.177      12 20  400   52  0   0   . 
0 8.3         10 20  400   56  0   0   . 
0 14.2        12 0   0     36  1   2   . 
0 21.768      14 15  225   36  1   0   . 
0 29.553      12 10  100   46  0   1   . 
0 4.35        10 4   16    31  0   3   . 
0 24          11 3   9     52  0   0   . 
0 18.3        12 10  100   46  0   2   . 
0 17.2        12 9   81    35  2   0   . 
0 16.476      12 7   49    59  0   0   . 
0 13.4        8  12  144   36  0   1   . 
0 44.988      7  0   0     51  1   3   . 
0 18.2        16 16  256   31  1   0   . 
0 28          14 4   16    31  0   2   . 
0 11.55       12 7   49    32  1   1   . 
0 28.45       16 7   49    35  1   2   . 
0 15.096      12 14  196   40  0   3   . 
0 8.009       10 2   4     33  1   2   . 
0 10.04       7  20  400   54  0   0   . 
0 16.7        12 5   25    36  1   1   . 
0 8.4         10 10  100   50  0   1   . 
0 13          8  20  400   54  0   0   . 
0 17.97       11 10  100   48  0   1   . 
0 18.45       15 8   64    41  0   4   . 
0 31          12 11  121   50  0   4   . 
0 24.135      12 3   9     46  0   2   . 
0 31.7        13 6   36    42  0   1   . 
0 10.19       9  4   16    31  1   2   . 
0 21.574      12 4   16    53  0   0   . 
0 26.68       12 9   81    51  0   1   . 
0 17.7        12 10  100   47  0   1   . 
0 29.4        12 3   9     50  0   1   . 
0 22.159      6  2   4     37  0   1   . 
0 35          12 2   4     30  2   2   . 
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0 8.63        12 0   0     49  0   0   . 
0 17.08       12 8   64    52  0   2   . 
0 32.5        12 6   36    47  0   2   . 
0 16          12 15  225   49  0   0   . 
0 18.85       12 15  225   44  0   4   . 
0 17.5        8  9   81    53  0   0   . 
0 19.392      12 8   64    30  1   0   . 
0 14.45       12 18  324   54  0   2   . 
0 21.8        7  3   9     47  1   1   . 
0 7.7         15 10  100   56  0   0   . 
0 31.8        12 6   36    49  0   1   . 
0 17.258      6  20  400   48  0   0   . 
0 13.399      12 8   64    49  0   1   . 
0 16.073      12 3   9     56  0   1   . 
0 23.26       12 4   16    46  0   0   . 
0 37.3        12 13  169   45  0   2   . 
0 11          12 4   16    32  0   2   . 
0 13.075      12 17  289   43  1   1   . 
0 13.7        12 4   16    34  1   1   . 
0 25.1        12 0   0     30  1   1   . 
0 18.6        17 15  225   38  2   0   . 
0 29          16 11  121   33  1   1   . 
0 19.237      12 23  529   52  0   0   . 
0 19.855      11 1   1     43  0   3   . 
0 9.45        12 5   25    33  1   1   . 
0 30          10 1   1     45  0   0   . 
0 15          10 5   25    36  2   1   . 
0 24.701      12 3   9     34  1   1   . 
0 15.9        14 3   9     37  0   2   . 
0 16.24       10 19  361   46  0   1   . 
0 21.1        12 20  400   47  0   0   . 
0 23          16 5   25    31  2   1   . 
0 6.34        5  0   0     57  0   0   . 
0 42.25       12 3   9     30  1   1   . 
0 14.694      12 3   9     30  0   0   . 
0 21.417      12 7   49    44  0   3   . 
0 20.2        13 7   49    53  0   0   . 
0 12.09       8  1   1     51  0   0   . 
0 24.76       12 13  169   39  1   3   . 
0 23          8  0   0     52  0   0   . 
0 19.365      8  0   0     46  0   4   . 
0 5.55        12 12  144   47  0   5   . 
0 68.035      8  0   0     52  0   2   . 
0 29.3        12 5   25    45  0   2   . 
0 18.5        11 45  2025  60  0   0   . 
0 22.582      13 10  100   41  0   2   . 
0 21.5        8  2   4     39  0   3   . 
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0 28.07       12 3   9     49  0   1   . 
0 50.3        15 1   1     32  1   1   . 
0 23.5        12 5   25    33  1   3   . 
0 15.5        10 10  100   36  0   4   . 
0 13.44       13 4   16    37  3   3   . 
0 8.1         12 7   49    30  1   2   . 
0 9.8         11 9   81    44  1   1   . 
0 20.3        12 5   25    48  0   1   . 
0 15          11 4   16    40  0   4   . 
0 56.1        13 11  121   47  0   0   . 
0 22.846      12 9   81    36  0   2   . 
0 22.225      11 4   16    40  0   2   . 
0 17.635      12 2   4     46  0   1   . 
0 18.5        12 23  529   52  0   0   . 
0 13.39       12 3   9     44  0   1   . 
0 15.15       10 15  225   45  0   1   . 
0 16.2        7  8   64    30  2   1   . 
0 33.92       12 3   9     40  1   3   . 
0 14          12 25  625   43  0   1   . 
0 16.736      12 2   4     49  0   2   . 
0 30.65       12 0   0     46  1   4   . 
0 12.4        11 19  361   52  0   0   . 
0 19.022      12 3   9     31  1   1   . 
0 11.203      10 7   49    42  1   1   . 
0 19.876      11 1   1     33  0   3   . 
0 57          16 9   81    57  0   0   . 
0 18.29       10 3   9     49  0   0   . 
0 20.22       14 8   64    45  0   1   . 
0 22.15       11 0   0     56  0   0   . 
0 30.623      12 5   25    41  1   3   . 
0 9.38        5  20  400   56  0   0   . 
0 22          10 3   9     48  0   1   . 
0 23.675      16 12  144   52  0   2   . 
0 33.671      12 5   25    51  0   0   . 
0 12.367      11 1   1     35  0   3   . 
0 21.95       12 0   0     45  0   0   . 
0 32          12 7   49    54  0   0   . 
0 22.61       12 13  169   54  0   2   . 
0 12.092      12 3   9     31  1   0   . 
0 3.777       6  0   0     53  0   3   . 
0 36          14 2   4     35  2   2   . 
0 26.9        12 0   0     36  1   3   . 
0 32.242      12 2   4     59  0   0   . 
0 35.02       16 1   1     54  0   0   . 
0 37.6        12 10  100   37  1   1   . 
0 1.5         12 10  100   44  0   0   . 
0 96          17 1   1     34  1   2   . 
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0 18.15       12 3   9     49  0   0   . 
0 15.5        12 32  1024  49  0   0   . 
0 14          9  0   0     60  0   0   . 
0 14.756      12 7   49    51  0   0   . 
0 22          12 5   25    30  1   1   . 
0 24.466      12 2   4     47  0   2   . 
0 24.4        12 5   25    36  0   4   . 
0 24          12 3   9     35  1   3   . 
0 15.5        12 25  625   58  0   0   . 
0 30.8        14 0   0     41  1   3   . 
0 10.66       10 3   9     51  0   1   . 
0 13.35       12 10  100   47  0   0   . 
0 10.09       9  10  100   45  1   2   . 
0 55.6        14 7   49    60  0   0   . 
0 25.7        16 5   25    30  1   1   . 
0 29          11 15  225   55  0   0   . 
0 7.286       12 1   1     32  1   2   . 
0 37.752      12 5   25    36  0   2   . 
0 13.072      12 9   81    55  0   0   . 
0 7.044       12 18  324   47  0   0   . 
0 18.2        12 1   1     47  0   1   . 
0 27          11 0   0     37  0   1   . 
0 30.3        12 6   36    50  0   2   . 
0 12          12 1   1     30  0   3   . 
0 31.5        17 2   4     48  0   1   . 
0 27.092      10 15  225   43  0   2   . 
0 20.968      11 25  625   48  1   0   . 
0 27          14 1   1     41  1   2   . 
0 11.225      12 0   0     50  0   0   . 
0 37.7        8  0   0     58  0   0   . 
0 28.2        13 0   0     38  0   5   . 
0 34          12 8   64    37  0   1   . 
0 63.2        16 22  484   50  0   0   . 
0 7.5         8  5   25    42  0   4   . 
0 17.41       9  10  100   37  1   3   . 
0 51          16 1   1     41  0   2   . 
0 12.916      12 1   1     31  0   2   . 
0 21.9        12 6   36    51  0   0   . 
0 17.64       12 4   16    36  1   2   . 
0 20          15 6   36    54  0   0   . 
0 15          12 0   0     49  0   0   . 
0 14.06       9  1   1     48  1   1   . 
0 15.825      9  3   9     42  0   2   . 
0 16.51       12 15  225   41  1   2   . 
0 13          16 33  1089  55  0   0   . 
0 10          9  2   4     42  0   0   . 
0 22          15 1   1     32  0   1   . 
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0 29.8        12 10  100   43  0   2   . 
0 15          12 0   0     33  1   3   . 
0 22.3        15 14  196   48  0   1   . 
0 14.55       12 15  225   43  0   2   . 
0 19.73       17 15  225   47  1   3   . 
0 35          12 10  100   54  0   0   . 
0 21.014      12 6   36    51  0   1   . 
0 10.876      10 18  324   51  0   1   . 
0 27.85       13 15  225   43  1   1   . 
0 9.56        12 30  900   53  0   0   . 
0 30.3        11 15  225   34  1   1   . 
0 7.72        8  10  100   31  1   1   . 
0 10.55       12 0   0     56  0   0   . 
0 24.106      16 0   0     42  0   1   . 
0 22.995      12 4   16    32  0   2   . 
0 6           12 0   0     35  1   3   . 
0 24.35       12 3   9     30  1   1   . 
0 7.608       10 20  400   51  0   0   . 
0 28.2        12 3   9     47  0   3   . 
0 16.15       12 1   1     54  0   1   . 
0 51.2        15 5   25    31  3   0   . 
0 12.646      10 7   49    47  0   0   . 
0 19          14 6   36    47  0   3   . 
0 19          12 2   4     40  0   3   . 
0 14.4        8  0   0     48  0   0   . 
0 7.232       8  10  100   34  0   7   . 
0 21.943      12 6   36    38  0   3   . 
0 47.5        12 4   16    32  1   3   . 
0 28.9        16 8   64    48  0   1   . 
0 12.4        12 18  324   41  0   2   . 
0 6.531       5  7   49    49  0   2   . 
0 22.422      8  15  225   59  0   0   . 
0 22.2        13 7   49    58  0   0   . 
0 77          12 8   64    41  0   3   . 
0 88          12 8   64    45  0   2   . 
0 26.04       14 3   9     30  1   1   . 
0 63.5        12 10  100   41  0   1   . 
0 12.1        12 9   81    30  2   0   . 
0 17.505      12 24  576   53  0   1   . 
0 18          12 12  144   31  0   0   . 
0 28.069      14 2   4     43  0   2   . 
0 14          12 6   36    31  1   1   . 
0 8.117       12 18  324   51  0   0   . 
0 11.895      9  17  289   43  0   0   . 
0 45.25       14 7   49    31  1   2   . 
0 31.106      11 6   36    48  0   0   . 
0 4           12 10  100   31  1   1   . 
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0 40.5        12 5   25    44  0   1   . 
0 21.62       11 7   49    48  0   1   . 
0 23.426      12 11  121   53  0   1   . 
0 26          10 14  196   42  0   3   . 
0 7.84        12 5   25    39  2   6   . 
0 6.8         10 2   4     32  1   2   . 
0 5.33        12 4   16    36  0   2   . 
0 28.2        13 5   25    40  0   2   . 
0 10          12 14  196   31  2   3   . 
0 9.952       12 4   16    43  0   0   . 
0 24.984      12 15  225   60  0   0   . 
0 28.363      9  12  144   39  0   3   . 
; 

The output data set (MROZ) is saved in your Work library.
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B

bar charts 124
horizontal 153

bar-line charts 129

C

charts
bar 124
bar-line 129
histograms 134
line 138
pie 142

code
adding comments 57
formatting 57

correlation 165
correlations 202
Count Panel Data Regression 

task 94, 104
custom tasks 56

D

data
about 60

random sampling 178
ranking 70
replacing missing values 177
sorting 83
transposing 89

data binning 160
data characteristics 60
distribution analysis 191

F

frequency tables 198

H

Heckman selection model 100
high-performance tasks

generalized linear models 168
histograms 134

L

line charts 138
linear models

generalized 168
linear regression 110, 243
List Data task 65
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logit regression 116

M

missing values 177

N

nonparametric one-way 
analysis of variance 237

O

one-way analysis of variance 
230

nonparametric 237
one-way frequencies 198

P

panel data
Count Panel Data Regression 

task 94, 104
pie charts 142
probit regression 116

R

random sampling 77, 178
regression

linear 110

S

scatter plots 145
series plots 149
summary statistics 185

T

t test
one-sample 214
paired-sample 218
two-sample 224

table analysis 208
tables

attributes 86
tasks

about 51
bar chart 124
bar-line chart 129
characterize data 60
correlation 165
correlations 202
Count Panel Data Regression

94, 104
creating 56
data binning 160
distribution analysis 191
editing 56
generalized linear models 168
Heckman selection model

100
histograms 134
horizontal bar charts 153
line charts 138
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linear panel data regression
110

linear regression 243
List Data 65
nonparametric one-way 

analysis of variance 237
one-sample t test 214
one-way analysis of variance

230
one-way frequencies 198
paired-sample t test 218
pie chart 142
probit/logit regression 116
random sample 77
random sampling 178
ranking data 70

replace missing values 177
running 51
scatter plot 145
series plot 149
sorting data 83
summary statistics 185
table analysis 208
table attributes 86
transpose data 89
two-sample t test 224

transposing data 89

X

XML templates 56
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